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1 MediaLab Overview

Getting Started

MediaLab Features  and Setup  

Introduction and Key Concepts

Main Menu Commands

What's New in v2006?

Designing Experiments and Questionnaires

MediaLab Experiment Editor

MediaLab Experiment (.exp) Files

MediaLab Questionnaire (.que) Files

MediaLab Preferences and Other Options

MediaLab Samples

Welcome to the PDF documentation for MediaLab v2006. You can search this documentation
using Adobe Acrobat's search tool or by using the table of contents or index at the end of the
document. We have designed this document for easy printing from Acrobat should you prefer
a hard copy manual. Note that all of the information contained in this document can also be
accessed via the interactive help system located in MediaLab's Help menu, or by clicking on
MediaLab Help in the C:\MediaLab\Help folder after installation.

If you are new to MediaLab, we suggest you start by running the on-line tutorial from the 
Help menu of the main program window. You can also access a number of additional (zipped)
samples  in the C:\MediaLab\Samples folder.

If you have a question that these help files do not answer, please visit our support site at 
support.empirisoft.com or visit www.empirisoft.com/company.aspx to contact us directly. 

1.1 Features

Examples of General Features

§ Define as many experimental conditions  as you like

§ Flexible randomization features

§ Randomize items within a single group  and the order in which groups of items  are
presented

§ Randomization routines at both the experiment level  and within questionnaires

§ Simple and complex skip patterns . Base skips on any prior response, or even
combinations of prior responses .

§ Calculate scores and other variables  while a session is running--present them on screen
as stimuli, use them in skip patterns , or in post-session reports .

§ Create and optionally print summary reports  from each session with graphs, summary
data, scale scores

§ Embed your own or third-party programs  within an experiment or questionnaire
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§ Create your own custom questionnaire items  using standard HTML forms--MediaLab will
intercept the posted data!

§ Run DirectRT  or Inquisit  sessions from within your MediaLab experiment.

§ Create multiple custom preference settings  with choices of fonts and display colours

§ Context sensitive help such that pressing F1 at any time will help you with what you are
currently doing

§ Option of on-the-fly editing  of Word and WordPerfect documents—edit them as you run
through your experiment.

§ Resolution Independent . Compatible with screen displays from 640x480 to 1600x1200
and beyond. 

§ Easy-to-use intuitive interface--no programming code necessary for all but custom items

§ Compatible with most non-English fonts  (e.g., Japanese, Chinese, Arabic, Greek)

§ Customize all standard feedback messages  and/or translate into alternate languages

§ Optionally run experiments from a CD-ROM or Server  on LAN

§ Communicate with external equipment  for trial synchronization (e.g., psychophys
equipment).

§ Receive input from external devices  such reponse boxes and precision keyboards

§ Run sessions automatically  from other programs and batch files

  Examples of Flexible Questionnaire Design

§ Scale responses  with up to 12 closed ended responses

§ Multiple response  (select all that apply) responses

§ Fill-in-the blank  responses (free or restricted)

§ Ranking  allows subjects to drag and drop words, phrases or pictures to sort them by any
criterion

§ Essay-type  responses

§ Thought listings  and recall listings

§ Have subjects rate their own thought-listing  responses on any dimension

§ Easy text-based instructions  for any question

§ Voice Responses  with optional voice response times

§ Present HTML  and other web pages with active hyperlinks. Internet Explorer browsing
engine can display anything that IE can handle.

§ Track browsing behaviour  as subjects navigate through local HTML files or the World
Wide Web. Track every URL the subject follows and record in and out times.

§ Present Microsoft Word  and Microsoft PowerPoint  shows within your experiment or
questionnaires

§ Gather on-line continuous rating data  during audio and video clips.

§ Skip pattern capability  when a particular closed ended response is given

§ Questionnaire items can be omitted  in specified conditions

§ Easily modify and re-use  your questionnaires in other experiments

§ Option of self-paced or time-limited responses
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§ Allow subjects to return to previous questions  if necessary

§ Embed subjects' responses  in subsequent question wordings

§ Create multiple style configurations  (e.g., colours and fonts) for use within the same
experiment or questionnaire

§ Can't find what you need? Design your own custom items  using HTML forms. 

Example of Multi-Media Capability

§ Present graphics  (.bmp, .jpg, and .gif)

§ Present sound  files (.wav, .mp3)

§ Present video  (.avi, .mpg, .mov, .rm, .ra, .asf and more)

§ Present combinations of graphics , sound , video  and questionnaire items

§ Present HTML, Flash, java, ASP and any other browser compatible files

§ Optional parameters  allow you to set the screen location of images and movies as well as
set the size of video clips all the way up to full screen 

Examples of Data Features

§ Writes data  to an easy-to-analyze .CSV text file and SPSS .SAV file

§ Your choice of which variables  and to write to the data file

§ Smart data structuring so results from multiple conditions can be viewed in a single Excel or
SPSS file. You can start analyzing your results immediately.

§ Two sets of data files are produced, one organized by questionnaires , the other by
variable names .

§ Includes a utility to merge  .CSV and .TXT data files collected on different computers

§ Optionally write reaction time  data for any response to the data file

§ Optionally write data from multiple computers to a single folder on your network

45

56

85

90

48

53

49

42 43 44

48

60

72

70

72

72

74

71

84



MediaLab v20064

© 1995-2006 Empirisoft Corporation

1.2 Setup

System Requirements

For most uses, MediaLab will run perfectly well on any PC system, running Windows 95/98/
ME/NT/2000/XP. At least 32 Mb of RAM is recommended. If large experiments and/or large
multi-media files are going to be used frequently, then additional RAM is advisable though not
necessary. Video cards with at least 2 Mb of video memory also are recommended.

It is recommended that you also install Microsoft Office on all machines that will be running
MediaLab. These programs allow MediaLab to present documents fully formatted by Word and
slide shows prepared in PowerPoint and allow you to execute a number of features using the
conditional logic of Excel. Although MediaLab will work fine without them, these programs
perform cooperatively with MediaLab to produce some very impressive functionality.
Microsoft's Internet Explorer version 4 or later is required in order for MediaLab to present
custom items and other HTML formatted pages (whether stored locally or on the internet).
Finally, it is necessary to have a spreadsheet application (e.g., Excel, SPSS) installed in order
to view the data files produced by MediaLab (although the .txt and .csv data files can also be
viewed in any text editor).

Installation

To install MediaLab, download and run ml2006.x.x.exe (where x.x is the specific release)
available from www.empirisoft.com/download.aspx. If installing from a CD-ROM then simply
double-click on the ml2006.x.x exe file located on the CD. The installation program will guide
you through the set-up procedure. After the setup is complete, follow the security instructions
below to gain authorization for the workstation to run MediaLab.

Note to Network Administrators:

Users will require read/write access to the MediaLab folder following installation. If they do
not have read/write permission for the folder, the license check will fail and will cause a new
code to be generated. The installation should grant these rights to all users automatically, but
if not then they may need to be set as follows by someone with administrator-level access:

Step 1. When logged on as an administrator, this can be done by right clicking on the
MediaLab folder and selecting Properties and then Security and ensuring that regular users
have Read/Write permission. If you do not see a Security tab, then try Step 2.

Step 2. Open Folder Options in the Windows Control Panel. On the View tab, make sure Use
simple file sharing is not checked. It should be one of the last options. With that unchecked,
you should now get a security tab when checking the properties of folders. Try Step 1 again—
that should do it.

Security

To help control unauthorized distribution and use of MediaLab, it has been secured with ATX™
software protection. MediaLab will not run on any machine until this security has been
disabled. To disable the security follow these steps:

§ Install and run MediaLab.

§ You will receive a message that the current workstation requires authorization to use the
software, and a code number will be displayed.

§ E-mail the code to sales@empirisoft.com.

§ If you are an authorized user, you will receive a translation of this code which will be a
registration number unique for the machine on which you have installed MediaLab (usually
the same day). Then, re-start MediaLab and enter the five digit code provided to you.

http://www.empirisoft.com/download.aspx
mailto:sales@empirisoft.com
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MediaLab should now be fully functional. Important: ATX codes are unique to every
machine. Be sure to get authorization for each machine that will be using the software. If
you have any difficulty at all with this procedure, please contact us for assistance via 
sales@empirisoft.com.

§ Trial users may request a code that will enable MediaLab to run for 21 days.

Alternative Solution for Verifying Licenses

Tired of entering all those authorization codes? If you belong to a school that has purchased a
departmental site license then we can hard code your department's IP prefix into MediaLab so
that ANY machine starting with that prefix (e.g., 123.456.789.*) will start up right away if the
code 99999 is entered. Multiple patterns can be accommodated. Ask sales@empirisoft.com
for details.

Reinstalling MediaLab

If you are upgrading to a new version you will be asked to uninstall the existing version.
Experiments, data folders, preferences, and licenses will not be affected by uninstalling. Of
course, we recommend backing up experiment data before making any changes to your
system.

System Settings

The following are suggestions for your general system set-up. 

True colors

To allow for the full range of colors usable by MediaLab, it is recommended that you use 16,
24, or 32 bit color. Some older systems are set by default to 8 bit, which provides for only
256 colors (colors or color ranges may appear as dots, patterns, or solid regions). To change
these settings, open the Display properties in your computer's Control Panel, and select
Settings. Select the highest color range possible. 24 and 32 bit color ranges are both capable
of displaying close to the full range of colors detectable by the human eye.

Show file extensions

MediaLab frequently makes use of file extensions. These are the three-letters following the
period on file names (e.g., .exe, .doc, .mpg). For this reason, it is advisable that you don't
instruct Windows to hide these from you. To set this as a default:

§ In Windows 95, open any folder and select View from the pull down menu. Select Options,
and then View again. Deselect the option to have Windows Hide MS-DOS extensions.

§ In Windows 98, open any folder and select View from the pull down menu. Select Folder
Options, and then View again. Deselect the option to have Windows Hide File Extensions. It
is also useful to have Windows Display the Full Path in Title Bar, as well as Smooth Edges of
Screen Fonts.

§ In Windows ME/2000/XP, open any folder and select Tools from the pull down menu.
Select Folder Options, and then View. Deselect the option to have Windows Hide File
Extensions. It is also useful to have Windows Display the Full Path in Title Bar as well as
Smooth Edges of Screen Fonts. The latter setting can be found in Control Panel > Display >
Effects in Windows ME, NT, 2000 and XP

Task bar NOT always on top. 

It is possible to have the windows task bar always on top. This is not recommended for use on
machines that will be running MediaLab as it gives participants easy access to the system,
and it can obstruct some important features of MediaLab. To deselect this option, right click
on the task bar and then click on Properties. Make sure that Always on top is deselected. The

mailto:sales@empirisoft.com
mailto:sales@empirisoft.com
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key sequence Ctrl+Esc will make the task bar appear at any time.

Screen Resolution 

Although MediaLab was designed to work in all screen resolutions, how things look may
depend on the resolution you choose. Certain items may need to be repositioned with the left
and top parameters when running in high resolution modes. If you are working on different
computers, it is often best to pick a single resolution for your experiment (e.g., 1024x768).
To change these settings, open the Display properties in your computer's Control Panel, and
select Settings. 

1.3 Key Concepts

The Basic Idea

You need three things to conduct a MediaLab experiment. First, you need the materials or
stimuli you want to show participants. In many cases, you may simply have a number of
instructions and questions you want to give participants. Although MediaLab has the capability
to present many file types, some people just want to administer a basic questionnaire. If this
is the case, then you should find MediaLab an extremely easy way to do this. However, if you
want to show images, play sound files or movie clips, display Word documents, PowerPoint
shows, HTML pages, or execute other stand-alone programs, you will find MediaLab to be
extremely cooperative in this respect as well.

Second, you need dependent measures. Typically, these will consist of questions you have
regarding participants' responses to your instructions or materials. These questions may
consist of lengthy open-ended responses, short fill-in-the-blank type responses, multiple
choice and scale responses, thought or recall listings, or even ratings of subjects' own
responses. MediaLab will allow you to ask your questions using a wide variety of question
formats.

Finally, you need an experimental design. For this, you need to know which of your materials
and questions are assigned to each of your experimental conditions, and the order in which
they will presented. You may have just a single condition with a single questionnaire, or a
complicated factorial design with many questionnaires and randomization. Either way,
MediaLab is very flexible in terms of experimental design.

Once you have your design planned, your questions in mind and your materials prepared,
MediaLab plays the simple role of executing your experiment and preparing your data for
analysis. To get MediaLab to do what you want, you need to understand two new types of
files:

The Experiment File

The experiment file (i.e., files with the .exp extension) deals with things on a very general
level. Here, you simply specify which files are going to be presented in each of your
conditions. You basically tell MediaLab, "In condition 1, present file1, file2, file3, etc., and in
condition 2, present file1, file4, file5, etc." These files can be Word documents, PowerPoint
shows, HTML files, movies, sounds, images, executables, and MediaLab Questionnaires. To
learn more about experiment files, see help on MediaLab Experiment Files .

The MediaLab Questionnaire

This is where MediaLab becomes extremely flexible. The questionnaire (.que) is a file that can
be presented just like any other in your experiment. In the experiment file, you identify the
files to be presented in your various conditions—including questionnaire files. Questionnaires
differ from the other file types in that they are a single self-contained file full of instructions
for MediaLab. These instructions can tell MediaLab to present various files (e.g., images,

24
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sounds, videos, executables, Word documents, PowerPoint shows, HTML pages), but
questionnaires also contain the instructions for MediaLab to ask questions and gather data.

MediaLab questionnaires provide instructions for essay-type open ended responses, multiple
choice responses (with single or multiple response options), multiple response questions (e.
g., select all that apply), fill-in-the-blank answers, continuous on-line ratings, thought and
recall listings, and thought ratings (where subjects rate there own open ended responses on
dimensions you define). To learn more about questionnaire files, see help on MediaLab
Questionnaire Files  .

Running the Experiment

Once you have defined your experimental conditions, and created the files which it is going to
present, simply click the Select and Run Experiment command from the Run menu of
MediaLab. After finding and double clicking on your experiment, you will be asked which
condition you want to run, and what subject ID you want written to the data file. The rest is
easy. MediaLab runs the experiment, gathers the data and writes it to all to a single data file
that can be read directly by Excel (up to 255 variables) or SPSS (unlimited variables).
MediaLab also creates a data input list for your data set in both Excel and SPSS formats so
that you can start analyzing your data immediately. MediaLab also provides a data merging
utility so that you can easily combine data gathered on different computers before running
your analysis. See Data  for more details.

What MediaLab is NOT

Before planning a study with MediaLab it critical to know its limitations. Most importantly, we
advise serious caution about using any program written for the Windows environment for
studies requiring extremely accurate presentation times and response times involving visual
images. MediaLab does utilize a timer with a resolution of less than one millisecond and was
originally written with the functionality to conduct a wide variety of standard reaction time
experiments such as priming studies. For a number of technical reasons, this capability has
been removed from the main program and has been developed as a stand alone program
called DirectRT that will work cooperatively with MediaLab (although we still use the high-res
timer). DirectRT provides high precision timing routines for the presentation of images and
measurement of response times in the Windows environment and is recommended for any
application where high precision timing is critical.

The second limitation of MediaLab to keep in mind is that it works on the principle of a static
experimental design. Dynamic changes in design are not currently possible. Basically this
means that a subject needs to be assigned to a condition at the start of the experiment, and
what occurs in that condition is fixed. Although fairly complex skip patterns and dynamic
stimuli can be set up in MediaLab questionnaires, a subject can not be re-assigned to a
different condition based on a response contingency. This is not usually a big deal, but it's
something to keep in mind.

1.4 What's New?

For the most part, the v2006 features are all optional. This means if you are accustomed to
using a previous version of MediaLab (v2000-v2004), you should be able to continue using
v2006 without having to learn anything new. v2006 is backward compatible so that MediaLab
experiments from all previous versions should run the same as they always have without
requiring modification. In fact the final release of MediaLab v2004 served as a beta test
release for many of these new features.  Of course, be sure to confirm compatibility for
yourself with any old experiments prior to scheduling participants.

With that said, here are the new features which you can learn and apply at your own pace. If
you're new to MediaLab you can read this section or skip over it. All of this information is
located in the appropriate places elsewhere in this manual. This section is intended for the
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more experienced user who just wants to know what's different between the major releases.
Have fun and let us know if you have any problems or if you have requests for additional
features or fixes.

New in MediaLab v2006

Online Support

We have created an online forum for the 2006 versions of both MediaLab and DirectRT. Just
enter support.empirisoft.com in your web browser. We are regularly posting questions and
answers regarding the new versions. You can search it like a database to get help with issues
that have come up since the creation of these help files. You may also register (it's fast and
free) in order to download files, post your own questions or share your experiences and
experiments with other users.

Save Calculated Variables to Your Data Files

As of v2004, you could create or calculate variables during a session using the power of Excel.
Now you can save these values along with your other MediaLab data. Create simple
placeholder variables in your questionnaire. By using the same variable name for the
placeholder and calculated variables, MediaLab will know which values to grab from
responses.xls and store in your regular data files. This means anything you can calculate
based on anything your participants do, can now be written directly to your Excel or SPSS
data files. More Info

Custom Items Made Easy 

Want to use a slider? A pull down box, or radio buttons? Want to make custom buttons with
pictures? Now MediaLab allows you to create your own forms using any technology you
want--if it will display in Internet Explorer, then it will display in MediaLab. Simply use a
standard post or get method and MediaLab will grab and save the data. In v2004, we tried
something like this with Visual Basic, but many found it too difficult. This is much easier and
can be picked up quickly if you check out a few of the samples. More Info

Multiple Items on One Page 

Want five fill in the blanks on one page? Or three scale items, three blanks, a pull down list,
and a slider? Using the new custom item method (above), you can generate and place any
number of input methods on a single html form. You can even take an existing survey off the
internet and put it in your experiment--with little or no modification required. MediaLab will
display it all and save everything along with your regular data. More Info

Run sessions automatically from another program or batch file 

Using a simple shortcut file, batch file, or run command you can start a session directly
without having to see the usual MediaLab screen. The shortcut or batch file can simply tell
MediaLab what experiment or questionnaire to run. Optionally, you can add the subject and
condition IDs or tell it to use an autostart file or prompt. More Info

Save Data in an Access Database 

A blank access database called vertical.mdb is now available in the MediaLab Utilities folder.
This file can be copied into the "\data\byvariablename" subfolder of any experiment you like.
If MediaLab finds this file after a session is complete, it will output all of the data into the
three columns (subject, varname, value) of the "vertical" table. Data from each subject will be
appended to this file. This will be in addition to all of the usual data file formats. To maximize
compatibility, this file is (and should remain) in Access 97 format--it is readable by all
versions of Access. More Info
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New Image Ranking/Organizing Feature 

You can now use the Ranking item type to allow participants to rank images as well as text
labels. Simply enter the names of image files where you would normally enter text labels and
subjects can place faces, cars, logos, etc. in any order on any dimension. As with text, there
is a limit of 12 images at a time. More Info  

Improved Probe Task Capability 

Visual, auditory and TTL signal probes can now be launched easily during any task. You can
create a schedule of probes at either random or fixed intervals and get subjects response
times to the probes. The probe schedule can span multiple items as it runs independently of
the experiment once launched. Response times are assessed using DirectX so accuracy is very
good. More Info

Easily Align Question Text as Left, Right or Centered 

In v2004, you could add parameters to question wording by adding "param()" to the end of
your question wording. In the parentheses, you could add top, left, width and height
parameters as usual. In v2006, you can also add an "a" parameter to set the alignment of the
text. By default it will be left aligned. For right alignment, add "a1". For center alignment, add
"a2". e.g., "The quick brown fox jumped off the roof. param(a1)" will be right aligned. "The
quick brown fox jumped off the roof. param(a2,t.5) will center the sentence horizontally on
the screen and the top of the text will be located 50% of the way down the screen.  More Info

Adjust Speaker Volume Automatically During Session 

Sometimes you will have multiple media clips in your session that vary in volume. Some play
too loud, others not loud enough. Now you can embed an executable item at any point called 
volume.exe located in the C:\MediaLab\Utilities\Sounds folder that will allow you to adjust the
volume at any point during your experiment.  More Info

Silently Run EXE Files or Batch Files During a MediaLab Session 

In the past, executable files have needed to be their own item in MediaLab. Now you can
instruct MediaLab to run an executable at the start of any other item type by adding a "c"
parameter followed by the file name. More Info

Option to Disable Keyboard Navigation 

Add a (k-1) parameter to any questionnaire item to disable the spacebar as a means to
proceed to next item. Solves HTML problems where the spacebar can be required for text
input. More Info

Enhanced Output To External Equipment 

In previous versions, MediaLab could send a single byte TTL signal to external equipment at
the onset of any item. With v2006, you also have the option to send a whole string of
characters via the com port. Nice for situations where the external equipment wants a bit
more information than a single TTL signal can provide. More Info

Enhanced Input From External Equipment 

MediaLab can now read continuous data input from an external device and write these data to
a file with current time and variable stamps as well as subject and condition IDs. More Info

True Autostart 

Using a substitute.txt  file, you can have a blank message ("") defined for the end of session
event. If MediaLab sees that you have no message and you are using an autostart file, then it
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will proceed automatically with the next session without hassling you--i.e., you will not be
asked if you want the next session run, it will simply start. Doing so requires ctrl-alt-delete
when you finally want to escape. More Info

Smarter Autostart 

If you intentionally end a session prematurely, you will now be asked if you would like the
autostart file to be reset as it was before the session. This prevents MediaLab from scratching
the session off its to-do list. More Info

Cleared Data Now Safely Recycled 

In the past, clearing data at the start of a session would delete the data permanently (after a
serious warning, of course). In v2006, cleared data are sent to the Windows Recycle Bin
where they stand a good chance of being saved should they be cleared accidentally. Requires
that the experiment and data be stored locally (as opposed to on a network drive). More Info

Enhanced Audio and Video support 

MediaLab v2006 has the capability to work directly with Microsoft's latest media player
technology to present audio and video. 

Support for Long Variable Names

As of MediaLab v2006.1 the limit for variable names was increased from 7 to 12 characters.
As of v2006.2, this was increased to 60 characters. Keep in mind though that some statistical
packages and spreadsheet applications may still have difficulty working with longer variable
names. Be sure to view and analyze some practice data before going too crazy with this
feature! 

Shift + Alt + Right Arrow

* Note: In previous versions, the combination Alt + Right Arrow would end the current
questionnaire or file. Because this combination is now commonly used in web browsing we
added a shift key to the combination to avoid accidental endings. More Info

Edit .que and .exp Files Directly in Microsoft Access

This is not a new feature but many people do not know about it so we're putting it here
anyways. More Info

Small Group, Departmental, and University-Wide Site Licensing via IP Patterns

If you belong to a school that has purchased a small group, departmental or university wide
site license then we can hard code the appropriate IP patterns into MediaLab (and/or
DirectRT) so that ANY machine with a matching pattern will start up right away without
requiring a code. Ask sales@empirisoft.com for details.

88
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2 Main Program Window

Menu Commands

The main menu commands are found at the top of the MediaLab program window. These are
the general commands used for running experiments, viewing data files, and for setting
preferences. Note that the MediaLab Experiment Editor  has it's own separate menu system.

Run Preferences

Data Help

Experiment Editor

15
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2.1 Run

Menu Commands

When you are ready to run your experiment, either as a trial run or to collect real data, you
have three options. From the Run menu you can choose to:

Select and run experiment

If you haven't run the experiment before, this choice allows you to search through the folders
on your machine to find the desired experiment. Locate the experiment file and then either
double click on it, or select it and click Open.

Select and run a single questionnaire

If you want to test or run a single a questionnaire or just see what it looks like you can click
on Select and Run a Single Questionnaire. MediaLab will automatically create a single item
experiment file  and run it. All data files will be located in the usual place but will be named
after the questionnaire, e.g., self-esteem_que.csv

Run the most recently executed session

This choice will execute the experiment or questionnaire most recently run on the machine.
The key sequence Ctrl-R will perform the same function. This command is handy when
multiple participants are being run back-to-back in the same session.

Select from the 5 most recently run sessions

MediaLab keeps track of the five most recently run sessions and displays them in the Run
menu. Clicking on any one of them will run the selected session (assuming it's where you left
it).

Running an Experiment from a CD-ROM

By default, MediaLab writes data to the same folder that contains the experiment files. This
prevents you from running experiments off of a CD-ROM since you can't write data to a read-
only CD-ROM. To accomplish this, you can specify an alternate data folder in your preferences

 file. So long as the alternate data folder is one to which MediaLab can write the data, then
running the experiment off a CD is no problem.

Running Experiments Over a Network

In the same way that you can write data to a folder on another computer, you can also run an
experiment from another computer. To do this, again, you must map the drive of the other
computer which contains the experiment (see above). Once you have done this, you can run
the experiment as if it were located locally. From the Run menu, choose Select and Run an
Experiment or Select and Run a Single Questionnaire and browse to the experiment located
on the mapped drive (e.g., h:\experiment1\myexperiment.exp). This way, multiple computers

6

83
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can access the same experiment from a single computer. As with writing data to another
computer (see above), it is recommended that you specify a unique machine code in
Preferences  since all the data from all machines will be writing to the data folder on this
single computer. This option may not be suitable for experiments that require a lot of
bandwidth (e.g., those that use a lot of video and sound) or for experiments using many
computers on a slow network.

Running Experiments From Another Program, Shortcut or Batch File

In some cases you may want to start an experimental session from another program or
shortcut without any of the usual MediaLab startup screens.  You can begin a MediaLab
session from within a Visual Basic application or program with VBA support by using a shell
command as follows:

Shell "c:\medialab\medialab.exe c:\medialab\samples\sample1\sample1.exp,15,1"

If you specify the subject and condition IDs like this (i.e., "15,1" in this example) then the
session will start automatically with no prompts and will end upon completion.  Alternatively,
you may specify "0" for either or both.  If you specify a "0" for both (i.e., "0,0") then
MediaLab will attempt to use your autostart file if it finds one.  If one does not exist, then
MediaLab will prompt you for the IDs.  You may also specify one but not the other, in which
case MediaLab will prompt you for the unspecified value.  

This can also be run from the Windows Run command, a batch (.bat) file or shortcut
file--notice the difference in quotation marks:

"c:\medialab\medialab.exe" c:\medialab\samples\sample1\sample1.exp,15,1

2.2 Navigation

Key Navigation

As an alternative to having subjects click on the Continue and Go Back buttons, you can have
subjects use the keyboard to navigate their way through your experiment. The Backspace and
Spacebar keys will simulate mouse clicks on the Go Back and Continue buttons, respectively.
This does not apply to essays, fill-in-the-blanks, and thought-listings which can still be ended
with the Escape key as an alternative to the mouse click (since the Spacebar and Backspace
keys are necessary for open ended responses). Note: If you use an Executable item, the
navigation keys will become active only after the executable program has ended and control
is returned to MediaLab.

Not: When using an HTML item in your questionnaire that allows for spacebar or backspace
input, you may want to add a k-1 parameter  to disable keyboard navigation for that item.
This does not apply to Custom items made with HTML because custom items do not allow for
keyboard navigation.

Secret Keys

When test-running an experiment, you may want to skip over various items, files, or
questionnaires that you already know are working. You also may have timed items that you
don't want to wait for while you're testing things out. For this reason, there a few secret key
combinations that will allow you skip around.All use the right or left arrow keys on your
keyboard in combination with either or both of the Alt key or Ctrl key. Press each key down
and hold it until each of the remaining key(s) is pressed.

Ctrl + Left Arrow Go back to previous question in a
questionnaire

83
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Ctrl + Right Arrow Skips to next question in a questionnaire

Shift* + Alt + Right Arrow Quits the questionnaire or other current
file

Ctrl + Alt + Right Arrow Quits the experiment in progress

Notes 

In previous versions, the combination Alt + Right Arrow would end the current questionnaire
or file. Because this combination is now commonly used in web browsing we added a shift key
to the combination to avoid accidental endings.

Some item types that involve videos and or HTML may require that you first click on the outer
border of the MediaLab space in order to use the secret keys. This is because the Windows
Media Player and Internet Explorer engines will sometimes intercept keystrokes and won't
share them with MediaLab. For the same reason, the spacebar may cause a video to pause
rather than causing MediaLab to continue to the next item. In any case, a click on the outer
border will return keystroke input to MediaLab if and when this happens.

StatusBar

The StatusBar is displayed at the bottom of the main MediaLab window. Allows you to view
some convenient information about the experimental session. The first cell in the status bar
displays information about current activities and when nothing else is going on, it displays the
name of the last experiment run during the current session. The next cell displays the last 
Subject ID and Condition run during the current session. The next two cells display the
current date and time. Can be hidden with option on the Tools menu. 
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3 Experiment Editor

Menu Commands

These main menu commands are found at the top of the Experiment Editor window. To launch
the experiment editor, either click on Experiment Editor in the main MediaLab window, or click
the MXEdit icon in the MediaLab startup folder. These are the general commands used for
editing Experiment (.exp) and Questionnaire (.que) files.

File Edit

Options Window

3.1 File

QuickInfo

The following describes the functions provided in the File menu of the MediaLab
Experiment Editor.

Commands

New Experiment

Creates a new experiment file for editing. See Experiment Files  for details.

15 17

18 18
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New Questionnaire

Creates a new questionnaire file for editing. See Questionnaire Files  for details.

Open

Opens an existing experiment (.exp) or questionnaire (.que) file for editing.

Open Recent

Select from the list of recently edited experiment and questionnaire files for editing.

Launch Explorer

Runs the Windows Explorer for file browsing. See suggestion regarding the visibility of file
extensions  (e.g., .que, .exp, .htm, .doc, .etc)

Launch DirectRT

Runs DirectRT if you have it installed. See www.empirisoft.com/directrt.aspx for details.

Save

Saves the active file.

SaveAs

Saves the active file but allows you to specify a new folder or filename.

Page Setup

Allows you to set print options such as margins, portrait vs. landscape and which columns to
print. See Printing  for details.

Print Preview

Allows to preview printed output.

Print

Prints the contents of the active file.

Exit

Exits the MediaLab Experiment Editor.

37
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3.2 Edit

QuickInfo

The following describes the functions provided in the Edit menu of the MediaLab
Experiment Editor. See also Editing Tips and Tricks  for a variety of editing
shortcuts.

Commands

Cut  

Deletes the selected text or cells and places the deleted contents in the MediaLab clipboard
for pasting elsewhere.

Copy

Copies the selected text or cells and places the copied contents in the MediaLab clipboard for
pasting within the same or other questionnaire. See also External Copy below.

Paste

Pastes the contents of the MediaLab clipboard to the selected cell(s). See also External Paste
below.

Fill Down

When cells from multiple rows are selected, copies the value from the top selected cell(s) to
the selected cell(s) below.

Fill Right

When cells from multiple columns are selected, copies the value from the left most cell(s) to
the selected cell(s) to the right.

Select All

Selects all the cells in the active file.

Delete Rows

Deletes the selected rows from the active file.

External Copy

The MediaLab experiment editor uses it's own private clipboard for cutting, copying and
pasting. If you want to copy cells to paste in an external application, select the cells and
choose External Copy.

External Paste

To paste cells or text from external applications (e.g., Excel, Word, a text editor), select
External Paste.

Edit Tips and Tricks

Hints and short cuts  for working in the Experiment Editor.

20
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3.3 Options

QuickInfo

The following describes the functions provided in the Options menu of the MediaLab
Experiment Editor.

Commands

Use Full Path Names

When selecting files by double-clicking in a cell, this option specifies that the full path be
included (e.g., c:\experiments\exp1\images\image1.bmp). See Specifying File Paths  for
details.

Use Relative Paths

When selecting files by double-clicking in a cell, this option specifies that the path be specified
relative to the experiment (.exp) file (e.g., images\image1.bmp). See Specifying File Paths
for details.

Question Wording Cells

Expand All – Shows the complete contents of all question wording cells in the overview
window.

Collapse All – Shows only the first line of each question wording cell. Clicking on any question
wording cell will automatically cause it to expand.

Choose Columns to View/Print

Allows you to hide or show columns in the overview window. This feature is especially handy if
you wanted to print only a select number of columns from the overview window.

Editor Font

Allows you to choose an alternate font for editing text within the editor. Can be useful for
international font requirements. You may also need to choose a Character Set for your
language from the main MediaLab Preferences  menu

3.4 Window

QuickInfo

The following describes the functions provided in the Windows menu of the
MediaLab Experiment Editor. 

Commands

New Window

Equivalent to selecting Open from the File menu.

Cascade

Neatly arranges all open windows in an overlap pattern making all window titles visible.

104
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Tile Horizontal

Stretches all open windows their maximum width and arranges them in a horizontal overlap
pattern.

Tile Vertical

Stretches all open windows their maximum height and arranges them in a vertical overlap
pattern.

Arrange Icons

Neatly arranges all minimized window icons

Hint

The most useful function in the Windows menu is that at the bottom of the menu will be a list
of all currently open files. You can select which file to bring to the forefront by clicking on any
file in this list. Note also that you can use Ctrl+Tab to flip through all open files.

3.5 Printing

QuickInfo

Prints the content of your experiment or questionnaire file.

Value

Mouse-click, Alt-P (Overview editor only)

Purpose

You may wish to print a hardcopy of information in your experiment or questionnaire file. To
select which columns to print, click Select Columns to View/Print. Check all the columns you
want to print. Note that you can start by clicking Select All or Deselect All.

You can manually widen any column if you want more of it displayed when printing.

For question wording cells (questionnaire files only), you can expand (print all lines) or
collapse (print only the first line) the cells when printing. When selecting Print, select Expand
All or Collapse All for the Multi-Line Cells option.
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3.6 Editing Tips and Tricks

QuickInfo

The following describes how to use some of the editing features of MediaLab's new
Experiment Editor:

Moving Around and Editing a Cell

Copying a Single Cell

Drag & Drop (Turbo) Copy

Copy a Block of Cells

Copying an Entire Line/Record

Copying Multiple Lines/Records

Inserting Copied Lines/Records

Filling Down & Filling Right

Double-Clicking Functions

Relative vs. Absolute Paths
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Expanding Question Wording Cells

Selecting Cells to View

Copying and Pasting to and from Other Applications

Editing Files Directly in Microsoft Access

Tips and Tricks 

Moving Around and Editing a Cell

The arrow keys will allow you to navigate through the spreadsheet. To select a cell in order to
edit the contents, press the Enter key. When you are finished editing the cell, press Enter
again, and the arrow keys will again let you navigate. You can also leave a cell while editing it
by using the Up or Down arrow keys. To add a hard return/line feed to your question wording,
do this in Details mode. 

Copying a Single Cell

To copy a single cell, move to that cell select Copy (Ctrl+C), then move to the desired target
cell and select Paste (Ctrl+V). Only entire cells may be copied & pasted in the main overview
spreadsheet. To copy and paste only portions of cells, do this in Details mode. 

Drag & Drop (Turbo) Copy

You can quickly copy the contents of one cell to another using the right-mouse button.
Simply right-click on the cell you want to copy and drag it to the desired cell. Only one cell at
a time can be copied this way. This can also be done between multiple open files (i.e., drag
from a cell in one file and drop to a cell in another file). 

Copy a Block of Cells

To copy a block of cells, highlight the block and select Copy (Ctrl+C), then move to the upper
left cell where the pasting should begin and select Paste (Ctrl+V). You can also copy a block
of cells from one file and paste it into another using this method. 

Copying an Entire Line/Record

To copy an entire line or record, use the record selector at the very left of the spreadsheet
(this selects all the cells in that row). Select Copy (Ctrl+C), then move to any cell on the line
where you want it copied and select Paste (Ctrl+V). This will copy the entire record, including
its details, to the new line. To insert copied lines, see below. You can also copy an entire
record from one file and paste it into another using this method.

Copying Multiple Lines/Records

Follow the instructions for copying a single record (above), but highlight as many rows as you
like with the record selector. Move to any cell in the row at which you want to start the
pasting, and select Paste (Ctrl+V). You can also copy entire records from one file and paste
them into another using this method.

Inserting Copied Lines/Records

Note that pasting overwrites the cells in the current row. Therefore, to insert the copied line
(s), without affecting the other items in the file, go down to the first blank line, and then
select Paste (Ctrl+V). To move it to the desired location, simply assign it a position number
and then click Sort. You can also copy entire records from one file and insert them into
another using this method.
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Filling Down & Filling Right

Sometimes you may want to copy one cell over and over to a series of cells below it or to its
right. An example would be that you want to copy the same parameter value or scale point
labels to 20 sequential items without having to retype it each time. With the FillDown
function, this is easy:

· To copy a cell to a series of cells below it, highlight the block of cells (including the one you
want to copy) and then select FillDown (Ctrl+D). This will copy the top cell to all the cells
selected below.

· To copy a cell to a series of cells to its right, highlight the block of cells (including the one
you want to copy) and then select FillRight (Ctrl+R). This will copy the top cell to all the
cells selected below.

· Note that the filling functions only operate in the main overview spreadsheet and not in 
Details mode.

Double-Clicking Functions

If you double click on the Position, Name, or Condition (Experiment files only) columns, this
will immediately take you into Details mode. If the item type is a file, then double-clicking on
the FileName or QuestionWording column will immediately open up a file browser window so
you can select your file. If you select Cancel, this will return you to Edit mode so you can
manually edit the cell. Double clicking on the BackGround, BackSound, and BackVideo
columns will also immediately open a file browser window so you can choose an appropriate
file type.

Relative vs. Absolute Paths

To use Absolute or Relative (default) paths, select the appropriate option from the Options
Menu. What does this mean? When you select files using the file browser, you can opt to have
it return the entire (aka absolute) path of the file (e.g., c:\experiments\steve\exp1\images
\image1.bmp), or the path relative to the experiment (e.g., images\image1.bmp). Relative
paths are recommended because the experiment folder (e.g., in this case exp1) can be
moved anywhere on any computer and in any folder and MediaLab will know where to find the
file. The only time an absolute path is necessary is when the desired file is not located
somewhere within the experiment folder. However, if you are using Relative Paths, the editor
will enter an absolute path if this is the case. 

Expanding Question Wording Cells

When a question wording cell uses multiple lines, the cell will expand to show this when you
click on it. If you would like to see all such cells expanded at the same time, select 
QuestionWording Cells > Expand All from the Options menu. This is also an option you can
select when printing your file.

Selecting Cells to View

When working with your file, you may wish to view only certain columns. To select the
columns to view, select Choose Columns to View/Print (Ctrl+H) from the Options menu. This
is also an option you can select when printing your file. Note that the column selection feature
applies only while the file is open and is not saved for future use.

Copying and Pasting to and from Other Applications

The new editor uses its own proprietary clipboard so you can not use the usual copy and
paste functions to copy cells to and from other applications (e.g., Word, Excel, etc.). To do
this use the External Copy and External Paste commands on the Edit menu. These functions
access the usual Windows clipboard.
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Editing Files in Microsoft Access

Questionnaire (.que) and Experiment (.exp) files are really just small Access database files. If
you right click on any questionnaire or experiment file and select Open With, you can choose
Microsoft Access if you have it installed (you may have to browse for it). If you do this you
may be informed that you can not make changes to database objects. That's ok. You may also
be asked if you want to convert the database to a more recent version--just say no, and ask
to open the file.  Once the file is open in Access, you can double click on Table1 to edit the
file. This allows you to bypass the MediaLab Experiment Editor completely or you can do some
of the work in Access and some of the work in the MediaLab editor. Some people, e.g., like to
load their files into Access for heavy copying and pasting jobs, or to use the Access Spell
Checker.
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4 Experiment (.exp) Files

Key Concepts

Overview Window

File Details

Condition BackGround Randomize Within
Groups

Position BackSound Randomize Between
Groups

File BackVideo Parameters

4.1 Key Concepts

The experiment editor allows to you to create, view and edit the details of your experimental
conditions. The experiment file you create using this editor is the first thing that MediaLab
looks at when you go to run the experiment. You specify here which questionnaires, images,
videos, sounds, documents, html files, executables or PowerPoint shows you want to present
in each condition, and the order in which you want them presented. When you run the
experiment, MediaLab will ask you which condition you want to run. It will read your
experiment file, determine which files you have specified for that condition, and then it will
present those files to the subject in the order you have specified.

With the exception of questionnaires, no data is gathered for files that you specify here. This
is a very important concept. Data is only gathered in questionnaire files that you create.
Questionnaires are much more flexible in terms of the types of files and information that can
be presented and the type of responses and data that can be collected.

The Experiment file that you create with the experiment editor simply tells MediaLab which
files are to be presented in each of a virtually unlimited number of conditions. This can be as
simple as assigning a single questionnaire file to each condition, or as complicated as multiple
questionnaire files assigned to each condition, with each interspersed with video, audio,
graphics, Word documents and PowerPoint shows for which data does not need to be
gathered (e.g., for instruction screens or debriefing documents).

Remember though that all file types can also be presented in a questionnaire if you like. That
is why the experiment file can be as simple as stating which questionnaire (or set of
questionnaires) is assigned to each condition. Additional files can be specified simply for the
purpose of having this flexibility in the case that your application requires it.
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4.2 Overview Window

QuickInfo

In the overview editor, you can scroll through the basic information regarding your
experiment. In this mode, you can see and define which files are presented to
subjects in your different experimental conditions, and the order in which they're to
occur.

Click on a specific area for help on that topic:

Hints

Double-click on any condition or position field, and the file details will be displayed for the file
at that location. Double-click on any file field, and you will be able to search your drives for
the file you're looking to put there. If you want to edit the file name field without being
prompted for a file, just highlight the cell and press enter to edit it.

Info

Allows you to save summary information and detailed notes regarding your
experiment.

The title and comments are for the Editor's reference only. The comments field has a very
large capacity if you wish to exploit it.

Details

Allows you to set various options for the presentation of your experimental files.

Explore a specific area for help on that topic:
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Sort

Sorts the files in the experiment, first by condition and then by position.

The sort button makes life a little easier by automatically reordering all of the files in your
experiment so that you need not worry about where you are placing a file at any given time.
When MediaLab sorts the experiment files, it will first place all of the files in each condition
together. Next, it will reorder the files within each condition by their ordinal position. If you
forget to do this, the editor will do it automatically when you exit. You can manually sort
whenever and as often as you like by clicking the sort button.

Hints

To add a new file between two existing files (e.g., at positions 2 and 3), assign it a position
value between these values (e.g., 2.5) and then click the Sort button. After sorting, you can
automatically renumber all of your items as sequential integers by clicking the renumber
button.

Important: MediaLab will first sort by the condition  field and then by the position field, so
be sure that you identify the condition of the file before you sort.

Renumber

Renumbers the position  values within each condition  with sequential integer
values.

The renumber button cleans up your position numbering by replacing the values with
sequential integers. Within each condition, the first file will get a position value of 1, the
second will get a 2 and so forth. This is not a necessary operation and is provided mainly for
the purpose of aesthetics and to help you verify that you have the correct number of files in
each condition.
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Hint

If your files are out of order, be sure to sort  before you renumber.

Print

See Experiment Editor, Printing  

Help

Starts the interactive help system. 

You can search the documentation using the Contents, Index and Search tabs in the left-hand
window. Also note that MediaLab takes advantage of context sensitive help such that pressing
F1 at any time will often direct you immediately to help with what you are working on. A
printable PDF copy is available in the C:\MediaLab\Help folder.

Save

Saves the current file.

Save As

Saves the current file with a new name and/or location.

OK

Closes the Details window and returns to the Overview window.

Navigation

There are many ways to navigate your way around the experiment editor. The most useful
methods to be aware of are:

To jump from field to field, you can simply click on the field you want to edit.

You can also use the tab key and the arrow keys to jump from one field to the next

When your are editing in the overview window, double-clicking will allow you to edit any field
or will pull open a file search box if a file is required. If you want to edit a field that requires a
filename but do not want to open a file search dialog, then simply highlight the field and press
enter to edit the field directly.

All forms have a button with a check mark. This button closes whatever editor you are
currently in. You will always be given the option to save any changes that you've made.

Details Editor

In the details editor, you will notice four buttons with arrows. The first key will take you to the
details of the first file in your experiment. The second takes you to the file immediately
preceding the one you are currently editing. The third takes you to the next, and the fourth
takes you to the last.

26
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4.3 Condition

QuickInfo

Identifies which files are presented together in an experimental session.

Values

Any text. Usually numbers but words are allowed. For more than 9 conditions, you can label
the first 9 conditions 01, 02, 03 etc. to preserve numeric/alphabetic consistency.

Purpose

When you run a MediaLab session, you will be asked for two things: 1) a Subject ID for
writing to the data file, and 2) the Condition you want to run. MediaLab will then read your
experiment file and look for all the files that belong to the condition you specify. Therefore, in
the experiment editor you need to identify which conditions receive which files.

In your experiment file, you can create as many conditions as you like. Simply create a
unique identifier for each. You can use numbers (1, 2, 3, and so forth) or text (cond1, male
speaker, sg24, and so forth) to identify your conditions. Just be sure to give the same
condition id to every file that you want to be presented in that condition. If a file is to be
presented in multiple or all conditions simply list it once with each condition id.

Hints

Values are treated as words for purposes of sorting. So if you have more than nine conditions
and are using numbers to label the conditions you may want to use "01", "02" … "09", "10"
etc. to maintain your numerical order after sorting.

Using long text identifiers can be a pain when you are running many subjects and have to
type the long condition names to start the experiment every time. Using numbers or short
letter combinations to identify your conditions will solve this.

For factorial designs, try assigning single letters to represent the various levels of your
factors. For example, imagine a persuasion experiment with a 2 (attractive vs. unattractive
speaker) x 3 (strong vs. weak vs. no arguments) design. The six conditions might be
identified as AS, AW, AN, US, UW, and UN. Or for simplicity, you might simply label them 1, 2
, 3, 4, 5, and 6.

4.4 Position

QuickInfo

Identifies the order in which files are presented in each condition.

Values

Any number. Decimal values are allowed.

Purpose

This field determines the order in which files are presented in each condition. MediaLab will
automatically sort the files in each condition by the values you specify in the Position field.
You can manually sort the file at any time by using the Sort  button.26
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Hints

To add a new file between two existing files (e.g., at positions 2 and 3), assign it a position
value between these values (e.g., 2.5) and then click the Sort button. After sorting, you can
automatically renumber all of your items as sequential integers by clicking the Renumber
button.

Important: MediaLab will first sort by the condition  field and then by the position field, so
be sure that you identify the condition of the file before you sort.

4.5 File

QuickInfo

Names of the files to be presented in each condition

Value

Any file name ending with the following three letter extensions:  

.que MediaLab Questionnaire

.htm, .html HTML files on your hard drive or the web

.doc, .wpd Microsoft Word or WordPerfect documents

.pps Microsoft PowerPoint shows

.bmp, .jpg, .gif Images

.wav, .mp3 Sounds

.avi, .mpg Videos

.exe Programs (including old DOS, Windows
3.1 and Windows 95)

.csv DirectRT Input file **

Purpose

The file field simply tells MediaLab which files to present in the different experimental
conditions. See Questionnaire item types  for more details on specific file types.

Hints

Double-click on the File field to browse your hard drive and select files automatically. Press
Enter to manually edit a file path.

To be safe, you can always specify the complete file path (e.g., c:\experiments\myexp
\myimage.bmp). If you specify a complete path, remember to make sure the path is the
same if you load the experiment onto other computers.

Advanced Hints

If the file is located in the same folder as your experiment file, then you can simply enter the
name of the file (e.g., myimage.bmp). If the file is located in a subfolder that is located in the
same folder as your experiment files, then you can enter the name of the subfolder followed
by the name of the file (e.g., images\myimage.bmp). Otherwise, you need to specify the full
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path and name of the file you want to present (e.g., c:\mypictures\myimage.bmp).

The advantage of placing the file in the experiment directory (or a subfolder) is that the
experiment folder can then be moved to a different place and you won't have to worry about
checking path names (e.g., c:\..., d:\..., etc.)

If the file is not in the same directory as the experiment, and it's not in a subfolder, then you 
must specify the complete path of the file, e.g., c:\pictures\myimage.bmp

Files may also be located on another computer on your local network. MediaLab can display
files located on any computer on your network as long as the drive has been "mapped" on the
system running MediaLab. For example, a hard drive on another computer may be mapped on
your system as "h:\" or "s:\" etc. If so, you can refer to files on that drive just as you would
local files (e.g., h:\myfiles\myfile.bmp). Ask your network administrator about "mapping" the
drives of other machines on your network if you're new to mapping. See also Running
Experiments Over a Network  for details on how to run an entire experiment from another
machine.

** It's generally not a good idea to place two DirectRT sessions directly back to back in your
experiment. Instead, try separating the sessions with a simple instruction screen of some
type. They should be separated by at least a couple seconds.

4.6 BackGround

QuickInfo

Display an image in the background as the current file is presented.

Value

Any image file with a .bmp, .jpg, or .gif extension

Purpose

In the experiment editor, the file types that support background images are sound files, and
image files. If you would like an image displayed in the background simply type in the name
of the image file in this field.

Advanced Hints

You can specify the location of the background image in the same way as you do for the
primary image using parameter  values. This can be useful if you want to present two
images (one as the main, and one as the background).

To specify the location of the background image, use the top and left parameters. For
background images, place the parameters in parentheses after the file name. For example:

myimage.bmp (t50,l200) 

This will place the background image 50 pixels from the top and 200 pixel from the left. See 
Parameters  for more details.

If you want to present images with Word or HTML documents, you can insert them directly
into the documents.
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4.7 BackSound

QuickInfo

If you would like a sound played in the background while another file type is
presented then simply type in the name of the sound file in this field. Play a wave or
mpeg (mp3) sound file in the background when the current file is presented.

Value

Any sound file with a .wav or .mp3 extension

Purpose

Backsounds are sounds files that play while another file is being presented. Keep in mind that
MediaLab will play backsound files to their completion. This allows for a backsound to play
through multiple items if you care to structure things that way. To have MediaLab wait for the
duration of the sound file and then automatically proceed, use the delay parameter for the
item and specify the length of the sound clip in seconds, e.g., for a 30 second sound clip, use 
(d30). You can find out the length of a sound clip by right clicking on the file in Windows
Explorer and selecting Properties.

Converting WAV files to MP3

Traditional WAV sound files can get rather large especially when they're of high sound quality.
In contrast, MPEG (MP3) sound files are exceptionally small in their size while maintaining
excellent sound quality. With mpeg compression, you can reduce the size of your sound files
by up to 90% without a loss in detectable sound quality. MediaLab includes a freeware utility
called CDex in the Utilities folder that allows you to convert your WAV files to mpeg MP3
format. Run CDex and select Convert -> WAV to MPEG from the main menu. The new MP3
version of your sound files will be copied to the OutputFiles folder of CDex.

4.8 BackVideo

QuickInfo

Display a video in the background as the current file is presented.

Value

MediaLab will play most video files that are supported by the Windows Media Player. 

Purpose

In the experiment editor, the file types that support backvideos are image files, and Word
documents. If you would like a video played in the background simply type in the name of the
video file in this field.

Advanced Hints

You can specify the location and size of the backvideo in the same way as you do for a
primary image using parameter  values.

By default, the backvideo will be centered on the screen and play at its encoded size. To
specify the location of the backvideo, use the top and left parameters. For backvideos, place
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the parameters in parentheses after the file name. For example, myvideo.bmp (t50,l200) will
place the backvideo 50 pixels from the top and 200 pixel from the left. To specify the size of
the backvideo, use the width parameter (the height will automatically be adjusted
proportionally). For example, myvideo.bmp (w640) will play the video at a resolution of
640x480 pixels. A number of special width values are also available (e.g., quarter screen, half
screen, full screen). See parameters  for more detail.

Note that MediaLab uses the Windows Media Player for its video playback engine. If you check
the Use Enhanced Video option under Preferences, MediaLab will use an alternate custom
engine that may provide playback for some formats that can not be handled by WMP (e.g.,
some QuickTime and Real video formats). In general, it is recommended to NOT use this
option unless you have to. If you do choose to try this option, it  is best to have the latest
versions of QuickTime and/or Real Player also installed on your system.

4.9 Randomize Within Groups

QuickInfo

Randomly orders and presents all files sharing the same RWG value.

Value

Any positive integer value

Purpose

You may wish to randomly order and present certain files in your experiment. To do this,
assign the files you want to have randomized with the same number in this field. For
example, if you have five files you want randomized, assign them each an RWG value of 1.
The five files will be randomly presented in the five positions they occupy in the experiment.
All remaining files will be presented in their normal positions as long as their RWG value is
either 0 or none. You can independently randomize another group of items by assigning them
all a 2, another group with 3s and so forth.

Example

In one condition, you want to present 1) Word document, 2) five images randomly ordered,
3) five sounds randomly ordered, and 4) a final Word document. Assign an RWG value of "0"
or none to the Word documents to keep them where they are, a "1" to the five images, and
"2" to the five sounds. That's it. To randomize the order that groups of files are presented (e.
g., whether the images or the sounds are presented first),see Randomize Between Groups  .

Hints

Typically, randomization is used mainly in questionnaires rather than at the experiment level
since data is only collected in questionnaires. However, the functionality is there if you need
it.

34

33



Experiment (.exp) Files 33

© 1995-2006 Empirisoft Corporation

4.10 Randomize Between Groups

QuickInfo

All files sharing the same RBG value define a group to be kept together. If multiple
groups are defined, then MediaLab will present them in a random order.

Value

Any positive integer value

Purpose

You may wish to randomly order and present entire groups of files in a given condition (e.g.,
randomizing whether personality questionnaires or demographic questionnaires come first) .
To do this, assign the same RBG value to all of the items you want to keep together. For
example, if you have three groups of ten files in one condition, and you want to randomize
the order in which these 3 sets of files are presented, then assign each group a different
number and make sure all the files within each group share the same number for that group.
The files within each group will all stay together, but the groups themselves will be randomly
ordered. All files assigned a 0 or none will not move. Note that all files within a group must be
sequential in the given condition.

Example

In one condition, you want to present a Word document, five randomly ordered sets of five
images, and a final Word document. Assign a value of "0" or none to the Word documents to
keep them where they are, a "1" to the images in the first set, a "2" to the images in the
second set, and so forth. That's it. To randomize the order that the files are presented within
each group, see Randomize Within Groups  .

Hints

Typically, randomization is used mainly in questionnaires rather than at the experiment level
since data is only collected in questionnaires. However, the functionality is there if you need
it.
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4.11 Parameters

QuickInfo

Parameters supply additional information for the presentation of certain files. In the
experiment Editor, all parameters are optional but offer the user some nice
flexibility. Parameters can be given in any order, must be separated by commas, and
the entire set must be enclosed in a single set of parentheses. Note that parameters
also can be set for background, backsound, and backvideo files following the same
rules except that their parameters are entered after the filename rather than in the
parameters field.

Parameters

$ quickstyle

c command line arguments

d duration for timed items

l left position

t top position

w width

Parameters for Different File Types

Questionnaire  duration (+/-), $quickstyle

Executable command line arguments

HTML  duration

Image File top, left, duration

Movie top, left, width, duration

PowerPoint Show none

Sound File duration

Word Document duration

Details

$quickstyle (optional)

To apply custom colour and font settings to a questionnaire, you can create a QuickStyle file
from the Preferences menu. To apply it to a questionnaire you can enter the name of the
QuickStyle file precede by a $. E.g., ($mystyle). See QuickStyles  for more detail.

command-line arguments (optional)

For executables that allow for command line arguments, you can specify the arguments you
want to send with the c parameter. Just type in the arguments preceded by a "c" (
cmyargument). Follow any arguments with max and the application will be run in a maximized
window, e.g., (cmax), or (cmyarguments max)
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left position, top position (optional)

These parameters allow you to place an image or video exactly where you want it by
specifying the top left corner of its position relative to the top left corner of the MediaLab
window. The unit of measurement is pixels so placement will depend on what resolution you
are running on your computer. MediaLab attempts to scale most screens so that the same
scale is applicable no matter what resolution you are running. To determine the scale for your
system, go to the MediaLab Help menu and click "Showing Location Points". A left value of
400 and a top value 300 would be entered as (l400,t300).

Note: As of v2004, you can express ANY location and size parameters as a percentage of the
screen. E.g., (w.3,h.25) would be a rectangle 30 percent of the screen's width and 25 percent
of its height. To use percentages, simply use a value less than 1 and greater than 0.

width (optional)

By default, videos play in their origional size. However, you can set the exact size of the video
using the width parameter. The height will automatically be set in proportion to the width you
specify. For example, if you specify (w200) for a video that is normally 320x240 it will appear
as 200x150. You can also use the following shortcuts rather than specifying an exact width (e.
g., w-1, w2, etc.)

§ none or w0 = Default Size

§ w-1 = Full Screen

§ w-2 = Half Screen

§ w-3 = One Fourth Screen

§ w-4 = One Sixteenth Screen

§ w1 = Double Size

§ w2 = Half Size

§ w10 and higher = specified width & proportional height

Note: As of v2004, you can express ANY location and size parameters as a percentage of the
screen. E.g., (w.3,h.25) would be a rectangle 30 percent of the screen's width and 25 percent
of its height. To use percentages, simply use a value less than 1 and greater than 0.

duration for timed items (optional)

The default for many item types (instructions, essays, word documents, fill-in-the-blank,
thought and recall lists, image files) is for the subject to press a key to continue. Optionally,
you can set a duration for these items instead. For example, if you wanted an instruction or
an image to be displayed for 30 seconds and then automatically continue, you would specify 
(d30). You can also limit the time a subject has to complete a given questionnaire using the d
parameter.

Questionnaire files also offer a special option you can use to create a special countdown clock
to tell subjects how much time they have left to complete the questionnaire. On any
questionnaire file, if you use a negative duration value (e.g., d-300) then a countdown clock
will appear at the start of the questionnaire, showing how many minutes and second are left
before the questionnaire will automatically end. The clock will start with the absolute value of
the duration you specify (e.g., d-300 will put 300 seconds, or 5 minutes, on the clock). If you
are using a countdown timer for a questionnaire, try to avoid using duration parameters on
items within that questionnaire that could conflict with your countdown. Note that you can
place a single item in a questionnaire in order to get the countdown timer with a single item.  
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Examples

Image. To set the top left corner of an image to the center of a 640x480 resolution screen:
(l320,t240) or (l.5,t.5)

Movie. To play a video file at full screen on a 800x600 resolution screen: (w800) or (w-1).

Word Document. To display a Word document for 60 seconds rather than allowing the subject
to press a key to continue: (d60)

Background. For a BackGround image to be displayed for 60 seconds with the top left corner
located at the top left corner of the MediaLab window, specify the background file as: 
myimage.bmp (t1,l1,d60)
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5 Questionnaire (.que) Files

Key Concepts

Overview Window

Item Details

BackGround Labels SkipTo

BackSound Name Text Labels

BackVideo Omit Conditions Write Data as Text

Filename Parameters Write Reaction Time

GoBack Position Write To Data File

Item Type Randomize Between
Groups

Item Wording/File Randomize Within Groups

Item Types

Custom Instructions Sound File

DirectRT Movie Thought Listing

Essay Multiple Response Thought Rating

Executable On-Line Rating Voice Response

Fill-in-the-Blank PowerPoint Show WebTracker

HTML Ranking Word Document

Image File Recall List WordPerfect Doc

Inquisit Session Scale Response

5.1 Key Concepts

It is recommended to first read the introduction and key concepts associated with Experiment
Files  before reading this section.

Questionnaires are the foundation of MediaLab. MediaLab questionnaires are very flexible in
terms of presenting files and in terms of data acquisition. The questionnaire editor allows to
you to create, view and edit your questionnaires.

In the experiment file, you identify the files to be presented in your various conditions. These
files can be images, sounds, videos, executables, Word and WordPerfect documents, HTML
pages on your hard drive or the web, PowerPoint shows, and questionnaires. Questionnaires
differ from the other file types in that they are a single self-contained file full of instructions
for MediaLab. These instructions also can tell MediaLab to present various files (e.g., images,
sounds, videos, executables, Word documents, PowerPoint shows etc.), but questionnaires
also contain the instructions for MediaLab to ask questions and gather data.
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MediaLab questionnaires provide instructions for essay-type open ended responses, multiple
choice and multiple response (select all that apply) questions, fill-in-the-blank answers,
continuous on-line ratings, thought and recall listings, and thought ratings (where subjects
rate there own open ended responses on dimensions you define).

In many cases, you may simply want to present information through an HTML document,
Word document or PowerPoint show, or various stimuli via image, sound or video files. After
presenting these files you can have MediaLab ask your questions. Alternatively, MediaLab's
multi-media flexibility also allows you in most cases to combine questions and media,
presenting them simultaneously.

The key concept for creating questionnaires is very similar to that of creating experiments.
You just need to tell MediaLab what you want to present, and the order in which you want it
to happen. Again, the difference is that in questionnaires you also ask questions. This is why
in questionnaires we use the term items rather than files to describe what is being presented.
In contrast when talking about experiments, we use the term files because that is all that
experiments can present.

Another key concept to get with questionnaires is that they are self-contained. Once a
questionnaire file has been created, it can be copied and simply dropped into any other
experiment. This makes creating new experiments extremely easy when certain components
are re-used (e.g., a questionnaire that measures a personality trait, or a questionnaire that
contains a mood inducing video followed with manipulation checks, etc.).

Remember that MediaLab help is context sensitive. When you are creating a questionnaire
and you want to know what the purpose of a particular field is, just place your cursor in the
field and then hit F1. The help files have been designed to take you right to the relevant
information.

5.2 Overview Window

QuickInfo

In the overview editor, you can scroll through the basic information regarding your
questionnaire. In this mode, you can see and define which items are presented to
subjects in your questionnaire, and the order in which they're to occur.

Click on a specific area for help on that topic:
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Hints

Double-click on any position or name field, and the details will be displayed for that item.
When your are editing in the overview window, double-clicking will allow you to edit any field
or will pull open a file search box if a file is required. If you want to edit a field that requires a
filename but do not want to open a file search dialog, then simply highlight the field and
press enter to edit the field directly.

Info

Allows you to save summary information and detailed notes regarding your
questionnaire.

The title and comments are for the Editor's reference only. The comments field has a very
large capacity if you wish to exploit it.

Details

Allows you to set various options for the presentation of your questionnaire items.

Click on a specific area for help on that topic:
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Sort

Sorts the items in the questions by their position values.

The sort button makes life a little easier by automatically reordering all of the files in your
questionnaire so that you need not worry about where you are placing a file at any given
time. When MediaLab sorts the questionnaire items, it will reorder the items by their ordinal
position. If you forget to do this, MediaLab will do it automatically when you exit. You can
manually sort whenever and as often as you like by clicking the Sort button.

Hints

To add a new item between two existing items (e.g., at positions 2 and 3), assign it a position
value between these values (e.g., 2.5) and then click the Sort button. After sorting, you can
automatically renumber all of your items with sequential integers by clicking the renumber
button.

Renumber

Renumbers the position  values in the questionnaire with sequential integer
values.

The renumber button cleans up your position numbering by replacing the values with
sequential integers. The first item will get a position value of 1, the second will get a 2 and so
forth. This is not a necessary operation and is provided mainly for the purpose of aesthetics
and to help you know that you have the correct number of items your questionnaire.

Hint

If your items are out of order, be sure to sort  before you renumber.
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Print

See Experiment Editor, Printing  

Help

Starts the interactive help system. You can search the documentation using the Contents,
Index and Search tabs in the left-hand window. Also note that MediaLab takes advantage of
context sensitive help such that pressing F1 at any time will often direct you immediately to
help with what you are working on. A printable PDF copy is available in the C:\MediaLab\Help
folder.

Save

Saves the current file.

Save As

Saves the current file with a new name and/or location.

OK

Closes the Details window and returns to the Overview window.

Navigation

There are many ways to navigate your way around the questionnaire editor. The most useful
methods to be aware of are:

To jump from field to field, you can simply click on the field you want to edit.

You can also use the Tab key and the arrow keys to jump from one field to the next

When your are editing in the overview window, double-clicking will allow you to edit any field
or will pull open a file search box if a file is required. If you want to edit a field that requires a
filename but do not want to open a file search dialog, then simply highlight the field and press
enter to edit the field directly.

All forms have a button with a check mark. This button closes whatever editor you are
currently in. You will always be given the option to save any changes that you've made.

Details Editor

In the details editor, you will notice four buttons with arrows. The first key will take you to the
details of the first item in your questionnaire. The second takes you to the item immediately
preceding the one you are currently editing. The third takes you to the next, and the fourth
takes you to the last.

15
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5.3 BackGround

QuickInfo

Display an image or HTML file (or URL) in the background as the current item is
presented.

Value

Any image file with a .bmp, .jpg, or .gif extension, or any HTML or URL.

Purpose

In questionnaires, the item types that support background images are:

Essays

Sound files

Image files

Instructions

Scale Response

Multiple Response

Fill-in-the-Blank

Thought-listing

Recall-listing

If you would like an image, html file or web page to be displayed in the background simply
type in the name of the file in this field. Note that if all you want to do is present an image or
HTML file, then just use the Image or HTML item.

Important Note

If you want to display an HTML file or URL as a background image you MUST specify the size
and location of the area in which you want it displayed. This is because the browser display
area will cover and hide most other items that it overlaps so it's very important to specify the
area in which you want it (see below under Advanced Hints). To do this, use the top (t), left
(l), height (h) and width (w) parameters. For example, if you have some specially formatted
instructions in an HTML file that you want to use for a scale response, you could you could
enter "instructions.htm (t50,l50,w400,h150)" in the BackGround field for that item. This
defines an area for the html to appear that will not cover the buttons and labels of the scale
response.

Advanced Hints

You can specify the location of the background image in the same way as you do for a
primary image using parameter  values. This can be useful if you want to present two
images (one as the main, and one as the background), or to present an image at the same
time as a question item (e.g., to get judgments of the image).

To specify the location of the background image, use the top and left parameters. For
background images, place the parameters in parentheses after the file name. For example,
myimage.bmp (t50,l200) will place the background image 50 pixels from the top and 200
pixel from the left. See parameters  for more details.

If you want to present images with Html, Word or Word Perfect documents, you can simply
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insert them into the documents themselves.

Handy Pop-Up Links In Your Questionnaires 

Inserting some html with pop-up links in your background can allow your participants to click
a link on the question page to see a message, helpful hints, instructions, translations, or any
other text elaboration. 

5.4 BackSound

QuickInfo

Play a wave or mpeg (mp3) sound file in the background when the current item is
presented.

Value

Any sound file with a .wav or .mp3 extension

Purpose

In questionnaires, all items support backsounds. If the item is a movie or sound file that
already has sound content, then the content of the backsound will be superimposed. If you
would like a sound played in the background when another item is presented then simply type
in the name of the sound file in this field.

Hint

Keep in mind that MediaLab will play backsound files to their completion. This allows for a
backsound to play through multiple items if you care to structure things that way. To have
MediaLab wait for the duration of the sound file and then automatically proceed, use the delay
parameter for the item and specify the length of the sound clip in seconds, e.g., for a 30
second sound clip, use (d30). You can find out the length of a sound clip by right clicking on
the file in Windows Explorer and selecting Properties.

Note about Sounds versus BackSounds:

For flexibility in playing sound files, they can be presented as a Sound item or they can be
presented as "BackSounds" to other items. Note that Sound items end automatically when the
next item appears even if they have not yet completed. In contrast, BackSounds continue
until completion (overlapping subsequent items) or until another backsound is encountered.
Thus Sounds and BackSound can be used strategically to accomplish different effects. Note
that if you need to stop a BackSound upon item completion then you can simply insert
"silence.wav" as the backsound for the subsequent item. It is a short silent sound file that will
cancel any currently playing BackSound. Silence.wav can be found in the Utilities folder.

Converting WAV files to MP3

Traditional WAV sound files can get rather large especially when they're of high sound quality.
In contrast, MPEG (MP3) sound files are exceptionally small in their size while maintaining
excellent sound quality. With mpeg compression, you can reduce the size of your sound files
by up to 90% without a loss in detectable sound quality. MediaLab includes a freeware utility
called CDex in the Utilities folder that allows you to convert your WAV files to mpeg MP3
format. Run CDex and select Convert -> WAV to MPEG from the main menu. The new MP3
version of your sound files will be copied to the OutputFiles folder of CDex.
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5.5 BackVideo

QuickInfo

Display a video in the background as the current item is presented.

Value

By default, MediaLab will play any video file that is supported by the Windows Media Player.
This typically includes .mpg, .avi, .asf, .wmv, .dat, and .mpv video formats. So long as your
are not running MediaLab on Windows 95 or NT you may also take advantage of MediaLab's
own enhanced video functionality by selecting this option on the Preferences menu. Doing so
will allow you also present QuickTime (.mov) and Real (.ra, .rm) video formats providing that
QuickTime and/or Real Player are also installed on your system.

Purpose

In questionnaires, all item types support backvideos except executables, DirectRT and Inquisit
sessions. If you would like a video played in the background simply type in the name of the
video file in this field.

Advanced Hints

You can specify the location of the backvideo in the same way as you do for a background
image using the top and left parameter  values.

By default, the backvideo will be centered on the screen and play at its encoded size. To
specify the location of the backvideo, use the top and left parameters. For backvideos, place
the parameters in parentheses after the file name. For example, myvideo.bmp (t50,l200) will

place the backvideo 50 pixels from the top and 200 pixel from the left. To specify the size of
the backvideo, use the width parameter. For example, myvideo.bmp (w300) will play the
video at a resolution of 300 by its proportional height. See parameters  for more details.

5.6 Filename

QuickInfo

Identifies the filename when the item is an image, sound, movie, executable, or
Word document.

Value

If the item is one of the following file types, then this field will provide the file name for the
item.

DirectRT  Any DirectRT .csv input file

HTML  Any .htm or .html document

Image  Any .bmp, .jpg, or .gif image file

Inquisit  Any Inquisit experiment file

Executable  Any .exe program (DOS, Windows 3.1, or Windows 95)
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Sound  Any .wav or .mp3 sound file

Movie  Any .avi, .mpg, or .mov video file

Word Doc Any Microsoft Word .doc file

WordPerfect  Any WordPerfect .wpd file

PowerPoint  Any Microsoft PowerPoint .pps file

Also

Scale Responses and Fill-in-the-Blank

If you specify a file name ending with .txt for a scale response or fill-in-the-blank item, the
subject's response to the question will be written to that text file preceded by a ~. This is so
that other programs you may want to run during the session have the option of reading and
acting on this information. It was particularly intended for use with DirectRT so that responses
provided by subjects could be used as stimuli in an embedded DirectRT session.

Hints

Double-click on the File field to browse your hard drive and select files automatically.

To be safe, you can always specify the complete file path (e.g., "c:\experiments\myexp
\myimage.bmp"). If you specify a complete path, remember to make sure the path is the
same if you load the experiment onto other computers.

Advanced Hints

If the file is located in the same folder as your experiment file, then you can simply enter the
name of the file (e.g., myimage.bmp). If the file is located in a subfolder that is located in the
same folder as your experiment files, then you can enter the name of the subfolder followed
by the name of the file (e.g., images\myimage.bmp). Otherwise, you need to specify the full
path and name of the file you want to present (e.g., c:\mypictures\myimage.bmp).

The advantage of placing the file in the experiment directory (or a subfolder) is that the
experiment folder can then be moved to a different place and you won't have to worry about
checking path names (e.g., c:\..., d:\..., etc.)

Finally, do not place any parameter  values in this filename field. Any relevant parameters
should go in the parameters field. Parameters should follow the filename only for backgrounds

 , backsounds  and backvideos  .

5.7 GoBack

QuickInfo

If checked, an option will be provided to participants to return to the previous
questionnaire item.

Values

True (checked) or False (unchecked)

Purpose

In the details window of a questionnaire file, you can check GoBack for any questionnaire
item. If you check the GoBack option for any given item, then that item will be provide
participants with a "Go Back" button which can be clicked to return to the previous
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questionnaire item. This is especially useful if you are concerned about participants entering
responses they might want to go back and change.

If you check the GoBack option for a sequence of items, then participants will be able to back
up through the questionnaire. Note though that the GoBack function is limited to the current
questionnaire and will not let participants return to a questionnaire they have completed.

5.8 Item Type

Item Types

Custom Instructions Sound File

DirectRT Movie Thought Listing

Essay Multiple Response Thought Rating

Executable On-Line Rating Voice Response

Fill-in-the-Blank PowerPoint Show WebTracker

HTML Ranking Word Document

Image File Recall List WordPerfect Doc

Inquisit Session Scale Response

The following are descriptions of the various item types that can be included in a MediaLab
questionnaire. See also information on how to set parameters .

Custom

Can't find what you need? MediaLab now allows you to create your own custom item types
using Visual Basic, Visual C++ or other development platforms using the MediaLab ActiveX
control. You can reuse your custom item type in other experiments or share it with others.
Data are integrated with MediaLab's regular data files. Limited only by your imagination (ok,
and maybe a little programming ability :) See Creating Custom Item Types .

DirectRT

To embed a DirectRT session within your questionnaire, simply select the DirectRT item type
and enter the name of the input file in the File field. MediaLab will pass the current subject
and condition values to DirectRT which will run the session and then pass control back to
MediaLab when it's finished. Note: DirectRT takes a few moments to start up and shut down.
It's generally not a good idea to place two DirectRT sessions directly back to back in your
questionnaire. Instead, try separating the sessions with a simple Instruction item (e.g., that
says Click Continue to proceed). See DirectRT for more details on how to obtain DirectRT and
what you can do with it. Note that MediaLab can save certain responses for later use as
stimuli in a DirectRT session, see more .

Essay

An essay item allows subjects to enter a response of unlimited length. Subjects will be given a
full screen in which to type their response, with your question wording at the top of the
screen. The Esc key will end the response, which you can explain in your question wording if
you like, or you can set a time limit with the optional parameter, duration. Data for essay
questions will automatically be written to a separate file named with the variable name you
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assign to the item.

You can also specify the height, width and top and left points of the essay text box using the
h, w, l, and t parameters respectively. This allows additional room for question wording or for
background images/html.

Note about RTs. By default, response times for fill-in-the-blank and essay questions taken at
the time the subject continues to the next item. You can  optionally get it for the first key
stroke instead by using the parameter (k1).

Executable

In the case that MediaLab can not meet your needs for a particular experiment or
questionnaire, MediaLab will run any other program for you (including DOS, Windows 3.1, and
Windows 95/98/NT/2000/XP programs). Simply embed the program within your questionnaire
by selecting the executable item and specify the file name under File. Hint: MediaLab writes
the current subject number and condition to a file called CurrentSubjectInfo.txt at the
beginning of every session in case you want your custom program to access this information.
The Visual Basic code to do this is:

Open "c:\medialab\currentsubjectinfo.txt" For Input As #1
Input #1, subject: subject = Mid(subject, 11, Len(subject) - 10)
Input #1, condition: condition = Mid(condition, 11, Len(condition) - 10)
Close #1

If your program uses command line arguments, you can specify them with the optional
command line parameter. Note that embedded executables can not integrate their data with
MediaLab's. If this is something you need then this can be accomplished with a custom item
type (see Custom above). 

Note that for all other item types, an executable file may be launched at the start of the item
by adding a "c" parameter followed by the file name, e.g., (p7,cmyprog.exe) would cause

myprog.exe to launch at the start of a 7pt scale response. This is especially useful for
programs that should run silently in the background as MediaLab will not attempt to keep the
program visually in the foreground unless it is launched via the Executable item type. 

Fill-in-the-blank

Exactly as it sounds. Provide the question wording and the subject will be provided with space
for a short open-ended answer. Fill-in-the-blank responses become available for insertion
within the question wording of subsequent items. See question wording  for more details.

You can limit the response to a number by using the range parameter. For example, to accept
only a valid age, you might use (r16-125) which would require a response between 16 and
125. The user will be prompted to enter a number within that range if they fail to do so.
Negative values are permitted.

You can also use the mask parameter to specify the number of characters allowed in the
response and you can specify whether each is fixed or free. For example, the parameter
(m*****) will provide five blanks. The parameter (m***ck) will offer three blanks followed by
"ck". Fixing characters in this way allows subjects to offer partial responses such as in a word
completion task.

You can also combine the range and mask parameters. For example, the parameters
(m*********, r100000000-999999999) could be used to prompt the subject for a valid,
nine-digit social security number.

In cases where you need more space for a fill-in-the-blank item, you can use the optional s
pace parameter to tell MediaLab how many lines of text you want to allow. For example, a
parameter of (s3) will provide three lines of text instead of one (the default). Note that if you
specify more than 1 line, the Enter key will not send the subject to the next item but rather to
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the next line in the text box. The Escape key may be used as an alternative to the Enter key
in such cases.

You also have the option to specify the size and location of the fill-in-the-blank text field using
the top, left, height, and width parameters in the same way you would use them for an
image.

Finally, any time a subject answers a fill in the blank or scale response, their response is
saved so you can access it and embed it within the question wording of any subsequent
question. Just type the variable name of the response you want to embed in the question
wording surrounded by <>. For example, if you have a fill in the blank variable called "fb1"
then you can insert the subject's response to that question in any subsequent question
wording using <fb1>. The same goes for scale responses.

Note about RTs. By default, response times for fill-in-the-blank and essay questions taken at
the time the subject continues to the next item. You can  optionally get it for the first key
stroke instead by using the parameter (k1).

HTML

Displays an HTML file exactly as it would appear in Microsoft's Internet Explorer. MediaLab will
open a full screen browser window to display the HTML or other URL that you specify. The
HTML page will be fully active so that the subject can click on hyperlinks or other objects and
browse to other pages that you make available. HTML files can be located either locally or on
the internet. Simply choose the HTML item and then enter the location of the HTML file in the
file field (e.g., c:\experiment\stim1.htm, or www.mysite.edu/stim1.htm). Both .htm and .html
are acceptable suffixes. To limit browsing by time, use the duration parameter, otherwise, the
subject can click Continue to proceed. Any Java or ActiveX applications will be fully
supported. 

Optionally, you can have navigation buttons appear while HTML pages are displayed. You can
display any or all of: back, forward, home (will return to the starting URL), refresh and
search. To enable this option, simply create a text file in your experiment folder called
"browser.txt" and copy the following into it, changing true to false for any buttons you do not
want displayed.

back = true
forward = true
stop = true
home = true
refresh = true
search = true

Note that the HTML item is capable of displaying many other file types than just HTML.
Essentially, MediaLab passes whatever file or URL you specify to the Internet Explorer
Browser engine. So, if you can view it in Explorer, then you can present it using the HTML
item type. So if you have a file of any type that you want to display in MediaLab, try
specifying it as the filename in an HTML item (see also Word Document item below).

Caution: HTML pages that require input may have a subject pressing the spacebar as a part of
that input. Since the spacebar is also used in MediaLab to continue with the next item, this
can cause a conflict. If this applicable to your HTML file, you can add a (k-1) parameter to
disable the spacebar as a means to proceed to next item. 

Image File

Displays an image file. MediaLab supports BMP, GIF and JPG image formats. You can specify
the location of the image on the screen using the optional top and left parameters. Hint: To
display two images at a time you can select a background  image and place it accordingly,
or you can insert multiple images in an HTML or Word file and then simply present that
instead. To get ratings of an image, use a Scale Response and use the image as a background
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image.

Images by default appear in their actual dimensions. Optionally, you can use the height and w
idth parameters to specify the image display size. Note that if you size an image using the
height and width parameters you need to also specify the top and left parameters otherwise it
will appear in the top left corner by default. Note that size and location parameters vary slight
depending on your display settings. MediaLab provides a guide for understanding these values
in the Help menu with an option called "Show Location Points."

Advanced Hints: BMP files will load faster than JPG or GIF formats because they do not have
to first decompress. Also, 256 (8-bit) color images will load much faster than images encoded
with thousands or millions of colors. Most image editing programs will allow you to convert
images to 256 colors without a noticeable degradation in quality. If you do see a noticeable
difference, try another image editor (e.g., IrfanView is very good and can be downloaded
from http://www.irfanview.com). All MediaLab images (e.g., the blue screen, the MediaLab
rats, the opening splash screen, etc. are 256 color images. The reason the display should be
set to thousands or millions of colors is so that multiple 256-color images can be displayed
simultaneously.

Instructions

For many instructions, you may not want to go to the effort of creating a Word or HTML
document. In many cases, simple text will do it. In such cases, choose the Instructions item
and provide the text you want displayed in the Question Wording field. By using the x
parameter , you can require that a password be entered to continue beyond the instruction
screen. This is a handy way to prevent subjects from continuing after a certain point without
experimenter intervention. Note that you can also set a password for the end of all
experiments in Preferences .

You can optionally control the positioning of instruction text using the top and left
parameters. You can also place a BackGround , BackSound  or BackVideo  on any
instruction screen.

Instruction items also allow you to specify the onset parameter like other items to create a
delay before the text appears. Note that the response time (if you choose to record it) will
include the onset value.

To control the amount of time that instructions are presented, you can use the duration
paramater as you would with other item types. Instruction items also offer a unique option
you can use to create a minimum exposure time. On any instruction item, if you use a
negative duration value (e.g., d-10) then the Continue button will not appear until that many
seconds have passed. You can use this option to ensure that subjects are exposed to some
information for a minimum amount of time, after which they may proceed when ready.
Remember that you can always embed images, html, sound and video in an instruction item
by using backgrounds, backsounds, and backvideos respectively.

Inquisit

To embed an Inquisit session within your questionnaire you must have Inquisit build 1.25 or
later installed and operational (see www.millisecond.com). Note: Build 1.32 is incompatible!
Simply select the Inquisit item type and enter the name of the Inquisit experiment file in the
File field. MediaLab will pass the current subject values to Inquisit which will run the session
and then pass control back to MediaLab when it's finished.

Movie

Presents a video file. By default, MediaLab will play any video file that is supported by the
Windows Media Player. This typically includes .mpg, .avi, .asf, .wmv, .dat, and .mpv video
formats. So long as your are not running MediaLab on Windows 95 or NT you may also take
advantage of MediaLab's enhanced video functionality by selecting this option on the
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Preferences menu. Doing so may allow you also present QuickTime (.mov) and Real (.ra, .rm)
video formats (see  note below)

You can specify the location of the video on the screen using the optional top and left
parameters. You can specify the size of the video using the width parameter (the height will
automatically be set in proportion). Movies can also be shown simultaneous with most other
items types by specifying a video file in the backvideo field.

Note: MediaLab uses the Windows Media Player for its video playback engine. If you check
the Use Enhanced Video option under Preferences, MediaLab will use an alternate custom
engine that may provide playback for some formats that can not be handled by WMP (e.g.,
some QuickTime and Real video formats). In general, it is recommended to NOT use this
option unless you have to. If you do choose to try this option, it  is best to have the latest
versions of QuickTime and/or Real Player also installed on your system.

Multiple Response

The "check all that apply" multiple response format is the standard format to use when you
want to offer closed ended response alternatives AND allow subjects to select one or more of
the response alternatives. Use from 1 to 12 response options and provide a text label for
each. Subjects can select and deselect multiple response options by hitting the appropriate
key or clicking the appropriate button with the mouse. You can also have them use the
function keys (F1 through F12) in order to respond when 10 or more alternatives are
presented. MediaLab will create a unique variable for each option and record whether or not
each item was selected (1) or not (0).

Multiple response items require the p parameter  to indicate how many response options to
use, e.g., (p5) for five options. You can optionally add a range parameter to specify a
minimum and/or maximum number of responses to take. For example, (p5,r1-3) would
require that the subject choose at least 1 and no more than 3 of the 5 options. To require a
single response, you could specify r1-1. Multiple response items support backgrounds,
backsounds, and backvideos.

You can also now include <specify> in the text label of any response option. This will not be
displayed to the subject but will cause MediaLab to prompt subjects to enter a text response.
This is handy in cases where you want to provide an alternative such as "other" e.g. If you
wanted the seventh option to be "other" and you wanted subjects to specify what "other"
means, then enter other <specify> for the text label. The actual text response will be written
to the data file instead of whether or not the item was selected. If you choose to use this
feature, you should select the Write As Text option for the variable since a numeric variable in
SPSS will not be able to store a text response.

Multiple Response items support all of the same optional parameters as Scale Responses
(below).

On-Line Ratings

The new on-line ratings feature allows you to capture continuous response data from subjects
over the course of an entire item (e.g., movie, sound file, timed image or document). Using
either a joystick (default if one is connected) or the left and right arrow keys, subjects will be
asked to give continuous rating feedback for the duration of the item following the on-line
rating item. All you need to do is set the number of scale points for the rating scale and the
text labels for the scale points (use none to leave a label blank).

When the subsequent item starts, MediaLab will present the online rating scale which subjects
can move up or down by using the joystick or arrow keys. MediaLab will take 10 samples
every second and average these to provide a value for that second. MediaLab will continue
doing so for the duration of the item and then write these values to a separate data file which
will be named after the item being rated. For example, if you have subjects perform an online
rating of a movie item called movie1, then all the online data will be stored in a file called
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movie1_online.csv. This file can be opened in Excel or other spreadsheet application for
viewing.

Note that there is also a viewer included in the utility folder called "OnLineViewer". You can
open any online output file to view the data plotted as a continuous graph with this program.
You can also select by subject, by condition and you can set the time interval you want to see
plotted. At any time, you can also copy the plotted values and paste them into Excel or
another spreadsheet for further manipulation or graphing.

Note that there is also a joystick calibration program located in the utilities folder as well.

PowerPoint Show

Presents a Microsoft PowerPoint show. This is an ideal way to present impressively formatted
sequential display screens. Using PowerPoint, simply create a slide show. Create what ever
you want and then save the file as a PowerPoint show (.pps format). Then, enter the filename
in the Experiment editor in the position and condition(s) you want it to occur, or enter it as an
item within a questionnaire. PowerPoint shows do not require any parameters.

Hint: If you are new to PowerPoint, follow these steps to create your first slide show.

§ Open PowerPoint and select File->New from the main menu. Choose the Presentations file
tab and select a template (the Business Plan, Standard is very cool).

§ Click on the text and replace it with whatever you like (e.g., ‘Welcome to the experiment!"
Use the Page Down key to advance to the next slide and edit it as well.

§ Add new slides with the Insert->New Slide command. Delete slides with the Edit->Delete
Slide command.

§ When you're happy with the show, select File->Save As from the main menu. In the window
that appears, click on the Save As Type box and select PowerPoint Show (*.pps). Enter a
name for the file.

§ Drop it into your questionnaire or experiment file. You're done!

§ Hint: Open PowerPoint and go to Tools->Options->View->SlideShow and click off all three
options. This will eliminate the right clicking/popup issue as well as eliminate the "end of
slide show" screen in case you're getting that as well.

Ranking

With the ranking item, you can give subjects up 12 items to rank in any order they choose.
The items will appear as labels that subjects will be able to drag and drop into a special
ranking area using the mouse. To design your ranking item, first enter a points parameter to
indicate how many items you want to have subjects rank. For example, to have 6 items
ranked, enter (p6) in the parameters field. This will allow you to enter those 6 items in the
text labels area. Enter any text you like. As of v2006, you can also have participants rank
images. To do so, enter the name of each image file in a text label field. For examples of
ranking (standard and with images), visit our Experiment Sharing area at support.empirisoft.
com.

That is all that's necessary for a ranking item, but there are a number of formatting options.
For example, you may choose to have an instruction window pop up at the start of the item.
You can do so by entering text in the question wording field for the item. Subjects will be able
to bring these instructions up again at any time by clicking the Instructions label at the
bottom of the screen.

You can display labels at the top and bottom of the ranking area such as "Most Important"
and "Least Important" so that subjects know which items go toward the top and which go
toward the bottom. To do so enter these labels in the question wording area after the
instructions (if any) like this:

http://www.empirisoft.com/Support/showthread.php?t=202
http://www.empirisoft.com/Support/showthread.php?t=202
http://support.empirisoft.com
http://support.empirisoft.com
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=Most Important, Least Important

If you don't have any question wording then you can simply type the labels in the question
wording field preceded by an equals sign.

By default, the ranking items will be as wide as they need to be to fit on one line. Long words
and phrases will consequently be wider than short words and phrases. If you have entire
sentences being ranked, you may find they are too wide. There are two ways to control the
size of the items. First, you can specify a width parameter. This will force the items to be a
constant width and the text will wrap to accommodate the width—i.e., becoming multi-lined.
A second way you can control the size is by specify font size parameter. E.g., to display 6
items with a fixed width of 250 pixels and a font size of 7, you would use parameter values
of: (p6,w250,s7).

When saving the data, MediaLab will create a unique variable for each of your ranked items
and save it's ordinal value in the ranking as its value. For example, if your ranking item's
variable name were "rk1", then the fourth item in your list will be called rk1_04. If that forth
item were ranked second, the value of rk1_04 would be 2. If you select the Write Reaction
Time option for a ranking item, you will also get the first time each item was selected by the
subject—these values will be recorded as typical RTs using the same variable name preceded
with a t (e.g., trk1_04).

Recall List

Allows subjects to indicate what they can recall, one memory at a time. Operates in the same
was as thought listings (see below). Supports backgrounds, backsounds and backvideo.

Scale Response

The scale response format is the standard format to use when you want to offer multiple
closed ended response alternatives. Use from 1 to 12 response options and provide a text
label for each. Subjects can select a response option by hitting the number key that
corresponds to the alternative or you can have them use the function keys (F1 through F12)
in order to respond when 10 or more alternatives are presented. Scale responses require the 
points to indicate how many scale points to use, e.g., (p5) for a five point scale. Scale
responses support backgrounds, backsounds, and backvideos. The selected response also
become available for insertion within the question wording of subsequent items. See question
wording  for more details.

By default, scale responses offer a single line for the text labels. In case where you need more
space because of long labels, you can use the spacing parameter. This allows you to create
more space for labels with lots of text or if you're using an html file for your labels. For
example, if you want to "double-space" your response options to create more space, use the
parameter (s2), or (s3) to triple space, or (s1.5) to add a half space and so on. You can enter
any value from 1 to 5 and decimals are ok. This will produce evenly spaced response options
with as many extra lines per item as you need. Importantly you can do this on an item by
item basis--the default of course is single space if you don't specify the space parameter.

By default, scale responses are presented vertically. They can be presented using a horizontal
format by using the width parameter to specify the width of the scale (see Help -> Show
Location Points for help with sizing on your system). For example, (w.7) would make the scale
span 70% of the screen width. Scales will be centered in this space.

With both horizontal and vertical scale formats, you can specify how far down the buttons
appear by using the top parameter. This can help to create more space for extra question
wording. Note that if you don't see your scale you might have moved it down too far (i.e., try
a smaller top value).

To force a subject to answer with a correct response you can enter the item's variable name
as a skipto value for any incorrect answers. For example, if a question's variable name is q1
then simply enter q1 as a skipto value for any response options that are wrong. If one of
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these options is selected, the subject will be prompted to try again. Response times will
reflect the time of the first correct answer.

Finally, you may want a subject to specify their answer if, for example, you give the an
"Other" option. Just include <specify> in the text label of the response option. This will not be
displayed to the subject but will cause MediaLab to prompt subjects to enter a text response if
they choose this option. For example, if you wanted the seventh option to be "other" and you
wanted subjects to specify what "other" means, then enter other <specify> for the text label.
The actual text response will be written to the data file instead of response number. If you
choose to use this feature, you should select the Write As Text option for the variable since a
numeric variable in SPSS will not be able to store a text response.

Sound File

Plays a .WAV or .MP3 format sound file. For WAV files, larger sound files may take a few
seconds or longer to load. Note that 8-bit mono sound files will load and play much faster
than will 16 bit stereo sounds. In contrast, MP3 audio files are much smaller in size and will
start to play immediately. Importantly, MP3 sound files are compressed with virtually no loss
in sound quality! There is a freeware WAV to mpeg (MP3) conversion program included in the
utilities folder called CDex. Simply run CDex and select Convert, WAV->MPEG. Select your
WAV file and you'll find the newly created MP3 file located in the OutputFiles folder of CDex.
Sound files support backgrounds, backsounds (which will play simultaneously) and
backvideos.

Note about Sounds versus BackSounds

For flexibility in playing sound files, they can be presented as a Sound item or they can be
presented as "BackSounds" to other items. Note that Sound items end automatically when the
next item appears even if they have not yet completed. In contrast, BackSounds continue
until completion (overlapping subsequent items) or until another BackSound is encountered.
Thus Sounds and BackSound can be used strategically to accomplish different effects. Note
that if you need to stop a BackSound upon item completion then you can simply insert
"silence.wav" as the backsound for the subsequent item. It is a short silent sound file that will
cancel any currently playing BackSound. Silence.wav can be found in the Utilities folder.

Thought Listing

The thought listing is used when multiple open-ended responses are desired for a single
question. For example, a common use for this item-type is to expose subjects to information
and then ask them to indicate the thoughts that occurred to them during exposure. Thought
listings require the n parameter  to indicate the number of responses you want listed, e.g.,
(n4) for four thoughts. If you wanted to them to list up to 4, you can set a time limit using
the duration parameter. Note also that the escape key will end the thought listing question.
You can optionally inform subjects of this so that they can continue whenever they are done
listing their thoughts. You can also specify a time limit for the thought listing using the d
uration parameter.

Thought Rating

MediaLab allows you to have subjects rate their own open-ended responses from thought or
recall lists on any dimension you like. The thought rating works much like a scale response
but feeds back to subjects their responses from an earlier thought or recall list question. To
do this, you need to specify the variable name you gave to the thought or recall list from
which MediaLab is to supply the responses. For example, say subjects listed their thoughts
earlier in a variable you named tlist. To have subjects later rate these thoughts using a
thought rating item (for example how positive or negative each thought was), you would
specify the parameter  (qtlist) in your though rating item. Note that for thought ratings, you
must also specify the number of scale points parameter (above). Supports backgrounds,

60

60



MediaLab v200654

© 1995-2006 Empirisoft Corporation

backsounds, and backvideos. Thought Ratings also support all of the same optional
parameters as Scale Responses (above).

You can also include <specify> in the text label of any response option. This will not be
displayed to the subject but will cause MediaLab to prompt subjects to enter a text response.
This is handy in cases where you want to provide an alternative such as other e.g. If you
wanted the seventh option to be other and you wanted subjects to specify what other means,
then enter other <specify> for the text label. The actual text response will be written to the
data file instead of whether or not the item was selected. If you choose to use this feature,
you should select the Write As Text option for the variable since a numeric variable in SPSS
will not be able to store a text response.

Voice Response

MediaLab allows you to record voice responses and optionally measure the reaction time of
those responses. To save a voice response as a sound file, simply enter a name in the
filename field. It will automatically be saved by that name in a Voice subfolder within the
main Data folder. If you specify none then no sound file will be saved. If you check Write
Reaction Time then you will get the latency of the response in milliseconds. You can check this
option and specify none for the filename if you are interested only in the RT.

By default, MediaLab will record the voice response until the subject clicks Continue. You can
optionally specify the duration parameter to record the voice response for a fixed time. E.g.,
(d5) would record a voice response for 5 seconds and then automatically continue to the next
item.

Voice Response Setup

Recording voice responses and voice RTs requires that Microsoft's DirectX, Version 7 or later
be installed on your system. You can determine what version (if any) you have by typing 
dxdiag from the Run command on the Windows Start Menu. DirectX can be downloaded from
www.microsoft.com/windows/directx.

You will need to make sure you have a microphone connected to the microphone input
connector on your sound card. You will also need to make sure that the microphone is active
and able to record. Finally, you will need to tell MediaLab how sensitive it should be in
detecting response times.

To make all this easier, MediaLab comes with a tool called SoundCheck, which can be located
here:

C:\MediaLab\Utilities\VoiceResponse\SoundCheck.exe

After making sure your microphone is plugged into your soundcard, click Monitor and speak
into the microphone. If all is well, you should see the bar labeled Microphone Level respond
immediately to your voice. If that works, then click Stop to end the monitoring. Now try a
sample voice rt. Click Test RT and then speak into the microphone. SoundCheck should report
the response time in milliseconds.

If you need to speak too loudly to set off the test, then try moving the sensitivity slider
toward the left. If the test is set off too easily, then try moving the sensitivity slider toward
the right. Try this until you find an RT sensitivity that works well for you. When you are happy
with the sensitivity, click Save. This will make the new sensitivity level available to MediaLab
when you run a session with voice responses. It is advisable to run a few test RTs on any
machine before running a MediaLab session with voice responses for the first time. Note:
Some users have reported that optimal performance for Voice RTs requires restarting
MediaLab between sessions. While we work on figuring out why, we'll simply pass on this
recommendation.

http://www.microsoft.com/windows/directx
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Web Tracker

The HTML item type allows you to present HTML and other "browser-compatible" files. The
WebTracker item extends this functionality by tracking a subject's behaviour while browsing
through a sequence of HTML or other browser-compatible files. It stores each link that the
subject follows as well as the time at which the link was followed and how long the subject
stayed there before continuing to the next link. The item ends when the subject clicks the
"Continue" button. These data are all written to a separate spreadsheet file (.csv) that will be
named after the variable name you assigned to the WebTracker item and will be located in
the experiment's data folder.

Word and WordPerfect Documents

Note: Some systems have a hard time displaying Word documents. If you have any trouble,
simply save your documents in Word as HTML (using Save As) and then present them as
HTML items instead.

Present nicely formatted text by inserting a Word or WordPerfect document. Since MediaLab
presents these documents exactly as they appear when you see them in Word or WordPerfect,
you can exploit all of the formatting power available in these applications. Basically, however
it looks in Word or WordPerfect is how it's going to look in MediaLab. You can even embed
images or other objects in your document and they will appear in MediaLab. Word and
WordPerfect documents support backsounds and backvideos. Each application must be
installed on the system in order to take advantage of this functionality.

Some important considerations for using Word and WordPerfect documents with MediaLab

§ Each screen you want to show must be a separate Word/WordPerfect document.
Documents that will not fit on one screen can be broken up, saved as separate files and
presented sequentially. If you need all of your document presented in one long sequential
file that users can scroll through, consider saving your file as HTML and presenting it as an 
HTML item (see above)

§ Document margins and text size will depend on your display resolution. Wider documents
can be viewed when your monitor display is set at 800x600 than when it is set at 640x480
and so forth.

§ Some documents may appear without regard to their top and left margins (i.e., the text will
appear to the very left and very top of the screen). If you experience this, don't bother to
adjust your margins. Instead, select the text and increase the paragraph indentation (on
the menu, select format > paragraph.). For extra space at the top, insert hard returns. This
solves the problem.

§ Microsoft Word may warn you about macros when MediaLab attempts to present a Word
file. You can choose to disable macros, or you can save your documents without macros (I
know saving them in Word 6.0/95 format does this, but I don't do this—I just tell Word not
to bother me). Either way, if this happens, you can tell Word not to warn you about this
every time so that this window does not pop up every time MediaLab displays a document
with macros in it.

§ MediaLab uses a 2-second keyboard/mouse cancellation buffer for Word/WordPerfect
documents to avoid accidental skipping of Word documents. This is done because Word
documents may take a second or two to load and subjects may "continue" repeatedly while
this is happening.

Note that Word Document item is also capable of displaying many other file types than just
Word Documents. If you have a file of any type that you want to display in MediaLab, try
specifying it as the filename for Word Document items (see also HTML items above).
MediaLab will attempt to cooperate with the file's usual program to have it displayed correctly
(e.g., an Adobe Acrobat file, an Excel Spreadsheet, a Flash Presentation, etc.). Of course this
depends on how cooperative the other program is but it's definitely worth checking if you're
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curious.

See also

Appendix A: Unusual Task Specific Features  for a few functions that are.. task specific.

5.9 Item Wording/File

QuickInfo

Identifies the question wording for the item being presented, or if the item is a file
(such as an image, sound, movie, executable, html or Word document) then the file
name goes here.

Value – as Question Wording

If the item is one of the following question types, then this field will provide the question
wording for the item.

Instructions

Fill-in-the-blank

Scale Response

Multiple Response

Thought-listing

Recall Listing

Thought-Rating

Hints – as Question Wording

Click Details for a more flexible editing space.

A very simple solution for more elaborate or formatted instructions is to simply insert them in
a html, word or word perfect document and present that as its own item.

Advanced Hints – as Question Wording

If you want more formatting control over question wording you can insert HTML anywhere on
any question item by specifying an HTML file or URL in the BackGround field for the item. This
way you can create whatever you like and present it in place of (or in addition to) the usual
instruction text. Note that you must specify the area in the which the HTML should appear or
it may hide other parts of the question item. See BackGround  for details on how to do this.

You can insert the value of a subject's prior response to any fill-in-the blank or scale response
item by typing the appropriate variable name surrounded by < > within any question wording
text. For example, if you had previously asked subjects about their race using a fill-in-the-
blank question or a scale response and you had called this variable race, then you could insert
the subjects response in a subsequent question wording like this: What percentage of your
friends are <race>? For scale responses, the text label of the selected response is used.

Apply parameters to question wording

You can now add parameters specific to the question wording on any item. You can add top, l
eft, width, and height parameters in the question wording itself to define its location and
boundaries. To do so, use the key word "param" at the end of your question wording followed
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by your parameters in parentheses. E.g.,

Please answer the following questions. When you're done, feel proud you did a good thing.
param(t200,l100,w200,h100)

You can also add an "a" parameter to set the alignment of the text. By default it will be left
aligned. For right alignment, add "a1". For center alignment, add "a2". e.g., "The quick brown
fox jumped off the roof. param(a1)" will be right aligned. "The quick brown fox jumped off the
roof. param(a2,t.5)" will center the sentence horizontally on the screen and the top of the
text will be located 50% of the way down the screen. 

Value – as Filename

If the item is one of the following file types, then this field will provide the file name for the
item.

HTML  Any .htm or .html file local or on the web

Image  Any .bmp, .jpg, or .gif image file

Executable  Any .exe program (DOS, Windows 3.1, or Windows 95)

Sound  Any .wav or .mp3 sound file

Movie  Any .avi, .mpg, or .mov video file

Word Doc  Any Microsoft Word .doc file

WordPerfect Any WordPerfect .wpd file

Hints – as Filename

When your are editing in the overview window, double-clicking will allow you to edit any field
or will pull open a file search box if a file is required. If you want to edit a field that requires a
filename but do not want to open a file search dialog, then simply highlight the field and press
enter to edit the field directly.

To be safe, you can always specify the complete file path (e.g., "c:\experiments\myexp
\myimage.bmp"). If you specify a complete path, remember to make sure the path is the
same if you load the experiment onto other computers. For more details, see Specifying File
Paths .

Advanced Hints – as Filename

If the file is located in the same folder as your experiment file, then you can simply enter the
name of the file (e.g., myimage.bmp). If the file is located in a subfolder that is located in the
same folder as your experiment files, then you can enter the name of the subfolder followed
by the name of the file (e.g., images\myimage.bmp). Otherwise, you need to specify the full
path and name of the file you want to present (e.g., c:\mypictures\myimage.bmp).

The advantage of placing the file in the experiment directory (or a subfolder) is that the
experiment folder can then be moved to a different place and you won't have to worry about
checking path names (e.g., c:\..., d:\..., etc.)

Files may also be located on another computer on your local network. MediaLab can display
files located on any computer on your network as long as the drive has been "mapped" on the
system running MediaLab. For example, a hard drive on another computer may be mapped on
your system as "h:\" or "s:\" etc. If so, you can refer to files on that drive just as you would
local files (e.g., "h:\myfiles\myfile.bmp"). Ask your network administrator about "mapping"
the drives of other machines on your network if you're new to mapping. See also Running
Experiments Over a Network  for details on how to run an entire experiment from another
machine.
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5.10 Labels

QuickInfo

For scale responses, multiple responses, thought ratings, and online ratings the
buttons labels determine what is shown on the buttons. The defaults are the
numbers from 1 to 12 indicating what number key or function key can be pressed to
select a response. However, if subjects are using a mouse to click on the buttons,
then you can label them however you like (e.g., A, B, C, -1, -2, -3 etc.) For online
ratings these numbers are typically the numerical labels for the online scale.

Advanced Hints

On scale responses and thought ratings, the default value written to the data file is always the
ordinal value of the response option. For example, if the first option is chosen then a 1 is
written to the data file—even if the button label read A, -5 or 0. For multiple response items,
the default value of a chosen response is always 1, i.e., the option was either chosen or not.
For all of these item types you can specify an alternate value for any given response option.
This simply saves you from having to recode the data after collecting it. To specify an
alternate value, specify it in squiggly brackets after the text label like so:

Note that the value can be text or numeric although numeric is recommended. If you use
text, make sure the Write as Text option is checked for the item.

Input via Serial Port

As an alternative to keyboard input, you can receive input from external devices such as
response boxes via the serial port. To do so you just need to create a file called "comport.txt"
in your experiment folder and copy the following text into it:

comPort, baudRate, parity, dataBit, stopBit
1,19200,n,8,1
input code (1-255), response value (1-12)
1,1
2,2
3,3
4,4
5,5
6,6

You should not modify the first or third line. The second line represents the values of the
variables listed on the first line. You can change any of these as necessary. The remaining
lines tell MediaLab how to map incoming signals to response keys. On each line you can list a
pair where the first value is the signal sent to the serial port (i.e., 1-255) and the second
value is the response it should map on to (i.e., 1 to 12). In the example above, if MediaLab
detects a "1" coming through the serial port, it will react as though the 1 or F1 key had just
been pressed. See also Serial Data 107
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See also

text labels , especially for information regarding the size, format and location of response
options and buttons.

5.11 Name

QuickInfo

Identifies the item name and provides a variable name for the data file.

Values

Any string, up to 7 characters.

Purpose

This field is the variable name. A unique name is required for every item in the questionnaire.
This is the name that will be written to the SPSS and SAS input files. For items that collect
multiple responses, numbers will be appended to the name. Item names also allow for skip
patterns and thought ratings and for the insertion of subjects' responses into later question
wordings . Skip patterns  use the variable names in order to know which items to skip to.
Thought-ratings also use the variable name.

Hints

Most data analysis programs react negatively to a few things that can be avoided here. For
example:

§ Avoid variable names that begin with a number.

§ Avoid using the same variable name for different items.

§ Some other things to know:

§ Reaction times are represented in you data input file by a 't' added to the corresponding
variable names.

§ Questions that gather multiple responses (e.g., a thought listing question named thlist) are
represented by an incremental index appended to the variable name (e.g., thlist_1, thlist_2
, thlist_3, etc.). Consequently, to keep the output variable name to a maximum of 8
characters, keep in mind that 2 to 4 additional characters will be appended to the variable
name (e.g., _4, _12, plus a t prefix for the reaction time variables if they’re being
recorded). If you always limit such variable names to a maximum of four characters you will
always be safe.
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5.12 Omit Conditions

QuickInfo

Omits the particular question in the conditions specified. Response is assigned a
missing value.

Details

Although you may want to administer a given questionnaire in multiple conditions, you may
want to skip certain items in some conditions. To skip the item, simply enter the condition(s)
that are not to receive the item in the omit conditions field.

Example

Subjects watch a video about sexual harassment of women in the workplace by male co-
workers. Afterwards they fill out a female sexual harassment questionnaire. Men are all
assigned to condition 1 and women are assigned to condition 2. The question "Have you ever
been sexually harassed by a male co-worker" is to be omitted for male subjects. Therefore, in
the Omit Conditions field, there will be a (1). The question "Have you ever sexually harassed
a female co-worker" is to be omitted for female subjects, and so (2) is placed in the Omit
Conditions field.

If more than one condition should not get the item, then separate the conditions with
commas, e.g., (1,2,6,cond3).

5.13 Parameters

QuickInfo

This is about as difficult as MediaLab gets. Parameters supply additional information
for the presentation of certain questionnaire items. Most are optional but a few are
required for certain item types. Parameters can be given in any order, must be
separated by commas, and the entire set must be enclosed in a single set of
parentheses. Note that parameters also can be set for background, backsound, and
backvideo files following the same rules except that their parameters are entered
after the filename rather than in the parameters field.

Parameters

$ quickstyle

@ time stamp

c command line arguments

d duration for timed items

h height

k key
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l left position

m mask

n number of thoughts to take

o question wording onset

p number of scale points (1-12)

q target question for thought rating

r range

s spacing

t top position

ttl send ttl signal

w width

x password required to continue

Parameters for Different Item Types – Required parameters are in bold
CAPS

All Items  $quickstyle, @time stamp, ttlsignal, c
ommand, -key 

Custom  none

DirectRT  none

Essay  duration, top, left, width, height, key

Executable command line arguments

Fill-in-the-Blank  duration, top, left, width, height, mask, r
ange, key

HTML   duration

Image File  top, left, width, height, duration

Inquisit Session  none

Instructions  duration, password, onset, top, left

Movie  top, left, width

Multiple Response  Points, top, spacing, onset, range

On-Line Rating   Points

PowerPoint Show none

Ranking  Points, spacing, width

Recall List    Number, duration, onset
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Scale Response Points, top, spacing, onset, width, left

Sound File duration

Thought Listing  Number, duration, onset, width, left

Thought Rating  Question, Points, top, spacing, onset, w
idth, left

Voice Response  duration

Word Document  duration

WordPerfect Doc   duration

WebTracker none

Details

Note: (optional) indicates the parameter is NEVER a required parameter of ANY item type.

$ quickstyle (optional)

To apply custom colour and font settings to a questionnaire item, you can create a QuickStyle
file from the Preferences menu. To apply it to a questionnaire item you can enter the name of
the QuickStyle file precede by a $, e.g., ($mystyle). The style will remain in effect until you
apply different style file on a subsequent item or enter $off as a parameter for a subsequent
item. See QuickStyles  for more detail.

@ time stamp (optional)

By entering @ as a parameter for any item in a questionnaire, you can have MediaLab write a
time stamp at the onset of that item in order to keep track of events in real time. When you
do this, a time stamp will be appended to a file called "timestamps.csv" located in the data
folder. Each time stamp will include the Subject ID, the variable name, the time at which the
item started (e.g., 12:33:22), the milliseconds elapsed from the beginning of the experiment
and the number of milliseconds passed since the last timestamp. The timestamp function can
be used with all item types.

command-line arguments (optional)

For executables that allow for command line arguments, you can specify the arguments you
want to send with the c parameter. Just type in the arguments preceded by a c (e.g., c/
myargument). Follow any arguments with max and the application will be run in a maximized
window (e.g., cmax, or c/myarguments max). 

For other item types, an executable file may be launched at the start of the item by adding a
"c" parameter followed by the file name. E.g., (p7,cmyprog.exe) would cause myprog.exe to
launch at the start of a 7pt scale response. This is especially useful for programs that should
run silently in the background as MediaLab will not attempt to keep the program visually in
the foreground unless it is launched via the regular Executable item type. 

duration for timed items (optional)

The default for many item types (instructions, essays, word documents, fill-in-the-blank,
thought and recall lists, image files) is to click on Continue to proceed. Optionally, you can set
a duration for these items instead. For example, if you wanted an instruction or an image to
be displayed for 30 seconds and then automatically continue, you would specify (d30). An
integer value greater than or equal to 1 is required.

Instruction items also offer a special option you can use to create a minimum exposure time.
On any instruction item, if you use a negative duration value (e.g., d-10) then the ‘Continue’
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button will not appear until that many seconds have passed. You can use this option to ensure
that subjects are exposed to some information for a minimum amount of time, after which
they may proceed when ready. Remember that you can always embed images & html, sound
and video in an instruction item by using backgrounds, backsounds, and backvideos
respectively.

height (optional, see width)

key

Open Ended RTs: By default, response times for fill-in-the-blank and essay questions are
taken at the time the subject continues to the next item. You can optionally get it for the first
key stroke instead by using the parameter (k1).

Disable the Spacebar: HTML pages that require input may have a subject pressing the
spacebar as a part of that input. Since the spacebar is also used in MediaLab to continue with
the next item, this can cause a conflict. If this applicable to your HTML file, you can add a (k-
1) parameter to disable the spacebar as a means to proceed to next item. 

Track Key Presses: When used with an essay item, this parameter allows you to record every
time a given key is pressed over a given time period. Simply add the key parameter to
indicate that you want to track a key press response over the duration of the essay. You need
to tell MediaLab what key you want by giving it a code (e.g., k57 will have MediaLab track
the 9 key). There is a utility included in the Utilities folder called keycodes.exe. It will quickly
tell you the code for any key on the keyboard including function and non-character keys. Just
double click the keycodes.exe program and hit any key to get its code. These codes are NOT
the same as the more extensive set of DirectRT key codes!

Example. You want to track every time the subject hits the 9 key over a 30 second interval.
Run keypress.exe and hit the 9 key. You will see that its code is 57. Using an essay item,
enter the parameters (d30,k57). This means the item will be displayed for 30 seconds and
track every time the user hits the 9 key. Medialab will write the key tracking data to a file
called the same thing as the essay variable name file but with "_keypress.csv" added to it.
You can open the data file in excel. It will indicate the subject and condition IDs and give you
the time in milliseconds from the start of the essay for each time the key was hit. Remember
you can add images, video, html, and sounds to the Essay item in any way you like and you
can resize and relocate the text box--even hiding it altogether if you like.

left position, top position (optional)

These parameters allow you to place an image, text or video exactly where you want it by
specifying the top left corner of its position relative to the top left corner of the MediaLab
window, e.g., (t150,l200). You can also specify the left and top position of the essay, fill-in-
the-blank, and thought listing text boxes as well as the text presented in instruction items..

You can also use the top parameter to specify the location of the first button when using scale
responses, multiple responses and thought ratings (e.g., when you need more room for
question wording).

To determine values appropriate for your display, select "Showing Location Points" under the
main MediaLab Help menu.

Note: As of v2004, you can express location and size parameters as a percentage of the
screen. E.g., (l.3,t.25) would be a point 30 percent across the screen from the left and 25
percent down. To use percentages, simply use a value less than 1 and greater than 0.

mask (optional)

You can use the mask parameter to specify the number of characters allowed in a fill-in-the-
blank item and you can specify whether each is fixed or free. For example, the parameter
(m*****) will provide five blanks. The parameter (m***ck) will offer three blanks followed by
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"ck". Fixing characters in this way allows subjects to offer partial responses such as in a word
completion task.

You can also combine the mask and range parameters. For example, the parameters
(m*********, r100000000-999999999) could be used to prompt the subject for a valid,
nine-digit social security number (see range parameter).

number of scale points (1-12)

For scale responses, multiple responses, thought ratings and on-line ratings you need to
specify the number of scale points you would like MediaLab to display. When you enter this
parameter, MediaLab will then allow you to enter the labels for the number of points you
specify. You can have from 1 to 12 points. For example, to specify a 5-point scale you would
use (p5). Note that when MediaLab runs your experiment, the number keys (1-9) will work
only for a scale of up to 9 points. However, MediaLab will also take input from the function
keys (F1 to F12) so that you can conveniently collect data from a 12 point scale and still
assess reaction time. This does not apply to On-line ratings since input is taken through the
arrow keys or joystick.

onset of question wording

For items that take the onset parameter, you can delay the question wording for a specified
number of milliseconds. For example, a 7pt scale response with the parameters (p7,o750) will
reveal the options immediately, but the question wording will not appear for 750ms.

maximum number of thoughts or recall items to take

For thought listings and recall lists, you need to specify the number of separate responses you
would like to measure. For example, if in a thought listing you wanted the subject to list four
thoughts, then you would specify (n4). If you wanted to them to list up to 4, you can set a
time limit using the duration parameter below. Note also that the escape key will end the
thought listing question. You can optionally inform subjects of this so that they can continue
whenever they are done listing their thoughts.

password (x) (optional)

Sometimes you may want the subjects to wait for you to allow them to continue to the next
phase of the experiment. You may also want to prevent the subject from seeing the MediaLab
screen when the experiment is finished. To do this, insert an instruction item and use the x
parameter followed by the password you want to use. For example, if you wanted to use the
password ‘monkey’, then enter (xmonkey) as a parameter value for the instruction item.
Presumably, the experimenter will have to enter this password or tell subjects what it is at the
appropriate time. The characters will be masked (e.g., ******), so that subjects will not see
the password as it is entered. Pressing <Enter> after entering the correct password will cause
MediaLab to continue.

range (optional)

You can now limit a fill-in-the-blank response to a numerical range by using the range
parameter. For example, to accept only a valid age, you might use (r16-125) which would
require a response between 16 and 125. The user will be prompted to enter a number within
that range if they fail to do so. You can optionally combine this with the mask parameter to
provide the appropriate number of spaces for the number (see mask parameter). You can also
add a range parameter to multiple response items to specify a minimum and/or maximum
number of responses to take. For example, (p5,r1-3) would require that the subject choose at
least 1 and no more than 3 of the 5 options.

spacing (optional)

For items that use response buttons (i.e., scale responses, multiple responses and thought
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ratings) you can use the spacing parameter to create more space for options with lots of text
or if you’re using and html file for your labels. For example, if you want to "double-space"
your response options, use the parameter (s2), or (s3) to triple space, or (s1.5) to add a half
space and so on. You can enter any value from 1 to 5 and decimals are ok. This will produce
evenly spaced response options with as many extra lines per item as you need. Importantly
you can do this on an item by item basis--the default of course is single space if you don't
specify the space parameter.

For fill-in-the-blank items, you can use the Space parameter to tell MediaLab how many lines
of text you want to allow. For example, a parameter of (s3) will provide three lines of text
instead of one (the default). Note that if you specify more than 1 line, the Enter key will not
send the subject to the next item but rather to the next line in the text box. The Escape key
may be used as an alternative to the Enter key in such cases.

target question for thought rating (q)

MediaLab allows you to have subjects rate their own open-ended responses from thought or
recall lists on any dimension you like. The thought rating works much like a scale response
but feeds back to subjects their responses from an earlier thought or recall list question. To
do this, you need to specify the variable name you gave to the thought or recall list from
which MediaLab is to supply the responses. For example, say subjects listed their thoughts
earlier in a variable you named ‘tlist.’ To have subjects later rate these thoughts using a
thought rating item (for example how positive or negative each thought was), you would
specify the parameter (qtlist) in your though rating item. Note that for thought ratings, you
must also specify the number of scale points parameter (above).

top (optional, see left)

ttl signal (optional)

To communicate with external computers or hardware you can send out a signal from
MediaLab at the onset of any item. The signal can be a byte value (any integer from 1-255).
You can send the signal to any port address you like. Make sure you use the decimal value of
the port—not the hex value. For example, the port address of the parallel port on most
systems is 888 (or 378 in Hex). Finally, you can send the signal for any duration you like
before it resets to 0. Specify these three variables in the parameters field like so:

<value:location:duration>

For example, say you present an image item for 5 seconds and at its onset you want to send
a signal of 255 to port 888 for 10ms. To present it for 5 seconds, you would use parameter
value of (d5). To add the TTL signal at its onset, you would add:

(d5,<255:888:10>)

Note that there is a TTL I/O test utility located here:

C:\MediaLab\Utilities\TTL\IOTest.exe

You can use IOTest.exe to test whether your external hardware can send and/or receive TTL
signals from any given port. See also Serial Data

width, height (optional)

You can specify the width and height of the essay and fill-in-the-blank text boxes using the w
idth and height parameters to allow for additional room for question wording or for
background images/html, e.g., (h150,w400). To determine values appropriate for your
display, select "Showing Location Points" under the main MediaLab Help menu.

You can also use the height and width parameters to specify the display size of images. Note
that if you size an image using the height and width parameters you need to also specify the
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top and left parameters otherwise it will appear in the top left corner by default.

By default, videos appear in their origional size. However, you can set the exact size of the
video using the width parameter. The height will automatically be set in proportion to the
width you specify. For example, if you specify (w200) for a video that is normally 320x240 it
will appear as 200x150. You can also use the following shortcuts rather than specifying an
exact width (e.g., w-1, w2, etc.)

§ none or w0 = Default Size

§ w-1 = Full Screen

§ w-2 = Half Screen

§ w-3 = One Fourth Screen

§ w-4 = One Sixteenth Screen

§ w1 = Double Size

§ w2 = Half Size

§ w10 and higher = specified width & proportional height

Note: As of v2004, you can express location and size parameters for ANY item type as a
percentage of the screen. E.g., (w.3,h.25) would be a rectangle 30 percent of the screen’s
width and 25 percent of its height. To use percentages, simply use a value less than 1 and
greater than 0.

Examples

Scale Response. To set the number of response options for a scale response to 5: (p5)

Image. To set the top left corner of an image to the center of a 640x480 resolution screen:
(l320,t240) or (l.5,t.5)

Instructions. To require that password be entered before the subject can continue (e.g., at
the end of the experiment, between phases of the experiment), specify a password preceded
by an x, e.g., (xmonkey).

Movie. To play a video file at full screen: (w-1)

Thought listing. To have subjects list up to 8 thoughts, or until 120 seconds have passed,
which ever comes first: (n8,d120).

Background. For backgrounds, backsounds and backvideos, the parameters are always
entered in parentheses after the filename and are always optional. E.g., For a background
image to be displayed with the top left corner located at the top left corner of the MediaLab
window, specify the background file as: myimage.bmp (t1,l1)

5.14 Position

QuickInfo

Identifies the order in which items are presented in the questionnaire.

Values

Any number. Decimal values are allowed.
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Purpose

This field determines the order of the items in the questionnaire. MediaLab will automatically
sort the items in the questionnaire by these values when you close the file. You can also
manually sort the items at any time using the sort  button.

Hints

To add a new item between two existing items (e.g., 2 and 3), assign it a position value
between the values of the two existing items (e.g., 2.5) and then click the Sort button. After
sorting, you can automatically renumber all of your items as sequential integers by clicking
the Renumber  button.

5.15 Randomize Within Groups

QuickInfo

MediaLab will randomly order and present all items sharing the same RWG value.

Value

Any positive integer value

Purpose

You may wish to randomly order and present certain items in your questionnaire. To do this,
assign the same RWG value to all the items you want to have randomized with each other.
For example, if you have five items you want randomized, assign them each a 1. The five
items will be randomly presented in the five positions they occupy in the questionnaire. All
other files will be presented in their assigned positions as long as their RWG value is either 0
or none. You can independently randomize another group of items by assigning them all a 2,
another group with 3s and so forth.

Example

In your questionnaire, you want to present 1) an instruction screen, 2) five scale response
items randomly ordered, 3) three fill-in-the-blank items randomly ordered, and 4) a final
Word document. Assign an RWG value of 0 or none to the instruction screen and Word
document to keep them where they are, a 1 to the five scale response items, and 2 to the
three fill-in-the-blank items. That's it. To randomize the order that groups of items are
presented (e.g., whether the scale items or the fill-in-the-blank items are presented first),see 
Randomize Between Groups  .

Note

For ease of analysis, variables will be written to the data file in the order the occur in the
questionnaire, not in the randomized order in which they are presented.
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5.16 Randomize Between Groups

QuickInfo

All items sharing the same RBG value define a group to be kept together. If multiple
groups are defined, then MediaLab will present them in a random order.

Value

Any positive integer value

Purpose

You may wish to randomly order and present entire groups of items in your questionnaire (e.
g., randomizing whether demographic or personality questions come first in a questionnaire) .
To do this, assign the same RBG value to all of the items you want to keep together. For
example, if you have five sets of ten items, and you want to randomize the order in which
these 5 groups of items are presented, then assign each group a different number and make
sure all the items within each group share the same number for that group. The items within
each group will all stay together, but the groups themselves will be randomly ordered. Items
assigned a 0 or none will not move. Note that all items within a group must be sequential in
the questionnaire.

Example

In your questionnaire, you want to present 1) an instruction screen, 2) five scale response
items, 3) three fill-in-the-blank items, and 4) a final Word document. Whether the scale
responses come first or the fill-in-the-blanks come first is to be random. Assign an RBG value
of 0 or none to the instruction screen and Word document to keep them where they are, a 1
to each of the five scale response items, and a 2 to each of the five fill-in-the-blank items.
That’s it. To randomize the order of the items within each group, see Randomize Within
Groups  .

Note

For ease of analysis, variables will be written to the data file in the order the occur in the
questionnaire, not in the randomized order in which they are presented.

5.17 Skip To

QuickInfo

The Skip to field allows the Editor to create simple or advanced skip patterns in their
questionnaire.

Details

Conditional Skipping based on Scale Responses

After a scale response, MediaLab checks it for it corresponding SkipTo value. If the value is
none, it proceeds to the next question. If it has a value, it assumes that value is a variable
name and skips each subsequent question until it finds the one with the variable name that
matches the skip to value it's looking for. Skipped items will be assigned missing values in the
data set.
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Unconditional Skipping

In some cases you may want to skip over items unconditionally. Unlike conditional skipping,
you can do this with any item type. For unconditional skipping from a scale response simply
place the same variable name in each SkipTo field. For all other item types, simply enter the
variable name you wish to skip to in the single SkipTo field.

Unconditional skipping is especially useful for rejoining subjects who have been conditionally
skipped to various points in the questionnaire so that they end up at a common place. When
they are done their special sections, they can be joined up to the same question by putting an
unconditional skip item at the end of each of their custom sections. In each case they are all
skipped to the same item and continue on with the same set of items.

Advanced Hint

Combining the skip function with RWG (Randomize-Within Groups) you can achieve extra
randomization functionality. For example, to randomly present 5 of 10 items give all 10 items
the same RWG value (e.g., 1). This will randomize their order. Then, embed a blank
instruction item with a delay of 1 second after the fifth item and give it a skip value to go the
item following the tenth randomized item. This will result in the five of the ten items being
presented (which were randomly ordered) after which MediaLab will automatically skip the
remaining 5 items and proceed with the rest of the questionnaire.

5.18 Text Labels

QuickInfo

Text labels provide the response alternatives (e.g., strongly agree, female, >10,000,
and so forth, very positive) for scale response and thought rating items. If you
specify none, for a given text label, then that label will appear blank. This can be
used, for example, to create a scale anchored only at the ends.

Hints

You can also now include <specify> in the text label of any response option. This will not be
displayed to the subject but will cause MediaLab to prompt subjects to enter a text response.
This is handy in cases where you want to provide an alternative such as "other" e.g. If you
wanted the seventh option to be "other" and you wanted subjects to specify what "other"
means, then enter other <specify> for the text label. The actual text response will be written
to the data file.

See also Editing Tips and Tricks  for details on how to avoid repeatedly typing scale
responses when many items use the same scale. When an item is copied and pasted in the
overview editor using the record selector at the far left (selects the whole item), all details are
copied as well (i.e., including response options if the item is a scale response).

Advanced Hints

If you want to specify a specific location for a button you can add top and left parameters to
the text label. For example, if you want to relocate a button with a text label of "skip this
question" then you could modify it like this: "skip this question (t.7,l.7)" That would make the
button appear 70% of the way across and 70% of the way down the screen.

If you want to adjust the size of the button you can add height and width parameters--again
to the text label. In the example above, if we wanted to resize the button as well as relocating
it, we could modify it like this: "skip this question (t.7,l.7,w.2)". This would produce the same
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result as above except the label would be 20% of the screen width.

Finally, if you want to place the text label within the button itself, then simply put the text
label in the button label field and leave the parameters in the text label field, like this:

Using HTML for Labels

If you want to create custom formatted or graphic labels for your scale response options, you
can enter an HTML file or URL in place of the standard text label. This can be used to present
formatted text or images beside each button. 

Here is an example.  Paste this code into a text file and save it as "label1.htm" in your
experiment folder. You can preview the result by opening the file in Internet Explorer.

<body style="font: 12pt arial; color: navy; background: #ccccff; margin: 0px">
<i>Strongly</i> Agree 
</body>

Enter "label1.htm" for your button label and this is how it will appear:

See also

labels , especially for information regarding valid input options and recoding response data

5.19 Write to Data File

QuickInfo

By checking this field, data will be written to the data file. When the value is unchecked,
MediaLab will not write a value for this variable to the data file and will not include the
variable name in the data input file. See data  for more details.

For item types that do not gather input data, the response "ok" is written to the data file to
confirm that the item was presented (e.g., as opposed to being skipped). If this type of
information is of no interest, simply uncheck the Write to Data File field. You may also wish
not to write data from practice trials and so forth.

5.20 Write Data as Text

QuickInfo

When this field is checked, MediaLab will write the data to the data file with quotes
surrounding it. It will also indicate in the SPSS input file that the variable is text. Missing
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values will also be treated as text. Typically, this option is checked for all item types except
for scale response items. See data for more details.

When this field is not checked, MediaLab will write the data to the data file with no quotes
surrounding it. It will also indicate in the SPSS input file that the variable is numeric. Missing
values will also be treated as numeric. Typically, this option is only checked for data gathered
for scale responses, multiple responses, and occasionally for fill-in-the-blank items (i.e., when
numerical responses are expected). See data for more details.

5.21 Write Reaction Time

QuickInfo

By checking this field, the response time for the item will be written to the main data file. In
the data input file which MediaLab creates, a "t" will be appended to the variable name in
order to create a new variable name for the response time. You can leave this field unchecked
if you have no interest in assessing the response time for a given item. See data  for more
details.
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6 Data

Viewing Data

By default, data files are written to a Data subfolder located in the same folder as your
experiment (.exp) file. For example, if your experiment were c:\experiments\test\test.exp
then your data would be saved to c:\experiments\test\data\*.   If this data subfolder does not
exist when you run a session, MediaLab will create it. The main data file will be given the
same name as the experiment file, but with different file extensions to indicate the different
formats (e.g., .txt for the SPSS text-formatted data, .sav for the native SPSS data file and .
csv for the comma-delimited text files). Data from open-ended essay as well as on-line
response questions will also be located in the data subfolder.

You can view these files by browsing through "My Computer" on your desktop to the
appropriate data folder. You can also select View Data from the Data menu in MediaLab--this
will allow you to view any data file (.txt, .csv, .sav) you select.  Note that MediaLab will use
the default program your computer uses to view these file types.

Alternative Data Structures

How does MediaLab write the data file given that different subjects can get different
dependent measures? Good question! This was a real challenge, because we wanted to be
able to produce a single data file that could be a constant for all subjects no matter what
condition they were in. As you may know, data are collected during the administration of
questionnaire files (in which anything can be embedded). Subjects can then receive different
questionnaires in different conditions, or the same questionnaires but in different orders.
Before starting an experimental session, MediaLab goes through the whole experiment file
and looks for all the questionnaires you have in all your conditions. When MediaLab writes the
data file, it writes data for ALL the questionnaires in the experiment, whether or not the
subject received them. If a subject did not receive certain questions or questionnaires then
missing values are written. When the subject has finished, MediaLab writes TWO sets of data
files that contain the same information but are structured differently depending on your
needs. These two sets are called ByQuestionnaire and ByVariablename and can be found in
the Data subfolder of your experiment. Here is the difference between the folders:

ByQuestionnaire

The ByQuestionnaire data folder organizes your data by questionnaire (hence the name).
Before writing the data, MediaLab alphabetically orders all of the questionnaires in the
experiment. MediaLab then writes all of the data for each variable in the first questionnaire,
the second questionnaire and so forth. If a subject did not receive a particular questionnaire
in their condition, then missing values are written. This results in a constant data format no
matter which questionnaires a subject received and the order in which they were
administered.

ByVariablename

In contrast, the ByVariablename data folder organizes your data by variable names. Before
writing the data, MediaLab goes through all of the questionnaires in your experiment and
alphabetically orders all of the variable names. It then proceeds to write the data for all of the
variables in this order—regardless of the questionnaire in which they occurred. This is an
extremely easy way to analyze data from most experiments. It is also especially useful when
you want to include the same variable in different questionnaires for different experimental
conditions. Since the ByVariablename data files don't care about which questionnaire asks the
questions, data for items with identical variable names will all be written to the same column
even if they are asked in different questionnaires. Remember that the variables will be in
alphabetical order so q10 would end up following q9. If you are using a naming system like



Data 73

© 1995-2006 Empirisoft Corporation

that, you might want to use q09 instead.

CSV vs TXT vs SAV Files

You will notice that MediaLab writes a .txt file and a .csv file to each folder. The .txt file is
intended to be read into SPSS which has no practical limit on cases or variables. The
accompanying .sps syntax file that is generated will read this .txt file. The .csv file is intended
to be read in by pretty much any spread sheet application such as Excel. Many people prefer
to use Excel method because it's simpler, but note that Excel is limited to reading in the first
255 variables from your .csv file unless you are using Excel 2007 or later. 

Notice that there is also an .sav file located in the ByVariablename folder. This is a native
SPSS data file that can be opened directly in SPSS. You need to be careful with the .sav files
because they are very sensitive to changes in the structure of your experiment. If you make
changes to your study, it's usually best to delete (or move) the old .sav file and allow
MediaLab to generate a fresh one for the revised experiment. Note that SPSS only allows
variable names of up to 8 characters. If you have any names longer than this (e.g., with
suffixes added by MediaLab) then they will be renamed VAR0001, VAR0002, etc. In order to
find out which variables had to be renamed, you can double click on them in SPSS. MediaLab
saves the origional variable name as the variable label.

Advanced Hint

Some people strongly prefer using the .csv data format but get stuck when they have more
than 255 variables because they do not have Excel v2007 or later. If you try opening your .
csv file in Excel and get the "file not loaded completely" message, you can deal with  this by
importing the file directly into SPSS. To do so, first rename the file from .csv to .txt.  Then, in
SPSS, you can select 

File > New > Data

File > Open

Files of type > Tab-delimited (*.dat,*.txt)

File name  <select your file>

Predefined format? No

Delimited? Yes

Variable names at top? Yes

First case = Line 2

Each line represents a case? Yes

All of the cases? Yes

Delimiter? Comma (uncheck all others)

Finish

If you have any trouble reading in the data, you can look at the data directly in any text
editor. If the file is especially large and difficult to read in its raw form, try a powerful free
text editor like PSPad from www.pspad.com.  

See also

Data FAQ 74
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6.1 Data FAQ

§ Merging Data

§ Using SPSS to read your data

§ Using Excel or other spreadsheet to read your data

§ Getting Data into SAS

§ Viewing Data

§ Determining presentation order of random items and files

§ Determining when events happened in real time

§ Location of essay data

§ Changing the values written to the data file

§ Changing the value used for missing data

§ The Clear Data button and how to disable it

§ How to create a vertical format data file

§ Using Long variable names

§ How to save data from a custom item made with HTML

Is there an easy way to merge multiple MediaLab data files?

Each subject's data are appended to the same constant data file for ease of analysis, so you
won't have to merge any files that are collected on the same computer. You will however
have to merge files collected on different computers. MediaLab offers a utility called FileMerge
(located in the utilities folder) to do this rather painlessly. Essentially all you have to do is
drag the files you want to merge into the FileMerge window and select "Merge Files" from the
File menu. If you like, you can also save the list of files to merge them again later. A quick
tutorial on FileMerge is available by clicking on the FileMerge Help menu. You can also start
FileMerge by selecting Data > Merge Data Files from the main MediaLab menu.

How do I get SPSS to read the .txt data?

The easiest way to access your data in SPSS is to open the .sav data file located in the 
byVariablename data folder (see details above ). However, if for any reason you want to
import the raw text data files using SPSS syntax, here's how. If your experiment is called
exper1, then the text file "exper1.txt" will have all your data in format that SPSS can read.
The text file "exper1.sps" will be the input list for SPSS to read. Just open "exper1.sps" in
SPSS and it will read the exper1.txt" file. It will automatically assign variable formats and
variable names. You can start analyzing immediately. At the top of the .sps input file are a
number of things to check for to make sure you don't get any errors (variable names over 8
characters and that sort of thing). Once the data has been read into SPSS, you can save it as
a .sav file, analyze it immediately or export it into almost any other database format.

How do I get Excel to read the data?

If your experiment were called "exper1" then also written to the data folder will be a file
called "exper1.csv". This file will have all your data in a format that Excel can read. Just open
this file with Excel, and it will automatically read in the data, variable formats, and variable
names. You can then save the file as an .xls file readable by almost any stats package. Be
careful though, Excel can only read 255 variables. If you have more variables than that
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(including response times), then you may want to have SPSS read in your file.

How do I get SAS and other packages to read the data?

Most stats package will read the .csv file (this is the comma-delimited file in the data folder of
your experiment directory. If not, have Excel read the .csv file and then have your stats
package read the Excel file. Some will require you to save the Excel file in an earlier version
(e.g., as an Excel 4.0 worksheet).

How do I determine the order in which random items were presented?

There is routine that keeps track of the actual presentation order of everything (e.g., of files
and questionnaire items that are presented randomly). 

At the end of the experiment you can find a log file called question_order.csv in the
ByQuestionnaire data folder. The first row is the order of files (i.e., from the .exp file) and the
remaining rows are the question orders for each questionnaire in the order they actually
occurred. there is also a time stamp written to verify the time at which each questionnaire
was started.

How can I tell exactly when an item was presented—i.e., in real time?

By entering @ in the parameter field for any item in a questionnaire, you can have MediaLab
write a timestamp at the onset of the item. When you do this, a timestamp will be appended
to a file called timestamps.csv in the data folder. It will include the subject id, the variable
name, the time at which the item *started* (e.g., 12:23:22), the milliseconds elapsed from
the beginning of the experiment and the milliseconds passed since the last timestamp.

Where is my essay data?

Because large quantities of text do not play well with most data files, the responses of
subjects to essay items will be written to their own separate data files located in the main
data folder. The file will be named after the variable name you use for the essay. For
example, if you have an essay item called ess1 then look for your essay data in a file called
"ess1.txt" in the main data folder. The responses of all subject to this question will be
appended there along with their subject and condition IDs.

Can I change the values written to the data file?

On scale responses and thought ratings, the default value written to the data file is always the
ordinal value of the response option. For example, if the first option is chosen then a 1 is
written to the data file—even if the button label read A, -5 or 0. For multiple response items,
the default value of a chosen response is always 1, i.e., the option was either chosen or not.
For all of these item types you can specify an alternate value for any given response option.
This simply saves you from having to recode the data after collecting it. To specify an
alternate value, specify it in squiggly brackets after the text label like so:

Note that the value can be text or numeric although numeric is recommended. If you use
text, make sure the Write as Text option is checked for the item.
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Can I change the value used for missing data?

By default, 99 is used as the value for missing data. Because most item types are either open
ended or limited to a numeric value of 12, 99 is usually safe. However, if you suspect 99
might be a dangerous value for your particular study you can choose an alternate value.
Simply create a text (.txt) file in your experiment folder and name it "missing.txt" and on the
first line of that file, enter the alternate value. It must be numeric.

What is the Clear Data button for and can I disable it?

When you make changes to your experiment, you often change the structure of your data.
This can cause confusion in your data because one subject's data are always appended to the
last. Consequently, it is always a good idea to clear your data folder after making changes to
your study. If the existing data are important, then back them up and merge them later with
the new data. If they are not important (e.g., they are just test files) then you can click the 
Clear Data button when entering the subject and condition IDs. This will delete everything in
your data folder resulting in a clean start. Note that some people get very nervous about
having this button so accessible. If that's you, there is a way to disable it—on the Preferences
menu, simply click Disable Clear Data. Note that as of v2006, MediaLab will attempt to send
cleared data to the Windows Recycle Bin if the experiment is stored locally (i.e., as opposed
to on a network drive).  

How do I create a vertical format data file?

Occasionally, you may want to access your MediaLab data in a vertical format--i.e., one
variable per row--rather than the usual horizontal format (all data for each subject located in
a single row). Located in the folder C:\MediaLab\Utilities\Vertical Data is a file called vertical.
mdb. This file is a blank Access database. This file can be copied into the "\data
\byvariablename" subfolder of any experiment you like. If MediaLab finds this file after a
session is complete, it will output all of the data into three columns (subject, varname, value)
of the "vertical" table. MediaLab will always append data to whatever data already exist in the
file and this function will be in addition to all of the usual data file formats. To maximize
compatibility, this file is in Access 97 format--consequently it is readable by all versions of
Access. A simple test of this function would be to copy the vertical.mdb file into the "c:
\medialab\sample1\data\byvariablename" folder and run that sample--you should find the
results stored in that file after you run the session. This is also a handy way to
programmatically access data immediately after a session for use in other programs.  

How to save data from a custom item made with HTML

See Custom Items

Can I use Long Variable Names?

As of MediaLab v2006.1 the limit for variable names was increased from 7 to 12 characters.
As of v2006.2, this was increased to 60 characters. Keep in mind though that some statistical
packages and spreadsheet applications may still have difficulty working with longer variable
names. Be sure to view and analyze some practice data before going too crazy with this
feature! 

See Also

Data

90

72



Samples 77

© 1995-2006 Empirisoft Corporation

7 Samples

Tutorial and Additional Samples

A good way to get the feeling of how MediaLab works is to run a couple sample experiments
and then look to see how they were put together. If you are new to MediaLab you can get the
gist of things by running through the quick on-line tutorial. From the main menu in MediaLab,
select Help > On-Line Tutorial. The text from the six steps of the tutorial are also contained in
this section (see Sample 1 ) in case you would rather work from a hard copy (if you are
reading this online, you can always right click any topic and select Print).

After that, you can take a look at any of the additional sample experiments that illustrate the
basic features of MediaLab. They are contained in the C:\MediaLab\Samples folder. With the
exception of the first basic sample, all the samples are zipped and will need to be unzipped in
order to use them. If you are using Windows XP or later, you can do this by right clicking on
the zip file and selecting Extract All.

Other Sources for Samples

www.empirisoft.com/support - see MediaLab: Shared Experiments

This new area is provided for you to post your MediaLab experiments, questionnaires
and other MediaLab related files for others to play with. Feel free to post away! Also,
feel free to comment on any posts if you happen to try them--sort of an informal peer
review process. We may edit posts when we deem it necessary. Please zip your files
and folders whenever possible! Note that you will need to register to download files, but
registering is quick, easy and free. 

www.psych.uiuc.edu/~roese/mlhouse.htm - the MediaLab Warehouse Website

The MediaLab Warehouse is a shared software project by which researchers can
exchange operationalizations of particular tasks created for use with MediaLab, thereby
facilitating research by reducing duplication in programming effort. 

MediaLab is a software package for use in psychological experiments. The software was
created by Blair Jarvis and his company, Empirisoft. The chief advantages of MediaLab
are its ease of implementation (no formal programming required) and its flexibility with
regard to multimedia presentation (image, video, sound). An additional advantage of
MediaLab, now becoming increasingly apparent, is its modularity. In other words,
particular components of an experiment, from the core manipulations to distractor
tasks, from cognitive load manipulations to self-esteem scales, from cued recalls to
thought-listings, may be created independently and saved as separate files. Such files
may then be plugged into separate experiments.

Once a single computer file specifying a discrete procedure is created, one may reuse
it, or better yet: SHARE IT. Why recreate the wheel each time you run a
computer-based experiment? If someone else has created a perfectly good cognitive
load manipulation, for example, why not use theirs? Of course, to make use of all this
flexibility and functionality, you need to buy MediaLab. MediaLab is a commercial
product and you must pay for it. The modules that plug into it, however, may be shared
in the same noncommercial scientific spirit as all custom-created research materials.

This was the idea behind a database of MediaLab modules created by Neal Roese on an
intranet at Northwestern University in 1999. In Jan 2001, the MediaLab Warehouse
went online as an internet resource directly descended from that earlier intranet
version. This resource was initiated by Neal Roese (University of Illinois) and Cynthia
Pickett (University of Chicago), but in time we hope that the list of contributors will
swell into a truly collective project. This resource remains small, but is growing steadily
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with new contributions from viewers like you! Keep sending them! Eventually, we will
organize the contents into a searchable database.

Email submissions as attachments to either Neal Roese or Cynthia Pickett.

Continue to Samples

7.1 Samples

Sample 1 – Sample1.exp (text from Tutorial on the MediaLab Help menu)

"So I've installed MediaLab. Now what do I do?" Good question. This brief tutorial (about 15
minutes) will walk you through the basics of MediaLab. After you've run through this short
tutorial you will likely be able to design and execute a short experiment of your own. This
on-line tutorial can be run at any time by clicking Help > On-line Tutorial from the main
menu. You might find it helpful to print out this tutorial so you will be unobstructed as you go
through the steps of running and editing the sample experiment. To print this tutorial click on 
Print Me Instead! below. If you choose to use this window, it will stay on top while you
perform any actions. You can move it or resize it at any time if it gets in the way of your
view. 

This purpose of this short tutorial is to give you the gist of how MediaLab works. After running
through it, you may wish to check out the additional sample experiments and questionnaires
located in the Samples folder (usually C:\MediaLab\Samples). For more detailed help, select
Help > MediaLab Help from the main menu or press F1 at any time. You will also find a
printable PDF manual located in the C:\MediaLab\Help folder called MediaLabManual.pdf. 

Step 1: Run the Sample Experiment

The first sample experiment is as simple as MediaLab gets—a basic questionnaire, in this case
measuring self-esteem. To run Sample1.exp: 

1.First, if MediaLab is not running full-screen, then make it so by clicking the maximize button
in the top-right corner of the main MediaLab window (it's the one in the middle).

2.Go to the Run command in MediaLab and choose Select and Run Experiment. 

3.Find the Samples folder located in the C:\MediaLab directory.

4.Double-click on the Sample1 folder, and then double-click on Sample1.exp. Note that
experiment files are indicated by a green "building block" icon and that questionnaires are
indicated by a "paper and quill" icon. 

5.Enter a Subject ID (e.g., 5), and press Enter

6.Enter a 1 for the experimental Condition, and press Enter

7.Follow the instructions as if you were a participant.

Step 2: See How it Was Done

From the main menu in MediaLab select Experiment Editor. 

When the Experiment Editor opens, select Open from the File Menu and open Sample1.exp. 

You'll see that there are 2 conditions. Everybody in condition 1 gets only one file—
selfesteem.que. 

However, in condition 2 you see that these subjects will also get a PowerPoint Show (.pps) file
before they get the self-esteem questionnaire. In MediaLab experiments, you can define as
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many conditions as you like, with each having as many files as you like. These files can be the
same ones in different orders, or they can be different files altogether.

That's all there is to this experiment. 

Close the experiment file by clicking OK. Then close the Experiment Editor. This will return
you to the main MediaLab window. Now run the experiment, enter a subject ID, but ask for
Condition 2 this time. After that...

Step 3: See How the Questionnaire Was Made

From the main menu bar in MediaLab select Experiment Editor. 

When the Experiment Editor opens, select Open from the File Menu and open selfesteem.que. 

Here you'll see the items contained in the questionnaire. Here you can see the basic
information about each item—the ordinal position, the variable name and the question
wording or filename. Double-click on any position number to see the item details. Note how 
Scale Responses require the p parameter telling MediaLab how many scale points the
question requires. Try using the context sensitive help here. Place the cursor on any field
(e.g., the position field) and pressing F1. Close the Details window by clicking on the big
checkmark in the lower right corner, and then click OK to close the questionnaire and then
close the Experiment Editor.

Step 4: Look at the Data

Your data will be located in a data folder contained in the same directory as your experiment.
From the Data menu in MediaLab, select Launch Explorer. Find the Sample1 folder and open
the Data folder located inside. In here, you will see two folders. Usually, you will use the
byvariablename data folder. Take a look inside and you'll see a number of files. MediaLab has
generated all of these files for you automatically. The first one to look at is sample1.csv. You
can open this with Excel. Try it. (note that all the variables that start with t are response
times).

If you've got SPSS installed, you can open sample1.sav. Or you can open the .sps syntax file,
highlight everything in the file and run it. This input file tells SPSS to read the data file 
sample1.txt (also located in your data folder), and defines all of the variables. After running
this input file in SPSS, you can analyze it right away. Try doing some frequencies or means.

The other file in the main data folder is called comment.txt. You can open this in any text
editor. This file contains the open-ended responses from the essay question called comment
in the self-esteem questionnaire. MediaLab writes the data from essay questions to their own
file since it would get out of hand to write these to a standard data file.

Step 5: Modify and Run the Experiment:

Now let's try to modify the experiment you just ran. With Windows Explorer still open, make a
copy of the selfesteem.que questionnaire file and rename it myquestionnaire.que. Then,
double-click on it to open it in the MediaLab Experiment Editor.

This is where you can have some fun. Try changing the question wordings. Double click on
any position number to see the details for any item. Try this with a Scale Response. See
where it says (p6) in the parameters field? Try changing this to (p9). See how you now get 9
response options for the questions? You can add the additional options in the labels and text
labels fields.

Close the Details window by clicking on the big checkmark in the lower right. Try adding an
item of your own. In the first open position, enter a new position number of 4.5. Enter a
variable name such as MyVar. Double-click on the ItemType field and choose Fill-in-the-blank
from the pull-down menu. Finally, enter your question wording, e.g., "Please tell me what
your favourite food is."

Now click Sort and then Renumber. See how the item is now positioned between the 4th and
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5th items? This happened because you gave the question a position value of 4.5.

Now click Save and OK to close the questionnaire. 

Now we need to add your new questionnaire to the experiment file. From the File menu
select Open and open the Sample1.exp experiment file.

Let's replace the selfesteem questionnaire in Condition 1 with your new questionnaire. Simply
double-click on selfesteem.que in Condition 1, Position 1. When the dialog box opens, select
you new questionnaire. See how it has replaced the old questionnaire?

Let's add another file to Condition 1 in addition to your questionnaire. In the first available
row, enter a value of 1 in the Condition field. Enter a value of 2 in the Position field.
Double-click on the File field and select an image file on your hard drive (and jpg, bmp or gif
file). To see the types of files you can add here, click Files of Type when the dialog box opens.
If you have Internet Explorer 4 or later installed, you could also enter a web address here or a
local HTML file (e.g., www.empirisoft.com). After selecting a file, click Sort, then Save and OK
.

That's it. Close the Editor and return to MediaLab. Choose Select and Run Experiment and run
Sample1, Condition 1 again. Note that if you have made changes that will affect your data
files, you'll want to click the Clear Data button to delete the old data files and start fresh
(after backing them up if there are data you want to save). 

That's the gist of MediaLab. Of course experiments can get much more elaborate than this but
the basic idea is always the same. The experiment file defines the files that will be presented
in each condition. These files can be pretty much anything including MediaLab Questionnaire
files which allow you to ask questions. For more detailed help, be sure to check out the
manual (MediaLabManual.pdf) contained in the MediaLab help folder and to use the OnLine
Help by pressing F1 at any time. More samples are contained in the Samples folder. 

Sample 2 - Scale Responses and an Introduction to Parameters

C:\MediaLab\Samples\Sample2.zip (requires unzipping)

This sample demonstrates what you can do with scale responses. It starts with the
most basic application and ends with a relatively advanced example. You will need
Microsoft's Internet Explorer, Version 4 or later installed to view the HTML files that
are used in this sample. Click Continue or press the spacebar to begin. Press Ctrl+Alt
+Right to exit the sample at any time.

Standard Scale Item

The first scale response you'll see is the standard format which uses just the Point (p)
parameter to indicate the number of scale points (see the Parameters field). This tells
MediaLab how many scale points you want. In this case, it's 6. Click Continue, or press the
spacebar to see the item. When the item appears, you can click Go Back to see this screen
again or enter a response to continue.

Inserting Prior Responses in Question Wording and Skipping

With scale items and fill-in-the-blank items, you can enter subject's responses in later
question wordings. For example, what was the response you just gave to the last question?
Whatever it was, it should show up in the next item. The question wording specifies <rse9>.
That tells MediaLab to insert the subject's response to the item with variable name "rse9" into
the question wording of this item. 

Also notice that we're using "skip to" values here. Skip To values allow you to skip a subject
to any subsequent question by entering the variable name in the "Skip To" field. Below, you
can see the Details for the next three questions: rse10, rse11 and rse12 (you may have to
scroll down). To illustrate, say we want people who disagree with rse10 to answer question
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rse11 and we want those who agree to rse10 to answer question rse12. To do this we enter
"rse12" as the Skip To value of the agree responses in rse10. If the subject agrees to rse10,
they will be skipped to rse12, otherwise they will continue on to question rse11. Scroll down
here to see the details of rse11. See how the subject is unconditionally skipped to rse13? This
ensures that they will not get rse12 which was designed for those agreed to rse10. If that's
confusing try going back and forth using the "GoBack" button trying the different
combinations to see how it works. You'll see that depending on what you answer to rse10,
you will get only rse11 OR rse12. Instead of a single item, you could also have entire blocks
of items designed for a particular response.

Multiple Response Item 

Sometimes you may want a subject to be able to check more than one response. That is when
you can use the multiple response item instead of the scale item. It works exactly like a scale
response except that MediaLab will allow multiple buttons to be "checked". In this example,
try clicking multiple answers. When you're done, click Continue or press the spacebar.
Multiple Response items use all the same parameters as Scale Items. Note that on this item
we turn off the QuickStyle we applied earlier using the ($off) parameter. You should see that
MediaLab reverts to the default colours and fonts.

Inserting HTML in Place of Question Wording and/or Response Labels 

Want more control over formatting? You can create an HTML file and display it in place of the
usual question wording and even the text labels on the response buttons. In the experiment
folder, there is a subfolder called "sp". This folder contains the HTML files and media. In the
Background field, see that we specify that we want MediaLab to display "sp/rse.htm" --an
HTML file in the SP folder. When we do this we have to specify the area for it to cover using
the Top, Left, Width, and Height parameters. We are also going to display html files in place
of the response labels. To do this, we enter the name of the HTML files in place of the usual
Text Labels. To allow for more space to accommodate the larger HTML labels, we have triple
spaced the buttons using the Spacing parameter (s3). We have also specified that the scale
buttons be moved over to the right and upwards using the Left and Top parameters. Finally,
since the HTML files have a white background, we have applied a QuickStyle file (white.mlq)
here that instructs MediaLab to use a white background. This way the HTML files will blend in.

End of Scale Item Sample 

That's it. This sample represent much of what you can do with Scale Items. Of course,
everything you've seen here is optional aside from the use of the Points (p) parameter telling
MediaLab how many scale points you need (e.g., as in the first question, "rse1"). Hopefully, if
you need more options than that, you've seen here how to accomplish what you need. If you
have any questions, feel free to contact us at support@empirisoft.com.

Adding Response Options & Modifying Button Labels 

The next item is pretty much the same except that we've changed the Point parameter to 9,
providing for 9 response options. We've also changed the button labels to include negative
values. Since there are no "negative" keys on the keyboard, you would need to label your
keyboard appropriately (e.g., with 1 or F1 corresponding to -4, 2 or F2 as -3 and so on). Click
Continue, or press the spacebar to see the item. 

Horizontal Response Scale 

The next scale item is the same as the first except we now add the Width (w) parameter. This
tells MediaLab we want a horizontal scale and specifies that it should be 500 units wide. See
"Show Location Points" in the Help menu for the sizing scale that is used with your display.
MediaLab tries its best to use a resolution-independent display. Click Continue, or press the
spacebar to see the item. 
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More Room for Question Wording 

The next item again is the same as the first, except now we add the Top (t) parameter which
tells MediaLab that you want the buttons to start at a specific distance from the top. With this,
you can move the buttons up or down as much as you like. Note that you can use the Top and
Width parameters together to create a horizontal scale at a specified height. Click Continue,
or press the spacebar to see the item. 

Getting Subjects' Attention 

Sometimes after answering many questions, the items can start to "blend in" with one
another. A couple things you can do to minimize this: You can add an Onset (o) parameter
which delays the display of the question wording. In this case we've added (o1000) which
means there will be an approximate 1000ms delay before the question wording appears.
We've also added a QuickStyle ($) parameter. QuickStyle files can be created in the MediaLab
preferences menu. They contain font and colour information (see the help documentation for
more detail). In this case, we apply a style file called "green.mlp" located in the experiment
folder by entering the parameter value of ($green). 

Creating More Room For Response Labels

In this item, we have some very long response labels. To create more space for them, we can
double, triple or even quadruple the spacing of the buttons using the Spacing (s) parameter.
In this case, we've entered (s2) to double space the buttons. Any value (decimals are ok)
between 1 and 4 is acceptable.

Turning off the QuickStyle and Imposing a Time Limit 

When this item occurs, we shut the previous QuickStyle off by entering a QuickStyle
parameter of ($off). An alternative would be to apply a different QuickStyle file. Using the
($off) value returns the colours and fonts to the default settings in your preferences file. We
also add the Duration (d) parameter here to impose a time limit on the question. In this case,
you will have up to 5 seconds to respond. Try letting the time pass and see what happens.

Adding Other Media 

It's easy to add sound, images and video to your questionnaire items using the "Back" fields.
In this case, we add an image in the Background field and a sound file in the Backsound field.
In this case, we have entered parameters for the Background image immediately after the
filename (this is always optional). This will locate the image with a Left value of 300 and a
Top value of 100. 

Adding a "Specify" Response 

In some case you may want to offer an "Other" response. If you add <specify> to any
response label, then MediaLab will prompt subjects to specify their answer if they choose this
button. Try it. When the item appears, select the "Other" response and see what happens. If a
subject specifies an answer like this, then the text response is written to the data file instead
of the button they pressed.

Back to Samples 77
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8 Preferences and Options

QuickInfo

The Preferences menu in the main MediaLab window provides a way to edit and
save default and alternative program options. 

Two types of files can be created and edited here. The first is the MediaLab Preferences File (.
mlp) which contains font and colour combinations as well as a number of general program
options. The second is the MediaLab QuickStyle File (.mlq) which contains ONLY font and
colour information. Normally, you would have just one Preferences file (usually default.mlp
which is loaded automatically) and many QuickStyle files. This is because you can only have
one Preferences file loaded during an experiment, but you can apply multiple QuickStyle files
throughout your experiment by requesting them in your questionnaires or experiment files. If
you do not create or request any QuickStyle files during your experiment, then the default
fonts and colours in your Preferences file will be used.

Preferences

Fonts and Colors

On-the-fly-editing of Word Documents

Hide MediaLab Rats

Disable System Key Sequences

Double Click to Close MediaLab

Use Alternate Data Folder

Use Unique Machine Code

Password to Exit Experiments

Where to Find Supporting Applications

Load Other Preferences File

Disable Clear Data

Mute MediaLab Sounds

Use Enhanced Video

Quick Styles

Character Set & Foreign Fonts

Changing Default Feedback and Message Text

AutoStart files to Automate Subject and Condition IDs

8.1 Preferences and Options

Fonts and Colors

You can change the fonts and colors MediaLab uses during experimental sessions. Select Edit
Preferences > Font & Colors. You can set fonts and colors separately for windows that display
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text provided by you, and for windows that allow subject input.

On-the-fly Editing of Word Documents

If this option is checked, then you can edit Word or WordPerfect documents as you run
through the experiment simply by double clicking on them. You may want to disable this
when you are running actual subjects.

Hide MediaLab Rats

For the politically correct and the phobic--you can choose to have MediaLab hide the rats from
the main window with this option. For the phobic, note the opportunity here to start your
systematic desensitization!

Disable System Key Sequences

Selecting this option will disable any key sequences that would allow participants to explore
your computer or otherwise interfere with your experimental session. The key sequences such
as ALT+TAB, CTRL+ALT+DELETE, and CTRL-ESC will be re-enabled after the session is over.
Caution should be used here such that you have fully tested your experiment before setting
this option. If for any reason, the program locks up while these system keys are disabled, you
would have to turn the computer off and restart it (e.g., since CTRL-ALT-DELETE would not be
an option for closing the program). Note that this function may not work on Windows XP.

Double-Click to close MediaLab

A small convenience that allows you to double click on the blue area of the MediaLab window
in order to close the program.

Use Alternate Data File

Click the button to its right to browse for a folder on your computer or network. MediaLab will
write the data to this folder instead of the experiment folder (default). This is especially useful
if you want ot run your experiment from a CD-ROM.

Also, since you can specify any location for the data using the "alternate data folder," you can
choose to gather all of your data on a central computer on your network. To specify another
computer as the location for your data files you need to "map the drive" on the other
computer as a drive letter on your computer running MediaLab (e.g., as h:\ or s:\ --you may
want to ask your network administrator to help you with this if you are unfamiliar with
mapping drives on other computers). You can then specify the alternate data folder by using
this mapped drive, e.g., "h:\medialabdata"

When MediaLab sees this, it will create a folder within the alternate data folder with the same
name as the experiment file, e.g., "h:\medialabdata\experiment1" and will write the data as it
normally would to this folder.

If you are having multiple computers write data to this same alternate folder, it is
recommended that you use a "Unique Machine Code" (see below) for each computer. This 3-
letter identifier of each computer will be appended to all of its data files. This serves to
identify which data files came from which computer and also helps to prevent conflicts that
may occur from multiple computers attempting to write to the same files at the same time
(since each computer will write to its own unique files). These multiple files can be easily
merged later using the FileMerge utility provided in MediaLab's data menu.

Unique Machine Code

Type any extension here that you want appended to data files produced on the current
computer. This helps to identify the machine on which data was collected. Leave this field
blank if you don't want a code appended to the data file names (default).
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Password to End Option

You can set a default password that will be required at the end of every experiment. This
saves you the trouble of creating a separate password item in your experiment. If you forget
the password, the secret key sequence CTRL+RIGHT ARROW will skip you out of it. No
password will be required if this field is left blank.

Where to Find Supporting Applications

For most users, these fields can be left blank because MediaLab will automatically know where
these applications are. However, if you get an message saying that MediaLab can not find one
of these applications then you can fill in these values and MediaLab will search there. You can
click the "…" button to the right of each field to browse your computer.

Saving the File

Click Save to save your work or click Close to cancel the changes. Click SaveAs to save the
current configuration to a new Preferences file. When clicking SaveAs, you can also then
select "Save as Type" and save the colours and fonts to a new Quick Style file if you like (see
below).

Load Other Preferences File

Allows you to load the preferences saved in another file. The default.mlp preferences file is
always loaded when MediaLab starts. You can edit and save the default preferences under a
new name and then load your new preferences file before you begin running your experiment.
This can be useful if different members of your lab have different preferences for how
MediaLab operates. Remember that if you're only changing colours and fonts, then it's much
easier to just create a new Quick Style file (see below).

Mute MediaLab Sounds

Upon certain events MediaLab will give audible feedback by way of beeps and clicks. To turn
off these sounds check this option.

Use Enhanced Video

MediaLab uses the Windows Media Player for its video playback engine. If you check the Use
Enhanced Video option, MediaLab will use an alternate custom engine that may provide
playback for some formats that can not be handled by WMP (e.g., some QuickTime and Real
video formats). In general, it is recommended to NOT use this option unless you have to. If
you do choose to try this option, it  is best to have the latest versions of QuickTime and/or
Real Player also installed on your system.

Disable Clear Data

Prevents the Clear Data button from being pressed at the start of a session. This is a handy
option if sessions are being started by users who are unfamiliar with the program. See Data
for more detail  regarding the Clear Data function.

QuickStyles: Create and Apply Multiple Style Files

MediaLab automatically loads the default preferences file. If you want load a different
preferences file, you can select "Load Other Preferences File" from the Preferences menu. As
with MediaLab2000, you can create, edit and save as many Preference files as you like.

A new feature though in 2002 is the addition of "quick style" (.mlq) files. Quick style files are
just like Preference files (.mlp) except that they contain ONLY font and colour information.
You can create many quick style files with various foreground and background colour
combinations as well as font options. The benefit of quick style files is that you can instruct
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MediaLab to apply a different quick style file at any time during the experiment or in the
middle of a questionnaire. In the parameter field of any experiment or questionnaire item you
can name a quick style file preceded by a $ which will cause MediaLab to switch to that style.
You are no longer limited to using a single set of colour and font options.

How Quick Styles work

To create a quick style (.mlq) file, select Quick Styles from the Preferences menu. You can
then select a configuration of fonts and colours. Select SaveAs and save the quick style file
with a name (e.g., mystyle1.mlq). You can either save it in the MediaLab Styles folder so that
all experiments can use it, or you can save it to your experiment folder to make it available
only to your current experiment.

Then, in your questionnaire or experiment, enter the name of the style file preceded by a $ in
the parameters field of any item, e.g., ($mystyle1). When MediaLab sees this it will read the
style file and apply it immediately. MediaLab will first look in your experiment folder for the
file (e.g., mystyle1.mlq). If it doesn't find it, it will look in the MediaLab Styles folder. If it
finds it, it will immediately apply that style to your running experiment. You can have as
many quick style files as you like and can apply them however frequently you like. The
currently applied style will remain in effect until you request a different style file, or until
($off) is encountered in the parameter field of another item.

Aside from added flexibility of formatting, this allows you to store color and font information
within your experiment folder so that it's always available. If for example, you send someone
your experiment folder, the formatting will remain the same so long as the quick style files
are included in the folder. This also means you no longer have to worry about loading the
correct Preferences file before each experiment because your experiment takes care of this
for you.

Note that you don't have to use quick style files at all. If you do not apply any quick style files
in your experiment, MediaLab will simply use the colours and fonts specified in the
Preferences file (e.g., default.mlp which is loaded automatically).

Foreign fonts

Improved foreign character support

If you need to display foreign characters in MediaLab there are now a few options that can
help.  In MediaLab, select Preferences and then Edit Preferences to choose the a compatible
font for use when running your experiment (MediaLab supports most double-byte fonts such
as Arial). Also under Preferences, you can select the Character Set option to select a script
that works best with your language and font. Finally, also under Character Set is an option to
right-align the text for question wording and open-ended responses. Finally, in the
Experiment Editor, under Options, you can select an Editor Font and chose a font that works
with the characters you need while editing your experiment. This step should be taken after
setting the font and script preferences in the main MediaLab window.

Note that if you are designing experiments in a language other than English, you can also
modify the messages that MediaLab displays so that they are in your preferred language (see
below). We can also help you with a custom Continue and Go Back button for your language—
let us know if you need this. In fact, there is already a series of Continue and Go Back
graphics in various languages located in the C:\MediaLab\Graphics folder. If you would like to
use them, simply replace C:\MediaLab\Graphics\continue.bmp and C:\MediaLab\Graphics
\goback.bmp with the ones located in the language subfolder of your choice (e.g., Chinese,
German, Greek, Japanese, Spanish).

Modify message text

MediaLab presents various messages during an experiment. You can edit the content of these
messages to suit your specific needs or even translate them into an alternate language. You
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will find two files in the "styles" folder called "messages.txt" and "substitute.txt" which you
can edit in any text editor. Messages.txt contains all of the possible feedback that MediaLab
presents to subjects during an experiment:

How to modify MediaLab messages

Do NOT modify messages.txt! That would be bad. Instead, create and modify a file called
substitute.txt

If you would like to customize or translate messages simply copy the messages you want to
change into substitute.txt. Make sure you copy the entire line including the ID number.
Change only the text within the quotation marks. MediaLab will substitute messages based on
their ID number. The substitute file you make may contain all of the messages in this file or
just a subset that you want to change. You can put the substitute.txt file in the C:\MediaLab
\Styles folder or in an experiment folder of your choice.

For example, you could copy messages 103, 104, and 106 from "messages.txt":

And copy them to "substitute.txt" where you can change them to anything you like:

If you were to do that, then these messages (103,104,106) would be used instead of those
contained in the message.txt file.

Here's how it works:

Every time MediaLab starts an experiment, it accesses the messages it will use from the
main messages.txt. It will then look in the Styles folder for a file called substitute.txt. If it
finds it, it will read your custom/translated messages and substitute them in the experiment.
Note that if you place the substitute.txt file in the Styles folder, then all experiments will use
the substitute messages. If you want to substitute messages in a particular experiment, then
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simply place the substitute.txt file in your experiment folder. Finally, you can place one
substitute.txt file in the Styles folder (which will affect all experiments) and another in your
experiment folder (which will affect only that experiment). If the same message IDs are
contained in both locations, priority is given to those in the experiment folder.

Using an AutoStart File to Automate Subject and Condition IDs

By default, each time you run a MediaLab experiment, you need to enter a subject ID and
condition. You can automate this process by using an AutoStart file. All you have to do is
generate a text list of subject id's and conditions and call it "autostart.txt" and place it in your
experiment folder.  E.g.,

When you run the experiment, medialab checks to see if an autostart.txt file exists in the
same folder. 

If it doesn't then you will be prompted for the subject ID and condition as usual. If it does
exist then it automatically runs the next subject ID and condition on the list. 

MediaLab will mark the subject ID condition with a * so it knows where to start next time.
Following the session, Medialab will ask if you want to run the next session--if you say yes it
automatically gets the next subject ID and condition from the list and runs it. This way you
can run sessions all day on multiple computers and never have to enter a subject ID or
condition. Note that you will probably want to create a unique list of subject ID's and
conditions for each computer to prevent redundancy!

Finally, an alternative way of using the AutoStart feature is to type "select subject" as the first
line in the autostart.txt file. If you do this, then MediaLab will prompt you only for the subject
ID. It will then look up the condition for that subject ID from the list and run it automatically.
This is useful if you want to have a constant autostart.txt file on all of your computers and
don't mind keeping track of which subjects still need to be run. It simply eliminates the need
to keep track of which conditions to assign.
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Advanced Hints for AutoStart

Using a substitute.txt  file, you can have a blank message ("") defined for the end of session
event. If MediaLab sees that you have no message and you are using an autostart file, then it
will proceed automatically with the next session without hassling you--i.e., you will not be
asked if you want the next session run, it will simply start. Doing so requires ctrl-alt-delete
when you finally want to escape. 

Note about ending sessions early:

The autostart.txt file will only be updated if a session is completed. You can end a session in
two ways.  One is to press ctrl-alt-delete and choosing to shutdown the medialab program--
this will shutdown the session, no data will be saved, and the autostart file will remain
unchanged. The other is to press ctrl-alt-right which is the key combination to end a session.
If you end a session in this manner the data will be written including missing values for
questions that were never answered and you will be asked if you would like the autostart file
to be reset as it was before the session. Answering yes to this will prevent MediaLab from
scratching this session off its to-do list.
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9 Custom Items

Note that the following documentation for custom items is current for versions v2006.2 and
later. If you are using an earlier release of v2006, it is recommended that you update your
version (it's free) before trying to create and/or execute custom items.

Overview

MediaLab allows you to create your own custom items using HTML. Using the Custom item
type, you can specify any web browser file (local or internet) in the filename field. If and when
a post event occurs, MediaLab will save any submitted data that you like and then continue on
to the next item in the questionnaire.  In order for a posted variable to be saved with the
regular data files, its variable name simply needs to match that of the Custom item or any
other item in the current experiment. 

HTML Items vs Custom Items

An HTML file (e.g., mydoc.htm) is a document. In the same way that a .doc file is meant to be
viewed in Microsoft Word, an .htm file is meant to be viewed in a web browser like Internet
Explorer, Netscape, or Firefox. An .htm file is also a simple text file which means you can
open and edit it in any text editor such as the Windows Notepad. When you open an .htm file
in a text editor you will see code that you don't see when viewing it in a web browser--these
are all the instructions that tell the web browser what to present and what to do with user
actions. 

Both Custom and HTML items in MediaLab may contain pretty much any HTML code you like.
This means that anything that can be displayed in Internet Explorer, whether it's on the web
or on your local computer, can also be used. This can include pictures, movies, formatted
text, hyperlinks, flash animations, interactive java applets, scripts, and so on. However, there
is a limit to the HTML item type--you can't collect any data with it. You can include questions
but there has never been a way to get MediaLab to save those data in the regular data files.
Contrariwise, the Custom item type allows you to do just that through the use of standard
HTML form code.

Note that a useful introduction to HTML is beyond the scope of this documentation. For a
general introduction see:

www.w3schools.com/html/html_intro.asp
www.w3schools.com/html/html_examples.asp

What is an HTML Form?

Forms are the basic ingredient for asking questions on the Internet. A single question or set of
questions can be asked in any HTML document by surrounding some question code (discussed
shortly) with the <form> tag like this:

<form method="post">
questions and variable names for responses go here

</form> 

The <form method="post"> tag tells the browser to keep track of any data that is collected
within the form and make it available for saving when the user clicks a button to submit their
responses. Although it can get more complicated, this is the gist of how most questions are
asked when you are surfing the internet. 

For more information regarding HTML forms, see:

www.w3schools.com/html/html_forms.asp

http://www.w3schools.com/html/html_intro.asp
http://www.w3schools.com/html/html_examples.asp
http://www.w3schools.com/html/html_forms.asp
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How it Works - MediaLab Intercepts!

If you present a Custom item rather than an HTML item, then MediaLab will monitor the
posting of any form data. If it finds any data being submitted where the variable name 
matches the variable name of any item in any questionnaire in your MediaLab experiment--
then that intercepted value will be written to your standard data files under that name. That's
all there is to it.

Example

What is the mysterious code that goes between the <form> tags? This item below presents a
text box in which subjects can enter a response. When they click Continue, MediaLab will
check to see if any variables in the experiment are called textBox1. If so, the response will be
saved to the data files under that name. We can handle that easily by assigning the variable
name textBox1 to the Custom item itself when we list it in the questionnaire. 

<form method="post">
    What is your answer?
    <input name="textBox1">
    <input type="submit" value="Continue"">
</form>  

How it looks in a browser:

Try It!

To create your first custom item you can copy the code above (everything from <form> to </
form>) into a blank text file (e.g., via Notepad).  Save it somewhere as myTextBox.htm.
Voila! You have just created a custom item! You can view it in Internet Explorer if you like by
double clicking on it.

To use it with MediaLab, open a questionnaire file and add an item--choosing Custom as the
item type, myTextBox.htm as the file name, and textBox1 as the variable name. That's it--try
running the questionnaire and then view your data to see if the posted response was written
to your data file. Remember that if you have made changes that will affect your data files,
you'll want to click the Clear Data button to delete the old data files and start fresh (after
backing them up if there are data you want to save). 

Hint: You can see these samples already prepared in the C:\MediaLab\Samples\Sample 5
Custom Items folder. 

Advanced Hint

MediaLab will not display the standard "Continue" button when a custom item is used.
Instead, it will wait until some data is posted via a submit button. In some cases though you
may not want this to happen automatically. An alternative is to use the password (x)
parameter. In this case the password can be a variable name, e.g., (xvarname). If you do
this, MediaLab will not proceed to the next item unless the password variable is included in
the post. This is especially handy if you want to make a multi-page custom item with multiple
postings.

See Also

Repeating Custom Items
Single Vs. Multiple Variables
Variable Reference
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Samples

9.1 Repeating Custom Items

A powerful and time-saving feature of custom items is the capability to use them over and
over again without having to modify them. If you create a special scale response item with a
slider to use in your 50-item questionnaire, you do not want to make 50 versions of it, each
with different question wording and response options. Well, maybe you do. If so, no need to
read any further. But if you like the idea of 1 file for 50 questions, read on!

Instead of adding the exact question wording to your custom item's HTML code, you can
simply say <ml.wording> and MediaLab will automatically substitute the question wording
from your questionnaire file. This means, each time you use your custom item in a MediaLab
questionnaire, you can enter different question wording the you would for any other normal
item. MediaLab will take it and put it into you HTML file for you!

Likewise, instead of using a specific variable name in the HTML form code, you can simply
specify <ml.varname>. This means you can now use the same custom item file with many
questions in the same questionnaire--because each time, MediaLab will substitute the current
variable name  into the HTML.  

You can also substitute other values such as backgrounds, backsounds, backvideos, fonts and
colours from the current session and so forth without having to change your item. For all the
stuff that MediaLab can substitute into your HTML, see the variable reference  table.

Note it is super supremely critical to use the <ml.varname> substitution if you are going to
be using the same custom item file over and over again in the same experiment. Otherwise,
the posted variable name will be always be the same and so the response will always be
written to the same variable in the data file. All of the other substitutions can provide for
some handy tricks but they are never necessary.

Substituting Values from the MediaLab Session

In the case of our custom example above, try this modification and save it as myTextBox2.
htm

<form method="post">
    <ml.wording>
    <input name="<ml.varname>">
    <input type="submit" value="Continue"">
</form>  

Create three Custom items in your questionnaire and assign them variable names such as
ques1, ques2, and ques3. For each, enter the same custom item file: myTextBox2.htm for the
file name. As you do this, create a different question wording for each one (e.g., What is your
favourite food? What is your favourite animal? What is your favourite movie?). Now run the
questionnaire and see what happens. You should find that each time you request it, MediaLab
will display it with the appropriate wording from the questionnaire and will save the data from
the item using the appropriate variable name.

See Also
Custom Items, Overview
Single Vs. Multiple Variables
Variable Reference
Samples
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9.2 Single Vs. Multiple Variables

Single vs. Multiple Variables

The item above collects a single response. The execution of this method is the easiest and is
applicable when you have a single value being collected with your custom item. In your
MediaLab questionnaire, you name your custom item var01 and in your HTML form, you
likewise name your posted variable var01. When the value for var01 is posted, MediaLab will
intercept it and save it as the value for var01 in your data files. Done deal. It's a little trickier
when you have multiple variables being collected with a single custom item. To deal with this,
you have two choices--use a variables parameter or create dummy variables in your
experiment. 

Using a variables Parameter

To use the variables parameter, add a v parameter to your Custom item, indicating the
number of variables you want to collect, e.g., (v7) would create space for seven variables.
The variables will be named after the primary variable name with an underscore and numbers
appended. So for example, if the variable name of your Custom item were choice, you could
post variables in your HTML form called choice_01, choice_02, ... choice_07.

In this example, we ask the participant to list "three good movies". It's very similar to the
first example, but here we create three blanks instead of just one. In this case we'll need
three variables so we will add the parameter (v3) to our Custom item that we are calling
movies. Using the v parameter means that we will reference the variable names by using the
primary variable name (movies) along with _01, _02, and _03.  

<form method="post">
    Name three good movies:<br><br>
    <input name="movies_01"><br>
    <input name="movies_02"><br>
    <input name="movies_03"><br><br>
    <input type="submit" value="Continue">
</form>  

How it looks in a browser:

An alternative: Dummy Variables

Instead of adding a parameter, you can create dummy variables in your experiment that act
as placeholders for data with matching variable names. To do so, create an additional Custom
item in any questionnaire and give it whatever variable name you like but do not give it a
filename. When MediaLab sees that you have listed a Custom item with no file name
indicated, it will understand that this item is merely a placeholder for a variable being
collected in some other Custom item. When recognized as a placeholder or dummy variable,
such items will be skipped during the experimental session. 

This method provides a nice way of capturing data from questions or surveys where you can
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not control the variable names that are used in the existing HTML forms. e.g., If you look at
the source code for a survey on the internet and see that you want to save two variables
called age and sex from the many that are being posted, you can include the survey as a
Custom item and then add age and sex as two dummy variables in your experiment. In the
following example, <table> tag along with cell markers are used in order to maintain an
orderly look via rows (<tr>) and columns (<td>). 

<form method="post">
<table>
    <tr><td> What is your: </td></tr>
    <tr><td> Name? </td><td> <input name="name"></td></tr>
    <tr><td> Age? </td><td> <input name="age"></td></tr>
    <tr><td> Sex? </td><td> <input name="sex"></td></tr>
    <tr><td> Ethnicity? </td><td> <input name="ethnicity"></td></tr>
    <tr><td> Marital Status? </td><td> <input name="marital"></td></tr>
    <tr><td> <br><input type="submit" value="Continue"></td></tr>
</table>
</form>

How it looks in a browser:

See Also
Custom Items, Overview
Repeating Custom Items
Variable Reference
Samples

9.3 Variable Reference

Variable Reference

The following variables can be placed in the HTML of any custom item. MediaLab will
substitute the appropriate values in the HTML before it is displayed. This is a convenient way
to substitute information from the current MediaLab item without having to alter the HTML.
Such substitutions could include color and font information, response options, question
wording, background images, parameters, and so forth. 

Note that you can also substitute calculated values from a responses.xls values directly by
placing the variable name in angular brackets. For example, if you had a calculated value of
total in your responses.xls file, you could enter <total> in your HTML file and MediaLab would
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substitute the correct value at the time the HTML is displayed.

<ml.subject> Subject ID <ml.$> quickstyle

<ml.condition> Condition <ml.@> time stamp

<ml.varname> Variable Name <ml.c> command line
arguments

<ml.wording> Question
Wording. Will also
include
substitutions
from responses.
xls if applicable.

<ml.d> duration for timed
items

<ml.color> Main area text
color. Will have
prefix "#" e.g., 
#CCCCFF  

<ml.h> height

<ml.bgcolor> Main area
background color.
Will have prefix
"#" e.g., 
#CCCCFF  

<ml.k> key

<ml.font> Main area font
name, e.g., arial

<ml.l> left position

<ml.fontsize> Main area font
size. Will have
"pt" appended, e.
g., 16pt.  

<ml.m> mask

<ml.color2> Input area text
color. Will have
prefix "#" e.g., 
#CCCCFF  

<ml.n> number of
thoughts to take

<ml.bgcolor2> Input area
background color.
Will have prefix
"#" e.g., 
#CCCCFF  

<ml.o> question wording
onset

<ml.font2> Input area font
name, e.g., arial

<ml.p> number of scale
points (1-12)

<ml.fontsize> Input area font
size. Will have
"pt" appended, e.
g., 16pt.  

<ml.q> target question
for thought rating

<ml.bg> BackGround.
Append
parameters if
desired: .t, .l, .
h, .w, e.g., <ml.
bg.w>

<ml.r> range

<ml.bs> BackSound <ml.s> spacing
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<ml.bv> BackVideo.
Append
parameters if
desired: .t, .l, .
h, .w, e.g., <ml.
bg.w>

<ml.t> top position

<ml.textx> Text Label (1-12).
Replace x with
option number, e.
g., <ml.text7>

<ml.ttl> send ttl signal

<ml.labelx> Button Label (1-
12). Replace x
with option
number, e.g., 
<ml.label7>

<ml.w> width

<ml.skiptox> SkipTo Value (1-
12). Replace x
with option
number, e.g., 
<ml.skipto10>

<ml.x> password
required to
continue

<ml.goback> Whether GoBack
is allowed. True/
False.

<...> Any variable from
responses.xls.
Specify variable
in angular
brackets, e.g., 
<var1>.

All of the variables above may be directly substituted into your HTML file. For example, if the
question wording in you HTML were: "Please choose from one of the <ml.p> alternatives" and
you had used the parameter (p5), the question wording would appear as "Please choose from
one of the 5 alternatives."

The code to display and image in HTML may look like this:

<img src="mypic.jpg">

Instead of having this be a fixed image, you could have your custom item pull up a different
picture every time by placing an image in the background field in the questionnaire. Then, in
your HTML you could specify:

<img src="<ml.bg>">

Voila--a different picture every time--whatever you have put in the BackGround field!

Indirect Substitution (optional)

Values may be directly substituted by entering them directly into the HTML code as above.
This can make previewing the HTML (e.e., in Internet Explorer) a little difficult because IE
won't know what <ml.bg> means. If you don't care about previewing the HTML, then it
doesn't really matter.However, there is an alternative method called indirect substitution
where you can list the substitutions below all the HTML code like this: 
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<form method="post">
 <img src="mypic.jpg"><br>

     some wording here
    <input name="varname">
    <input type="submit" value="Continue"">
</form>  

<!--ml.subs
ml.sub "question wording" = <ml.wording> 
ml.sub "varname" = <ml.varname> 
ml.sub "mypic.jpg" = <ml.bg> 
-->

See Also
Custom Items, Overview
Repeating Custom Items
Single Vs. Multiple Variables
Samples

9.4 Samples

Some Custom Sample Code

Examples of custom items can be found in the Shared Experiments area www.empirisoft.com/
support

The following examples of HTML form code are taken from 
www.w3schools.com/html/html_forms.asp

Text Fields

Text fields are used when you want the user to type letters, numbers, etc. in a form.

<form>
First name: <input type="text" name="firstname"><br>
Last name: <input type="text" name="lastname">
</form>

How it looks in a browser:

Note that the form itself is not visible. Also note that in most browsers, the width of the text
field is 20 characters by default. 

Radio Buttons

Radio Buttons are used when you want the user to select one of a limited number of choices.

<form>
<input type="radio" name="sex" value="male"> Male <br>
<input type="radio" name="sex" value="female"> Female
</form>
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How it looks in a browser:

Note that only one option can be chosen. 

Checkboxes 

Checkboxes are used when you want the user to select one or more options of a limited
number of choices.

<form>
<input type="checkbox" name="bike">I have a bike <br>
<input type="checkbox" name="car">I have a car
</form>

How it looks in a browser:

The Submit Button

When the user clicks on the "Submit" button, the content of the form is sent to another file.
The form's action attribute defines the name of the file to send the content to. The file defined
in the action attribute usually does something with the received input.

<form method="post">
Username: <input type="text" name="user">
<input type="submit" value="submit">
</form>

How it looks in a browser:

If you type some characters in the text field above, and click the "Submit" button, you will
make the text data available to MediaLab for the  variable User. 

Source: www.w3schools.com/html/html_forms.asp

Back to Custom Items Overview 90

http://www.w3schools.com/html/html_forms.asp
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10 Advanced Features

Responses.xls: Calculated Values, Complex Skips & Reports

Overview

This section will show you how to accomplish three advanced functions with MediaLab:

§ Calculate scores and other variables while a session is running. Present these calculated
values on screen as stimuli or feedback, use them in skip patterns, or in post-session
reports.

§ Execute complex skip patterns. Base skips on any prior response, or even combinations of
prior responses and calculated variables.

§ Create and optionally print summary reports immediately following the experimental
session. Create graphs, scale scores, or anything else you want based on raw and/or
summarized data.

Sample

Before we look into the technical details of accomplishing these advanced functions, let's run
a quick sample that demonstrates all three. Note that to take advantage of the functions
described in this section, you will need to have Microsoft Excel installed on your system—both
to design and to run the sessions. Also, because these are considered advanced features,
we're going to presume you have some basic familiarity with MediaLab.

From the samples folder, run Condition 1 of the following experiment:

C:\MediaLab\Samples\Sample5 advanced features\advanced.exp

After the first few questions, this should appear to look just like the standard self-esteem
questionnaire sample from the introductory tutorial.

What is very different from the standard tutorial is the summary screen which follows the self-
esteem scale. Somehow, we have been able to calculate your overall self-esteem score and
present that value back to you. We have also been able to tell you what that score means—i.
e., whether you are high or low in self-esteem—complete with matching emoticon—i.e., :)
or :(

We have also been able to calculate your average response time and tell you if you've been
fast or slow. On the following screen we continue by asking a question about your
membership in a racial minority or majority—based on how you responded to the race
question earlier in the questionnaire.

What happens next will depend on how you scored on the self-esteem test. You can try this a
couple times to see for yourself. If you scored moderately, then you will be at the end of the
session. If you scored very high (>4) then you will be at a screen representing where a social
desirability scale might be administered. If you scored very low (<2) then you will be at a
screen representing where a depression inventory might be administered.

When you're done, let's go to the experiment's data folder. In here, you'll find a folder called
"reports". Inside the reports folder is a file called 1.xls (this will be different if you used
another subject ID). Let's open this file by double-clicking on it. First you'll see many of the
responses you gave to the questionnaire. Click on the tab at the bottom left that says "sheet
2". Here you'll find a custom report for the session that displays your name, age and self-
esteem score. It presents a graphic that is based on your self-esteem score and also displays
a graph of the individual response times for each question. This report is completely
customizable and can be created automatically for each subject—with any raw or summary
data you like, and formatted in any way you like.
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How is it all done?

Let's close the report file and go back to the experiment folder. Open the file responses.xls—
this is the secret. If you have a standard Excel file called responses.xls in your experiment
folder then MediaLab knows you want to use some or all of these advanced functions. The
question now—what do we put in this Excel file called responses.xls?

Variable, Value and Skipto

Notice that there are three columns on the opening worksheet—variable, value, and skipto.

The Variable Column

In the variable column there are two types of variables—experiment variables and calculated
variables. If you take a look in our questionnaire self-esteem.que you'll see that many of the
variables listed there are also listed here in the variable column of responses.xls—name, age,
rse1, rse2, etc. These are experiment variables—i.e., variables taken from any of our
questionnaires in the experiment. This also includes reaction times such as trse1, trse2, trse3
and so on. If it would normally appear in your regular MediaLab data files then we're dealing
with an experiment variable.

But what about variables like minmaj, rse (positive scored), rse (positive scored), and rse?
These are not variables from the experiment. That's because we are creating them here in the
responses.xls file. You can create any and as many new variables as you like and you can call
them whatever you like. The only rule for a calculated variable is that it has a name that isn't
used in your experiment.

The Value Column

This brings us to the value column. For experiment variables, this is really simple—you don't
need to do anything. As a subject progresses through your experiment, MediaLab will
automatically fill these values in. After every question in your experiment, MediaLab checks
the variable column to see if it can fill in any values with the newly acquired data. Thus,
experiment variables are automatically updated by MediaLab when the data become
available.

What happens next is the really fun part–Excel automatically updates all of your calculated
variables taking into account the current values of your experiment variables!

Let's look at the example of rse (positive scored) . Double-click the mouse on the value
column for this calculated variable. You'll see that this cell actually contains the formula:

=AVERAGE(B4,B5,B7,B9,B10)

This is an Excel calculation formula. We're telling Excel that we want the value here to equal
the average of the cells listed in parentheses. If you look at what's in those cells, you'll see
that it's the subject's responses to rse1, rse2, rse4, rse6, and rse7. These happen to be the
positively scored self-esteem items such as "I feel that I have a number of good qualities."

Now let's look at rse (negative scored) . You'll see that this cell contains:

=7-AVERAGE(B6,B8,B11,B12,B13)

Here we're averaging the reverse scored items (e.g., "I am inclined to feel that I am a
failure.") and then subtracting that value from 7 to recode it such that higher numbers reflect
higher self-esteem.

Finally, look at rse :

=AVERAGE(B27,B28)
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We see that the final calculated self-esteem score is an average of the two sub-scores above.
Now we have a calculated variable rse that is the subject's overall self-esteem score.

10.1 Calculated Scores

Presenting Calculated Scores in MediaLab

Now that we have calculated a number of variables from the current session, we can present
these values back to the subject. Take a look at item #15 in the self-esteem questionnaire:

You have <rselabel> self esteem <face>

You scored <rse> out of a possible 6.

Your average response time was <rsert>ms (<rsertspeed>).

We are presenting six calculated variables here—all from responses.xls. On the second line of
the question wording we see where we are using the calculated self-esteem score. We do this
by placing the name of the calculated variable in angular brackets like this: <rse>. That's all

there is to it—using this method, you can insert the value any calculated variable into the
question wording of any MediaLab item.

Following the same idea, we calculated and presented whether the subject was high or low in
self-esteem by using the calculation for <rselabel> as follows:

=IF(B29>3,"high","low")

Using Excel's language for conditional logic, here we're saying that if the subject's calculated
self-esteem is greater than 3, then they're "high" and that otherwise, they're "low".
Calculating and presenting the subject's average response time, whether it is considered
"slow" or "fast" are additional examples of the same idea—calculating new variables from
gathered data and using those values in the same session.

Save Calculated Variables to Your Data Files

As of v2006.2, you can save calculated values along with your other MediaLab data. Create
simple placeholder variables in your questionnaire by using the Custom item type with no
filename. When such an item is encountered, MediaLab will check to see if the variable name
exists in your responses.xls file. If it does, then MediaLab will record the value for that
variable in your regular data files. In other words, by using the same variable name for the
placeholder and calculated variables, MediaLab will know which values to grab from
responses.xls and store in your regular data files. Note that MediaLab will be grabbing the
current value of the calculated variable if and whenever it comes across the placeholder item
during the session--i.e., location of the placeholder within your session could be an important
factor. 

See Also: Advanced Features Overview

10.2 Complex Skips

We saw above how calculated variables can be used as information we can present back to
subjects. We can also use calculated variables to help us with skip logic.

For any experiment variable you have entered in reponses.xls, you can specify or calculate a
variable to skip to when that item is completed. If the current MediaLab item is listed in the

99



MediaLab v2006102

© 1995-2006 Empirisoft Corporation

variable column of responses.xls then MediaLab will check the skipto column when the item is
finished to see where it should go next. If there is no skipto value then no skip will occur.

Let's take the fill-in-the-blank age question for example. Currently, there is no skipto value.
What would happen if we typed "debrief" into the skipto column for that item? When the age
item came up in the MediaLab session, MediaLab would see that age is listed in responses.xls.
It would see the skipto value of debrief and send the subject to the last item in the
questionnaire. If you have used MediaLab's skipto function in the past, this is pretty standard
stuff.

Where it gets interesting is in the fact that you can now use responses.xls to calculate skipto
values. Instead of placing a static value in the skipto column, we can compute a variable
based on what's been happening in the experiment. Let's say that we want to use the
subject's self-esteem score to determine what happens next. If they scored extremely high,
we want to administer a scale which measures socially desirable responding. If they scored
extremely low then we want to administer a depression inventory. If they scored in the
normal range, we'll skip them to the end of the session.

Take a look at how we do this by checking out the formula in C26, that is the skipto value of
the essay item, ess1:

=IF(B29<2,"dep",IF(B29>4,"sdes","debrief"))

In this formula, you can see three items from the questionnaire—dep, sdes, and debrief.
These are our three skipto candidates. The conditional logic of Excel is applied to say: "If self-
esteem is < 2 then dep otherwise if self-esteem is > 4 then sdes, otherwise debrief."

See Also: Advanced Features Overview

10.3 Post-Session Reports

At the end of every session, MediaLab automatically saves a copy of Responses.xls in the data
\reports folder. The copy is named using the current subject ID and will have all of the
subject's responses to the experiment variables saved in the value column. There are two
reasons for this. One is that this allows you to open the subject's report and check your
calculations. You will be able to view the results of all of calculated variables and skipto values
based on the subject's actual responses. It's a handy way to check your work.

The second reason for this is the option to create post-session reports for each subject. In the
sample provided, you can click on the "sheet2" tab in the lower left corner of Responses.xls.
You will see a template for a post-session report. This is a completely free-format. It uses
Excel formatting to create text and figures with references to experiment and calculated
variables on the main worksheet. As the session unfolds and values are updated on the main
sheet—so are the fields and figures in the report. When the session is over, the report is
saved for easy access to these summary data. Take a look at "sheet2" of data\reports\1.xls
as an example.

Notice that on the main page of responses.xls there are two lines that read:

print.sheet1  no
print.sheet2  no

You can add these optional lines to any responses.xls file. If listed with "yes" in the value
column, they instruct MediaLab to send the listed worksheet(s) directly to your default
printer. This is handy, for example, if you want a report on "sheet2" to print automatically so
that you might discuss the results with the participant.
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See Also: Advanced Features Overview

10.4 Tips

Extra Notes & Rules to Know

§ As a guiding principle remember that MediaLab never looks at your formulas—only the
results! How the results of calculated variables occur is completely between you and Excel.
Remember that it's your recipe–MediaLab just supplies the ingredients and eats the meal.

§ You can include as many or as few experimental variables as you like. Feel free to include
only those that you need for your calculations.

§ A complete discussion of Excel's logic and math functions is way out of the scope if this
tutorial. If you've never done calculations in Excel this might seem a bit intimidating at first,
but it's really not too bad (honest!). The trick is getting an understanding of how to nest
multiple conditions within a single calculation. Grab a pot of coffee and go through Excel's
help on this for an hour or so and you'll get it.

§ To access the relevant help on constructing calculations and conditional statements, press
F1 in Excel. Using the Answer Wizard or the Index, look up terms like If, And, Or, Logical
Functions, Functions Listed by Category.

§ When including experiment variables, you can include ANY variable from ANY questionnaire
in your experiment—everything goes into responses.xls which is placed in your experiment
folder.

§ Variable names used for experiment variables need to match the variable names used in
the MediaLab data files. This is important to remember for items that record multiple
values. For example, let's say you have a multiple response question called MR1 that has
five response options. Normally, there won't be a variable in your data file called MR1.
Since there are five responses written, they will be called MR1_01, MR1_02, MR1_03 and so
forth. This applies also to thought listing items and ranking items. If in doubt, you can
always check one of your data files to see how the variable names are written.

§ When creating conditional statements or calculations based on the value of experiment
variables, it will always be the value written to the final data file that will be entered by
MediaLab in the value column of Responses.xls.

§ Essay content can not be accessed as a variable.

§ Responses.xls should not have any empty rows on the main page

§ MediaLab executes skips by skipping over items until the desired item is found. This means
that if you tell MediaLab to skip to a variable that doesn't exist then the session will end.

§ Using responses.xls will have no impact on your primary data files—i.e., calculated
variables are just for use during the experiment and are saved only in the post-session
report (i.e., in the reports folder see above).

§ In addition to saving a copy of responses.xls under the subject's ID in the data\reports
folder, MediaLab will also save a copy as !currentsession.xls in the same folder. This is a
temporary file reflecting the responses of the last subject to participate in the experiment.

§ Currently the MediaLab GoBack function is disabled if calculated skips are involved..

See Also: Advanced Features Overview
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11 Tips and Notes

QuickInfo

Here are a few miscellaneous tips that don't easily fit elsewhere in this guide. 

Specifying File Paths

Sizing Images and Movies

Miscellaneous Features

Using Responses from MediaLab as Stimuli in DirectRT
Adjusting Speaker Volume Automatically During Session 
Secondary Tasks - Requiring Participants to Respond to Probes
Sending and Receiving Serial Data

Trouble Shooting Tips

11.1 Specifying File Paths

When you tell MediaLab to present a file (e.g., an image, a sound, a movie, a questionnaire,
etc.), you need to specify where that file is located. There are two ways to do this—using
absolute or relative paths.

Relative Paths

If the file is located in the same folder as your experiment file, then you can simply enter the
name of the file (e.g., myimage.bmp). If the file is located in a subfolder that is located in the
same folder as your experiment files, then you can enter the name of the subfolder followed
by the name of the file (e.g., images\myimage.bmp). You can use a relative path for ANY file
located anywhere within your main experiment folder.

The advantage of placing the file in the experiment directory (or a subfolder) is that the
experiment folder can then be moved to a different place and you won't have to worry about
checking path names (e.g., c:\..., d:\..., etc.). You could copy your experiment folder to any
location on any drive and all of the relative paths would still be valid.

Absolute Paths

If the file you are presenting exists anywhere outside of the experiment folder then you will
have to specify an absolute file path. An absolute file path is the exact location of the file (e.
g., c:\mypictures\myimage.bmp).

Remember, if the file is not in the same directory as the experiment, and it's not in a
subfolder, then you must specify the complete path of the file. Make sure that any absolute
file paths you use will still be valid if you copy your experiment to another computer.

Hint

You can specify relative or absolute file paths to be the default when selecting files in the
experiment editor. You can set your preferred default in the Options menu. It is
recommended to set this option to Use Relative Paths. This is because the only time an
absolute path is necessary is when the desired file is not located somewhere within the
experiment folder. However, even if you are using relative paths, the editor will enter an
absolute path if this is the case.
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11.2 Sizing Images and Movies

MediaLab tries to use a resolution-independent scale so that your experiments will look the
same no matter what resolution you run in. Some differences can not be avoided however. To
see what the scale is on your particular system, choose "Show Location Points" from the Help
menu in MediaLab. To see how the resolution independence works, take a look at the scale
now. Then resize the MediaLab window and try it again. You should notice that the scale
doesn't change. Try setting a different display resolution on your computer (Control Panel ->
Display, Settings). Look at the scale again—it should be about the same no matter how you
change your display. One factor that does to to influence the scale is whether you use "small
fonts" or "large fonts" in your system settings. Small fonts produce a slightly larger range for
both height and width. If you want the experiment to look the same on all computers you
should check to make sure they are all running small fonts or that they are all running large
fonts.

Typically, the width parameter will range from 1 to about 700. The height parameter will
range from 1 to about 500. These values apply to the top and left parameters as well.

Note that the scale applies to most everything in MediaLab when the top, left, height, anmd
width parameters are used. The exception is movies. Movies do not follow the MediaLab scale
because they are presented with the Windows MediaPlayer. Consequently, if you specify a
width of 300 (for example) it will appear smaller on a larger screen resolution. How you can
combat this is to use the special width parameters provided especially for movies. For
example, (w-1) will play the movie at full screen, (w-2) will play it half screen, (w-3) at a
quarter and there are others. See parameters  for more detail.

Note also that although the scale applies to images, that this is only true if you explictly
define the size of the image (using the height and width parameters). Otherwise the image
will appear as it's default size. For example a 300 pixel wide image will appear smaller when
you use higher screen resolutions. However if you explicitly define the size using the height
and width parameters then it will appear according to the MediaLab scaling system.

Parameters (Questionnaire Files)

Parameters (Experiment Files)

The most common resolutions are 640x480, 800x600, and 1024x768. The first number tells
you the number of pixels that are displayed across your screen, and the second number tells
you the number that are displayed down your screen. You can determine and/or set the
resolution of your display by right clicking on your desktop and selecting Properties > Display.
MediaLab tries to use a resolution-independent scale so that your experiments will look the
same no matter what resolution you run in. Some differences can not be avoided however. To
see what the scale is on your particular system, choose Show Location Points from the Help
menu in MediaLab.

By right clicking on your desktop and choosing settings you can see if your system is set to
use large or small fonts. In 640x480 mode, only small fonts are available. At greater
resolutions, you may optionally choose large fonts. This impacts on window sizes as well.
Larger fonts result in larger windows. In our testing, MediaLab has worked well in most
resolutions with both large and small fonts.

11.3 Miscellaneous Features

These features are documented here despite the fact that you would probably never need
them. Sometimes when people get customizations to MediaLab done, they are very useful to
a lot of other users and so they get worked into the manual. Other times, well… they'll
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probably gather some dust. But just in case somebody else might be able to benefit from
them, here they are. There are many more but I'll start with these:

Using Responses from MediaLab as Stimuli in DirectRT

At some point you may want to use a subject's answer to a scale response or fill-in-the-blank
item as a stimulus in DirectRT. For example, in MediaLab you could ask a series of fill-in-the-
blank items asking subjects to enter foods that they like. Or you might ask them to indicate
their race using a scale response. Then in a DirectRT session, you might want to display these
responses as stimuli (e.g., as primes or targets in a priming study). For fill-in-the-blanks and
scale responses, you can use the "filename" field to have MediaLab save the response in the
file you specify. This will cause MediaLab to save the subject's response preceded with a "~"
symbol so that DirectRT will recognize that it is text for display purposes. Then, in DirectRT,
you can specify that this text be displayed as a stimulus by using the "&" symbol (which tells
DirectRT to read a single line stimulus from a text file). So if you have a MediaLab question
that asks subjects their race called "race" you could enter something like "c:\race prime study
\stim\race.txt" in the filename field. Then, in your DirectRT input file, you could refer to
"&race" as a stimulus. When DirectRT finds this, it will open the race.txt file that MediaLab
created, and will present the subject's response as the stimulus. See the DirectRT
documentation regarding "Input Files" and "Stim" types for more detail.

Adjusting Speaker Volume Automatically During Session 

Sometimes you will have multiple media clips in your session and they vary in volume. Some
play too loud, others not loud enough. Now you can embed an executable item at any point
called volume.exe located in the C:\MediaLab\Utilities\Sounds folder. Copy this file into your
experiment folder. Anywhere in your experiment add an executable item and in the filename
field, type volume.exe. In the parameters field enter (c5) where 5 is a volume setting from 1
to 10. For max volume, enter (c10) and for min volume enter (c1). Any integer value from 1
to 10 is ok. You'll get a brief, "please wait one moment" message while the volume is
adjusted after which you can click to continue. 

Secondary Tasks - Requiring Participants to Respond to Probes

Visual, auditory and TTL signal probes can be launched at any time from your questionnaire.
You can create a schedule of probes at either random or fixed intervals and get subjects
response times to the probes. The probe schedule can span multiple items as it runs
independently of the experiment once launched. Response times are assessed using DirectX
so their accuracy is very good. 

To execute a probe task you create a schedule of probes in an Excel file. Each schedule may
contain multiple sets of probes, with each set having an ID such as 1, 2, 3 and so on.  In a
MediaLab questionnaire, we refer to this ID in the parameters of any item by saying "*1" or
"*2".  That tells the Probe Generator which set of probes to execute.  The set will execute
until completion which means that a single set can span one or many items in MediaLab.  You
can have as many sets of probes as you like (Set 1, Set 2, Set 3 and so on).  However, you
can only request a given set once in a session.  You might assign different probe sets to
different tasks within the same session, or to the same task in different between subject
conditions. 

For detailed documentation and samples see:

http://www.empirisoft.com/support/showthread.php?p=826

http://www.empirisoft.com/support/showthread.php?p=826
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Sending and Receiving Serial Data

Some external devices can emulate keyboard input so that input will be instantly recognized
as key presses from a standard keyboard--they will just arrive much faster. For example, our
DirectINTM Precision Button Boxes and Keyboards are all USB ready and send signals within
1ms that look like regular keystrokes to your computer. Some older devices though still
communicate via the serial port. This section describes how you can get MediaLab to
recognize and record serial port data. 

Receiving a Single Response via Serial Port

As an alternative to keyboard input, you can receive input from external devices such as
response boxes via the serial port. To do so you just need to create a file called comport.txt in
your experiment folder and copy the following text into it:

comPort, baudRate, parity, dataBit, stopBit
1,19200,n,8,1
input code (1-255), response value (1-12)
1,1
2,2
3,3
4,4
5,5
6,6

You should not modify the first or third line. The second line represents the values of the
variables listed on the first line. You can change any of these as necessary. The remaining
lines tell MediaLab how to map incoming signals to response keys. On each line you can list a
pair where the first value is the signal sent to the serial port (i.e., 1-255) and the second
value is the response it should map on to (i.e., 1 to 12). In the example above, if MediaLab
detects a "1" coming through the serial port, it will react as though the 1 or F1 key had just
been pressed. 

Receiving Streams of Serial Data

MediaLab can also accept and log streams of serial data from an external source. MediaLab
will write the exact ASCII data to an external file named comdata.txt. To indicate to MediaLab
that the serial data should be recorded, your serial device should be programmed to send out
data packets that are surrounded in {} brackets as follows:

{
Hello World
This is data for MediaLab
}

The comdata.txt file will contain the data

Hello World
This is data for MediaLab

This function requires that you create a file called comdata.txt and place it in your experiment
folder. If MediaLab sees this file, it will automatically watch for  and save any serial data that
is surrounded in { } brackets. In order for MediaLab to use the proper serial port settings, you
should also include a comport.txt file as described above. If you do not want any key
mappings, it could simply look like this:
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comPort, baudRate, parity, dataBit, stopBit
1,19200,n,8,1
input code (1-255), response value (1-12)
0,0

Sending Streams of Serial Data 

If you are using a comport.txt file, you can also send a string of data to the serial port by
adding the string as a parameter value for any given questionnaire item.  The string should be
enclosed within braces and angular brackets like this:

<{112340}> or <{RED}>

When included in the parameters for a 5pt scale response, for example, your parameters field
might look like this:

(p5,<{SCALE1}>)

In this example, so long as you have a valid comport.txt file in your experiment folder (see
above), then MediaLab would send "SCALE1" to the appropriate port at the onset of this scale
response item. Again, if you do not want any key mappings, comport.txt could simply look
like this:

comPort, baudRate, parity, dataBit, stopBit
1,19200,n,8,1
input code (1-255), response value (1-12)
0,0

See Also:

Receiving Responses Via TTL Signals
Receiving Response Via Serial Port

11.4 Trouble Shooting Tips

Answers to many common trouble shooting questions can be found at our support site: 
support.empirisoft.com. If you can not find the answer to your question there, you may
register a username and password and post your question directly on the support site. This is
often the fastest way to get an answer from us or maybe even one of our other helpful users.
If for some reason, you can not get the answer you need via the support site, then contact us
directly through email at support@empirisoft.com. 

No matter which route you take, there are two basic types of trouble you might experience
while trying to use MediaLab. The first is trouble associated with a particular input file and the
second is trouble associated with the program in general. Here are some questions we're
likely to ask depending on your situation.

Questionnaire or Experiment File Trouble

If you're having trouble with a particular file you're working on, but otherwise MediaLab is
running fine (e.g., samples work ok), then:

· Post or send us a copy of your problem file with as few items in it as possible to illustrate
your question. This will help us see as quickly as possible what's going on. If we can quickly
see and replicate the issue here, then we can usually solve the problem very quickly.
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System or Software Trouble

If it's an apparent bug that you've found, or some unusual behaviour, try to tell us the
following in your post or email..

· Does the same thing happen on multiple machines, or just one? Problems that replicate are
usually much easier to fix!

· Is it seemingly random or predictable? Do you have to do something to make it happen?

· Does the same thing happen with any of the samples that come with MediaLab or is it
specific to a single file that you've created (see above)?

· What version of MediaLab are you using? You can find this by clicking "About" on the Help
menu. What version of Windows are you using? Have you tried making sure that no other
programs are running at the same time that might be causing some kind of interference?

Note that the samples that come with MediaLab should always run fine. If they don't, you may
have a system problem. In this case, the first thing to try is usually making sure you have the
latest version of MediaLab.

One thing we can do is look over your system diagnostics and see if there are any obvious
problems that could be corrected. If you want to try that, here is how you do it: Type
"dxdiag" from the "Run" command on the Windows "Start" menu. You will get a complete
diagnostic description of your system. If you then click "Save All Information" and send the
resulting file to us, we'll take a look at it and see if we can see anything problematic. You can
also check for some obvious problems here yourself--the display tab in particular may indicate
you could benefit from a driver update or other action.
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Calculated Scores and Variables, 101
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Serial Data, 107

Setup, MediaLab, 4

Skip To, 68

Sound,

BackSound, .exp, 31

BackSound, .que, 43

Experiment File, 29

Parameters, .exp, 34

Parameters, .que, 60

Questionnaire Files, 53

Sound Effects, MediaLab, 85

Spacing, s Parameter, 34, 60, 64

Speaker Volume, 105

Speaker,Volume,Sound, 106

Spell Checking, 23

SPSS, 74

Syntax and Data, 72

Variable Names, 59

Support, 108

Supporting Applications, 85

System Requirements, 4

System Settings, 4

T

Target Question, q Parameter, 65

Task bar, 4

Text Labels, 69

Thought  Listing, 53

Thought Listing,

Parameters, 60

Thought Rating,

Parameters, 60

Timestamp, @ Parameter, 60, 75

Trouble Shooting, 108

TTL Signal Parameter, 65

TXT Data Files, 72

U

Unique Machine Code, 84

Use Alternate Data File, 84

Use Enhanced Video, 85

V

Variable Names, 59, 76

Video (see Movie), 49

Voice Response, 54

Parameters, 60

Volume, Speaker, 105

W

WebTracker, 55

Width, w Parameter, .que, 65

Word Document,

Experiment File, 29

On-the-fly Editing, 84

Parameters, .exp, 34

Parameters, .que, 60

Questionnaire Item, 55

Write Data as Text, 70

Write Reaction Time, 71

Z

Zip Files, 77
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